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Memory Based Questions IBPS RRB PO & Clerk 2024 
 

Q1. What is unauthorized access with malicious intent 
commonly referred to as? 
(a) Phishing 
(b) Hacking 
(c) Data Mining 
(d) Spoofing 
(e) Firewall Breach 
 
Q2. Which method is commonly used to steal your identity 
online? 
(a) Phishing 
(b) Data Encryption 
(c) Cloud Storage 
(d) Firewall 
(e) Debugging 
 
Q3. In email communication, what do the terms CC and BCC 
stand for? 
(a) Current Copy and Blind Copy 
(b) Carbon Copy and Blind Carbon Copy 
(c) Central Communication and Backup Communication 
(d) Clear Copy and Backup Carbon Copy 
(e) Contact Copy and Blind Contact Copy 
 
Q4. What typically happens when a system hangs or 
freezes? 
(a) CPU Overload 
(b) System Reboot 
(c) Blue Screen of Death (BSOD) 
(d) Application Crash 
(e) None of the above 
 
Q5. Which of the following software is commonly used for 
sending and receiving emails? 
(a) Adobe Photoshop 
(b) Microsoft Word 
(c) Microsoft Outlook 
(d) VLC Media Player 
(e) AutoCAD 
 
Q6. In a Gmail address, what does the "@" sign separate? 
(a) Username and password 
(b) Username and domain 
(c) Email ID and contact number 
(d) Sender and recipient 
(e) Local and international servers 
 
Q7. In MS Excel, what remains visible constantly even if you 
move through rows and columns? 
(a) Headers 
(b) Freeze Panes 
(c) Gridlines 
(d) Active Cell 
(e) None of the above 
 

Q8. Who is known as the father of computers? 

(a) Alan Turing 

(b) Steve Jobs 

(c) Bill Gates 

(d) Charles Babbage 

(e) John von Neumann 

 

Q9. Which type of malware can self-replicate and propagate 

without needing a host program? 

(a) Virus 

(b) Worm 

(c) Trojan Horse 

(d) Spyware 

(e) Ransomware 

 

Q10. Which of the following software is used to create and 

edit a document? 

(a) MS Excel 

(b) MS PowerPoint 

(c) MS Word 

(d) MS Access 

(e) Adobe Photoshop 

 

Q11. What are the concentric circles on a hard disk called? 

(a) Sectors 

(b) Clusters 

(c) Blocks 

(d) Tracks 

(e) Cylinders 

 

Q12. FORTRAN belong to which category of programming 

languages? 

(a) Assembly Language 

(b) Machine Language 

(c) High-Level Language 

(d) Scripting Language 

(e) Low-Level Language 
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Q13. Which of the following is used to convert a hard copy 
document into a digital copy? 
(a) Printer 
(b) Monitor 
(c) Scanner 
(d) CPU 
(e) Keyboard 
 
Q14. Which of the following shortcut keys is used to select 
all the content in a document? 
(a) Ctrl + C 
(b) Ctrl + X 
(c) Ctrl + A 
(d) Ctrl + S 
(e) Ctrl + V 
 
Q15. Which shortcut key is used to jump to the beginning of 
a document in MS Word? 
(a) Ctrl + Home 
(b) Ctrl + End 
(c) Ctrl + B 
(d) Alt + Tab 
(e) Shift + Home 
 
Q16. Which of the following devices or software is 
commonly used for wireless file transfer within a small 
range? 
(a) USB Cable 
(b) Bluetooth 
(c) Ethernet 
(d) HDMI 
(e) CD-ROM 
 
Q17. What is the primary function of a firewall in a 
computer network? 
(a) Monitor CPU performance 
(b) Block unauthorized access 
(c) Increase internet speed 
(d) Store data 
(e) Manage software updates 
 
Q18. What is the shortcut key to save a document in MS 
Word? 
(a) Ctrl + P 
(b) Ctrl + S 
(c) Ctrl + A 
(d) Ctrl + Z 
(e) Ctrl + X 
 
Q19. Word processors and spreadsheet applications belong 
to which category of software? 
(a) System Software 
(b) Utility Software 
(c) Application Software 
(d) Security Software 
(e) Firmware 
 

Q20. The unit of the timer watch fitted into the 

microprocessor is measured in? 

(a) Volts 

(b) Amperes 

(c) Hertz 

(d) Ohms 

(e) Joules 

 

Q21. Which of the following primarily stores data 

temporarily in a computer? 

(a) CPU 

(b) CD-ROM 

(c) RAM 

(d) Flash Drive 

(e) ROM 

 

Q22. Ctrl and Alt are examples of what type of keys in a 

keyboard? 

(a) Function Keys 

(b) Modifier Keys 

(c) Navigation Keys 

(d) Toggle Keys 

(e) Numeric Keys 

 

Q23. What is the rectangular area of the computer screen 

used for displaying information and running programs 

called? 

(a) Taskbar 

(b) Menu Bar 

(c) Window 

(d) Desktop 

(e) Toolbar 

 

Q24. Which of the following is not a threat to computers? 

(a) SQL Injection 

(b) Burn 

(c) DOS Attack 

(d) Phishing 

(e) Power Surge 

 

Q25. In the term CISC, what does the letter I stand for? 

(a) Internet 

(b) Integration 

(c) Instruction 

(d) Information 

(e) Interface 

 

Q26. Convert the decimal number 15 into a binary number. 

(a) 1001 

(b) 1100 

(c) 1010 

(d) 1111 

(e) 1000 
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Q27. India's first computer was installed in which city? 

(a) Mumbai 

(b) Kolkata 

(c) Bengaluru 

(d) Delhi 

(e) Chennai 

 

Q28. Which of the following is the search engine developed 

by Microsoft? 

(a) Google 

(b) Yahoo 

(c) Bing 

(d) DuckDuckGo 

(e) Baidu 

 

Q29. Who is known as the father of the Internet? 

(a) Tim Berners-Lee 

(b) Vint Cerf 

(c) Bill Gates 

(d) Steve Jobs 

(e) Marc Andreessen 

 

Q30. Which of the following is not a type of printer? 

(a) Word Matrix 

(b) Dot Matrix 

(c) Laser 

(d) Inkjet 

(e) Thermal 

 

Q31. Which shortcut key is used to find and replace text in a 

document? 

(a) Ctrl + F 

(b) Ctrl + H 

(c) Ctrl + R 

(d) Ctrl + G 

(e) Ctrl + P 

 

Q32. What is half a byte called? 

(a) Nibble 

(b) Bit 

(c) Word 

(d) Kilobyte 

(e) Megabyte 

 

Q33. Which shortcut key is used to add a new slide in 

Microsoft PowerPoint? 

(a) Ctrl + N 

(b) Ctrl + M 

(c) Ctrl + S 

(d) Ctrl + P 

(e) Ctrl + T 

 

Q34. Which of the following is the fastest type of memory? 

(a) CD 

(b) DVD 

(c) SSD 

(d) Flash Drive 

(e) Hard Disk 

 

Q35. Which of the following is the shortcut key to refresh a 

web page? 

(a) Ctrl + F6 

(b) Ctrl + R 

(c) Ctrl + F 

(d) Alt + F4 

(e) Shift + R 

 

Q36. Which of the following is a feature of a Dot Matrix 

Printer? 

(a) Coloured Printing 

(b) High-Resolution Printing 

(c) Prints Multiple Copies using Carbon Paper 

(d) Quiet Printing 

(e) Laser Precision 

 

Q37. From which of the following tabs in MS PowerPoint 

can you add a table, chart, or picture? 

(a) Home 

(b) Insert  

(c) Design 

(d) View 

(e) Review 

 

Q38. Which feature groups emails with the same subject 

line into a conversation in email clients? 

(a) Spam Filter 

(b) Conversation View 

(c) Thread Sorting 

(d) Email Archiving 

(e) Priority Inbox 

 

Q39. Which feature automatically fills in information on 

web pages? 

(a) Autofill 

(b) Cache 

(c) Cookies 

(d) Bookmark 

(e) Pop-up Blocker 

 

Q40. Which of the following is a popular open-source 

operating system? 

(a) Windows 

(b) macOS 

(c) Linux 

(d) iOS 

(e) Splunk 
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Q41. Where is the document temporarily stored during 

working on a PC? 

(a) Hard Disk 

(b) CD-ROM 

(c) RAM 

(d) ROM 

(e) USB Drive 

 

Q42. What is the primary purpose of Microsoft Access? 

(a) Word Processing 

(b) Spreadsheet Creation 

(c) Database Management 

(d) Graphic Design 

(e) Email Management 

 

Q43. Which of the following is used in memory storage to 

maintain the state of a single bit of data? 

(a) Register 

(b) Cache 

(c) Flip-Flop 

(d) RAM 

(e) SSD 

 

Q44. Convert the binary number (101010) ₂ to its decimal 

equivalent. 

(a) 8 

(b) 32 

(c) 22 

(d) 42 

(e) 24 

 

Q45. Which of the following computer generations used 

vacuum tubes? 

(a) Second Generation 

(b) Third Generation 

(c) Fourth Generation 

(d) First Generation 

(e) Fifth Generation 

 

Q46. Which component temporarily stores data while the 

CPU performs ALU operations? 

(a) HDD 

(b) Accumulator  

(c) RAM 

(d) Control Unit 

(e) ROM 

 

Q47. Which of the following is not hardware? 

(a) Hard Disk 

(b) Monitor 

(c) Printer 

(d) Python 

(e) Motherboard 

 

Q48. In an email service, which feature is used to mark 

important emails for easy access? 

(a) Archive 

(b) Star Mark 

(c) Draft 

(d) Folder 

(e) Priority Label 

 

Q49. Which of the following is not correct for non-volatile 

memory? 

(a) Data is retained even after the PC is turned off. 

(b) It is commonly used for long-term storage. 

(c) Data is lost after the PC is off. 

(d) Non-volatile memory includes devices like SSDs and Hard 

Drives. 

(e) It is slower than volatile memory like RAM. 

 

Q50. What is the use of middleware? 

(a) Middleware is used for managing hardware resources. 

(b) Middleware enables the processing of multiple synchronous 

transactions between applications. 

(c) Middleware provides direct access to system memory for 

faster processing. 

(d) Middleware is used for storing data permanently. 

(e) Middleware is responsible for user interface design. 

 

Q51. Which of the technology is used in the transaction of 

Bitcoin cryptocurrency? 

(a) Machine Learning 

(b) Artificial Intelligence 

(c) Data Mining 

(d) Blockchain 

(e) Cloud Computing 

 

Q52. What type of malicious software appears to be 

legitimate but can actually cause harm to your computer or 

network? 

(a) Virus 

(b) Trojan 

(c) Worm 

(d) Spyware 

(e) Ransomware 

 

Q53. Wireless USB is used in which of the following 

networks? 

(a) LAN (Local Area Network) 

(b) WAN (Wide Area Network) 

(c) PAN (Personal Area Network) 

(d) MAN (Metropolitan Area Network) 

(e) SAN (Storage Area Network) 
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Q54. Which of the following is not an antivirus software? 

(a) McAfee 

(b) Norton 

(c) CodeRed 

(d) Kaspersky 

(e) AVG 

 

Q55. Which of the following performs the arithmetic and 

logical operations in a CPU? 

(a) ALU  

(b) Memory Unit 

(c) Control Unit 

(d) Cache 

(e) Register 

 

Q56. Which of the following symbol is used to combine the 

contents of two or more cells in MS Excel? 

(a) % 

(b) + 

(c) & 

(d) = 

(e) * 

 

Q57. Which type of malware is designed to collect 

information about a user without their knowledge? 

(a) Virus 

(b) Worm 

(c) Spyware 

(d) Ransomware 

(e) Trojan 

 

Q58. Which of the following has the shortest access time of 

all memory units? 

(a) RAM 

(b) Cache 

(c) Hard Disk 

(d) SSD 

(e) CD-ROM 

 

 

Q59. What is the full form of ATX? 

(a) Advanced Technology eXtended 

(b) Automatic Technology Expansion 

(c) Advanced Transfer Extension 

(d) Accelerated Technology X-factor 

(e) Auxiliary Technology Expansion 

 

Q60. Ransomware is a type of: 

(a) Application Software 

(b) Encryption Malware 

(c) Decryption Malware 

(d) Antivirus Software 

(e) Protection Malware 

 

Q61. What is the function of the Control Unit? 

(a) Interprets instructions 

(b) Prints data to a printer 

(c) Provides internet access 

(d) Adjusts screen resolution 

(e) Compresses files for storage 

 

Q62. Which of the following are the most prominent and 

widely used IP protocols today? 

(a) IPv2 & IPv3 

(b) IPv5 & IPv7 

(c) IPv4 & IPv6 

(d) IPv1 & IPv7 

(e) IPv2 & IPv5 

 

Q63. What is a Rootkit? 

(a) A type of software that hides malicious activities on a system 

(b) A security software used to protect sensitive data 

(c) A tool for enhancing system performance 

(d) A legitimate application used for system recovery 

(e) An antivirus used to detect malware 

 

Q64. A stylus is a pen-like device that works using which 

technology? 

(a) Laser 

(b) Pointer 

(c) UV Rays 

(d) Capacitive Touch 

(e) Magnetic Field 

 

Q65. What is the use of an interrupt in a computer system? 

(a) To stop CPU tasks 

(b) To allocate memory 

(c) To handle urgent tasks and I/O 

(d) To save data 

(e) To protect against malware 
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Q66. Which equipment is used to increase the speed of a 

computer? 

(a) Increasing storage on the hard disk  

(b) Extending the size of RAM 

(c) Adding more USB ports 

(d) Installing antivirus software 

(e) Replacing the power supply 

 

Q67. A handwritten signature can be converted into an 

image using which of the following devices? 

(a) Barcode Scanner 

(b) Graphic Tablet 

(c) Joystick 

(d) Optical Mouse 

(e) Trackball 

 

Q68. Which of the following is the use of SMTP? 

(a) File Transfer 

(b) Web Browsing 

(c) Email Transmission 

(d) Data Encryption 

(e) Remote Access  

 

Q69. Which of the following is a System Software? 

(a) Microsoft Word 

(b) Photoshop 

(c) UNIX 

(d) VLC Media Player 

(e) Chrome 

 

Q70. Which of the following ports is commonly used to 

connect an internal hard disk drive (HDD) to a 

motherboard? 

(a) USB 

(b) HDMI 

(c) SATA 

(d) Ethernet 

(e) VGA 

 

Q71. Which type of malware can spread across networks 

without attaching itself to a host file? 

(a) Virus 

(b) Worm  

(c) Trojan 

(d) Spyware 

(e) Adware 

 

Q72. What is a phishing attack? 

(a) An attack that involves sending fraudulent emails to steal 

personal information 

(b) A technique used to block websites 

(c) A method to encrypt data during transmission 

(d) A type of malware that infects files 

(e) A process for scanning networks for vulnerabilities 

 

Q73. How can parents monitor the type of content their 

children are accessing online? 

(a) Using Activity Logs 

(b) Using Antivirus Software 

(c) Disabling Internet Access 

(d) Installing External Storage 

(e) Using Word Processors 

 

Q74. What is the difference between IMAP and POP3 in 

email protocols? 

(a) IMAP deletes emails after downloading, while POP3 keeps 

them on the server 

(b) IMAP allows syncing across multiple devices, while POP3 

downloads emails to one device 

(c) IMAP is used for sending emails, while POP3 is used for 

receiving emails 

(d) IMAP encrypts emails, while POP3 does not 

(e) IMAP works offline, while POP3 requires an active internet 

connection 

 

Q75. What does whitelisting mean in parental lock settings? 

(a) Blocking specific websites 

(b) Allowing only approved websites or content 

(c) Monitoring all online activities 

(d) Disabling internet access 

(e) Tracking time spent online 

 

Q76. Which of the following is related to non-volatile 

memory? 

(a) RAM 

(b) Cache 

(c) SSD 

(d) Registers 

(e) CPU 

 

Q77. Which of the following technology is used in optical 

disks to store data? 

(a) Magnetic Field 

(b) Laser 

(c) Electrical Charge 

(d) Capacitive Touch 

(e) UV Rays 

 

Q78. What is a macro in MS Excel? 

(a) A built-in formula to perform calculations 

(b) A shortcut for creating charts 

(c) A feature to automate repetitive tasks 

(d) A formatting tool for adjusting cell size 

(e) A tool to sort data in ascending order 

 

https://www.adda247.com/activity/DAILY_QUIZZES
https://www.adda247.com/activity/PYP
https://www.adda247.com/activity/MAGAZINES


IBPS RRB Computer Capsule 2025 (PO and Clerk) 

 

 

8 
 

                                    

Q79. How do Virtual Reality (VR), Augmented Reality (AR), 

and Artificial Intelligence (AI) enhance human 

understanding of complex concepts? 

(a) By replacing human decision-making entirely 

(b) By creating immersive environments and intelligent systems 

that help visualize and process information 

(c) By automating all human tasks 

(d) By limiting access to information based on user preferences 

(e) By focusing only on physical task assistance 

 

Q80. In Quantum Computing, which element is used in place 

of traditional bits to represent and process information? 

(a) Classical Bits 

(b) Qubits 

(c) Registers 

(d) Cache 

(e) Transistors 

 

Solution 
 

S1. Ans.(b) 

Sol. Hacking refers to unauthorized access to a computer 

system or network with malicious intent. Hackers often exploit 

system vulnerabilities to gain access and manipulate or steal 

data. This illegal activity can lead to significant data breaches, 

loss of privacy, and financial damage. 

Important Key Points: 

1. Hacking involves breaking into systems to cause harm or 

steal sensitive information. 

2. This act is illegal and can result in severe legal 

consequences. 

Knowledge Booster: 

• Phishing is a type of social engineering attack where 

attackers trick users into providing sensitive information 

through fake emails or websites. 

• Data Mining is the process of analyzing large datasets to 

find patterns and insights, not related to unauthorized 

access. 

• Spoofing refers to disguising a communication source to 

appear as a trusted entity, but it does not involve direct 

unauthorized access. 

• Firewall Breach happens when a firewall is bypassed, but 

it's a specific type of attack, not necessarily related to 

hacking with malicious intent. 

 

S2. Ans.(a) 
Sol. Phishing is a common method used by attackers to steal 

personal information, such as user IDs, passwords, and other 

sensitive data. Attackers typically use fake emails, websites, or 

messages that mimic legitimate organizations to trick 

individuals into revealing their credentials. 

Important Key Points: 

1. Phishing is a form of social engineering that aims to 

deceive users into providing confidential information. 

2. It often involves the use of fake websites or email links that 

appear legitimate to users. 

Knowledge Booster: 

• Data Encryption is used to protect sensitive data, not to 

steal it. It ensures that data is secure during transmission. 

• Cloud Storage is a service used to store data remotely and 

securely; it is not related to identity theft. 

• Firewall is a security measure used to block unauthorized 

access to networks, not to steal information. 

• Debugging is the process of identifying and fixing errors in 

software code, and it has no relation to identity theft. 

 

S3. Ans.(b) 
Sol. CC (Carbon Copy) and BCC (Blind Carbon Copy) are 

terms used in email communication. CC allows the sender to 

send a copy of the email to recipients while making it visible to 

all other recipients. BCC allows the sender to send the same 

email to multiple recipients, but the recipients in the BCC field 

remain hidden from each other. 

Important Key Points: 

1. CC sends a copy of the email to other recipients, and all 

recipients can see who received the email. 

2. BCC hides the recipients from each other, providing privacy 

in mass email communication. 

Knowledge Booster: 

• Carbon Copy (CC) is used when you want others to be 

informed of the email but don't require direct action from 

them. 

• Blind Carbon Copy (BCC) is used to protect the privacy of 

recipients when sending emails to large groups or when you 

don't want recipients to see who else received the email. 

• Central Communication and Clear Copy are not related to 

email terms. 

• Backup Communication and Blind Contact Copy are 

incorrect and not used in email systems. 

 

S4. Ans.(a) 
Sol. A system hang or freeze is commonly caused by CPU 

Overload, where the processor is overwhelmed with too many 

tasks, preventing it from responding to new inputs. When the 

CPU is overloaded, the system becomes unresponsive, and users 

are unable to interact with the applications or operating system 

until the issue is resolved. 

Important Key Points: 

1. CPU Overload occurs when the processor is tasked with 

more operations than it can handle, leading to 

unresponsiveness. 

2. It is one of the most common causes of system freezes or 

hangs, especially when running multiple heavy applications. 
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Knowledge Booster: 

• System Reboot occurs when the system is restarted, but it 

is not a typical result of a system hang unless manually 

initiated. 

• Blue Screen of Death (BSOD) indicates a critical system 

error in Windows, which causes the system to crash, but it 
is different from a freeze. 

• Application Crash refers to a single program failing, not 

the entire system freezing. 

 

S5. Ans.(c) 
Sol. Microsoft Outlook is a popular email client used for 

sending and receiving emails. It is part of the Microsoft Office 

suite and provides features like calendar management, task 
scheduling, and contact management, making it a 

comprehensive tool for communication and productivity. 

Important Key Points: 

1. Microsoft Outlook allows users to manage emails, contacts, 
calendars, and tasks in one integrated platform. 

2. It supports multiple email accounts and integrates well with 

other Microsoft Office applications. 
Knowledge Booster: 

• Adobe Photoshop is used for graphic design and image 

editing, not for email management. 

• Microsoft Word is primarily used for word processing and 

document creation, not for emails. 

• VLC Media Player is a multimedia player used for playing 

audio and video files, not emails. 

• AutoCAD is a software application used for computer-aided 

design (CAD) and drafting, not for email communication. 

 

S6. Ans.(b) 
Sol. In a Gmail address, the "@" sign separates the username 

from the domain. For example, in the email address 

user@gmail.com, "user" is the username, and "gmail.com" is 
the domain. The "@" symbol is used universally in email 

addresses to distinguish between the local part (username) and 

the domain part (email provider). 

Important Key Points: 
1. The "@" sign is a standard separator between the username 

and the email service provider's domain name. 

2. Every valid email address has this structure: 
username@domain. 

Knowledge Booster: 

• Username and password are not separated by the "@" 

sign; they are used together for authentication but are kept 

separate from the email address format. 

• Email ID and contact number are unrelated to the 

structure of an email address. 

• Sender and recipient are defined in the "To" and "From" 

fields of an email, not by the "@" sign. 

• Local and international servers are not distinguished by 

the "@" sign; the domain specifies the email provider’s 

server. 
 

S7. Ans.(b) 
Sol. The Freeze Panes feature in MS Excel allows you to lock 

specific rows or columns so that they remain visible even when 

you scroll through other parts of the spreadsheet. 

• For example, freezing the top row ensures that the headers 

remain visible as you navigate through the worksheet. 

• This feature is especially useful for large datasets to keep 

key references in view. 

Important Key Points: 

1. To enable Freeze Panes, go to the View tab and select 

Freeze Panes. 

2. Options include: 

o Freeze Top Row: Locks the first row. 

o Freeze First Column: Locks the first column. 

o Custom Freeze: Locks specific rows and columns 

based on your selection. 

3. Freeze Panes enhances navigation and understanding of 

large datasets. 

Knowledge Booster: 

1. Headers: Refer to the first row (default) and are only 

visible when scrolling vertically unless frozen. 

2. Gridlines: Provide structure to cells but do not stay fixed 

during scrolling. 

3. Active Cell: The currently selected cell, which changes as 

you move through the sheet. 

 

S8. Ans.(d) 
Sol. Charles Babbage is widely recognized as the "Father of 

Computers." He designed the concept of a programmable 

computer and is credited with inventing the Analytical Engine, 

an early mechanical computer that laid the foundation for 

modern computing. 

Important Key Points: 

1. Charles Babbage conceptualized and designed the first 

mechanical computer, the Analytical Engine. 

2. His work laid the groundwork for the development of 

modern programmable computers. 

Knowledge Booster: 

• Alan Turing is considered the father of theoretical 

computer science and artificial intelligence, but not the 

father of computers. 

• Steve Jobs co-founded Apple and was instrumental in the 

personal computer revolution, but he is not the father of 

computers. 

• Bill Gates is the co-founder of Microsoft and played a key 

role in software development, particularly with the 

Windows operating system, but not the father of computers. 

• John von Neumann contributed to the architecture of 

modern computers, particularly the stored-program 

concept, but he is not referred to as the father of 

computers. 
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S9. Ans.(b) 
Sol. A Worm is a type of malware that can self-replicate and 

propagate across networks without the need for a host program. 

Worms spread by exploiting vulnerabilities in network systems 

and can cause widespread disruption by consuming bandwidth 

and overloading systems. 

Important Key Points: 

1. Worms can replicate independently and spread across 

networks, making them highly contagious. 

2. They do not require a host file or program to execute and 

spread, unlike viruses. 

Knowledge Booster: 

• Virus: A virus needs a host file or program to replicate and 

spread. It infects files and requires user action to spread. 

• Trojan Horse: Trojans disguise themselves as legitimate 

software but do not replicate or spread on their own. 

• Spyware: Spyware monitors user activities without self-

replication capabilities. 

• Ransomware: Ransomware encrypts files and demands 

payment for decryption but does not self-replicate without 

assistance. 

 

S10. Ans.(c) 
Sol. MS Word is a word processing software developed by 

Microsoft, primarily used for creating, editing, formatting, and 

printing documents. It is widely used in offices, schools, and 

homes for tasks like writing reports, creating resumes, and 

drafting letters. 

Important Key Points: 

1. MS Word is specifically designed for creating text-based 

documents with various formatting options. 

2. It allows users to add images, tables, and charts, making it a 

versatile tool for document creation. 

Knowledge Booster: 

• MS Excel is used for creating spreadsheets and performing 

data analysis, not for document creation. 

• MS PowerPoint is used for creating presentations, not for 

text-based documents. 

• MS Access is a database management system, not intended 

for document creation. 

• Adobe Photoshop is a graphic design tool used for editing 

images, not for document creation. 

 

S11. Ans.(d) 
Sol. The concentric circles on a hard disk are called Tracks. 

These tracks are used to store and organize data on the surface 

of the hard disk. Each track is divided into smaller units called 

sectors, which contain the actual data. 

Important Key Points: 

1. Tracks are circular paths on the surface of a hard disk 

where data is magnetically recorded. 

2. Data on hard disks is organized into tracks, which are 

further subdivided into sectors for easier data access. 

Knowledge Booster: 

• Sectors are subdivisions of a track and contain the actual 

data storage units. 

• Clusters refer to groups of sectors that are treated as a unit 

for data storage. 

• Blocks are the basic units of data storage in some file 

systems, particularly in memory storage. 

• Cylinders are a set of tracks located directly above and 

below each other on a hard disk platter. 

 

S12. Ans.(c) 

Sol. FORTRAN is example of High-Level Programming 

Languages. High-level languages are designed to be easy to 

read and write, abstracting away the hardware details of a 

computer. These languages are closer to human languages and 

are easier for developers to understand and use for complex 

programming tasks. 

Important Key Points: 

1. FORTRAN (Formula Translation) was one of the earliest 

high-level languages, designed for scientific and engineering 

computations. 

2. BASIC (Beginner's All-purpose Symbolic Instruction Code) 

was designed to simplify programming for beginners and 

students. 

3. COBOL (Common Business-Oriented Language) is a High-

Level Programming Language. It was primarily designed 

for business, finance, and administrative systems for 

companies and governments. COBOL is known for its 

readability and is often used in legacy systems for handling 

large amounts of data processing. 

Knowledge Booster: 

• Assembly Language is a low-level programming language 

that is closer to machine code, not high-level like FORTRAN 

and BASIC. 

• Machine Language is the lowest-level programming 

language, consisting of binary code, which is directly 

understood by a computer’s CPU. 

• Scripting Languages like Python and JavaScript are used 

for automating tasks but are different from traditional high-

level programming languages. 

• Low-Level Language refers to languages like assembly or 

machine language that are closer to hardware and less 

abstracted. 

 

S13. Ans.(c) 

Sol. A Scanner is a device used to convert hard copy documents, 

such as printed papers or photographs, into digital copies. The 

scanner captures the image or text from the physical document 

and transforms it into a digital format that can be stored on a 

computer. 
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Important Key Points: 

1. Scanners digitize hard copy documents and store them in 

formats like PDF, JPEG, or TIFF. 

2. The digital copy can be edited, stored, or shared 

electronically after scanning. 

Knowledge Booster: 

• Printers are used to convert digital files into physical hard 

copies, the reverse of scanning. 

• Monitors display digital content but are not involved in 

converting physical documents to digital form. 

• CPUs process data but are not used for converting 

documents. 

• Keyboards are input devices used for typing, not for 

document conversion. 

 

S14. Ans.(c) 
Sol. The shortcut key Ctrl + A is used to select all the content in 

a document, whether it’s text, images, or other elements. This 

command works in most applications, including word 

processors, web browsers, and file explorers, allowing users to 

quickly highlight all content with a single key combination. 

Important Key Points: 

1. Ctrl + A is the universal shortcut for selecting everything in 

a document or window. 

2. It saves time by avoiding the need to manually highlight 

content using the mouse. 

Knowledge Booster: 

• Ctrl + C is the shortcut for copying selected content. 

• Ctrl + X is the shortcut for cutting selected content. 

• Ctrl + S is used for saving the current document. 

• Ctrl + V is the shortcut for pasting copied or cut content. 

 

S15. Ans.(a) 
Sol. The shortcut key Ctrl + Home is used to jump to the 

beginning of a document in MS Word. This combination 

instantly moves the cursor to the very first character of the 

document, no matter where you are within the file. 

Important Key Points: 

1. Ctrl + Home is a quick way to navigate to the start of a 

document, saving time from scrolling manually. 

2. It is a standard shortcut across many word processing 

applications. 

Knowledge Booster: 

• Ctrl + End moves the cursor to the end of the document, not 

the beginning. 

• Ctrl + B is used to bold selected text. 

• Alt + Tab switches between open applications but does not 

affect document navigation. 

• Shift + Home selects all text from the current cursor 

position to the beginning of the line, not the document. 

 

S16. Ans.(b) 
Sol. Bluetooth is a technology used for wireless file transfer 

within a short range, typically up to 10 meters. It allows devices 

like smartphones, laptops, and tablets to share files, photos, and 

data without needing cables or a physical connection. 

Important Key Points: 

1. Bluetooth provides wireless connectivity for file sharing 

between devices over short distances. 

2. It is widely used in mobile devices, laptops, and even 

peripheral devices like headphones and speakers for 

wireless communication. 

Knowledge Booster: 

• USB Cable requires a physical connection for data transfer 

and does not offer wireless capabilities. 

• Ethernet is used for wired networking and does not 

facilitate wireless file transfer. 

• HDMI is used to transmit audio and video signals, not for 

file transfer. 

• CD-ROM is a physical medium used to store data but does 

not support wireless transfer. 

 

S17. Ans.(b) 
Sol. A firewall is a network security system designed to block 

unauthorized access while permitting authorized 

communications. It acts as a barrier between a trusted internal 

network and untrusted external networks, such as the internet, 

by filtering incoming and outgoing traffic based on 

predetermined security rules. 

Important Key Points: 

1. Firewalls are essential for preventing cyberattacks and 

unauthorized access to sensitive data on a network. 

2. Firewalls can be implemented in both hardware and 

software forms, providing protection for individual devices 

or entire networks. 

Knowledge Booster: 

• Monitoring CPU performance is not the function of a 

firewall; this task is handled by system monitoring tools. 

• Increasing internet speed is not a function of a firewall; it 

works to secure the network, not optimize performance. 

• Storing data is the job of storage devices, not firewalls. 

• Managing software updates is a task performed by update 

management tools, not firewalls. 

 

S18. Ans.(b) 
Sol. The shortcut key Ctrl + S is used to save a document in MS 

Word. This command helps you quickly save any changes made 

to the document, ensuring that your work is not lost. 

Important Key Points: 

1. Ctrl + S is a universal shortcut for saving documents in 

many applications, not just MS Word. 

2. Regularly using Ctrl + S helps to avoid losing unsaved work 

due to system crashes or accidental closures. 
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Knowledge Booster: 

• Ctrl + P is used to print a document. 

• Ctrl + A is used to select all content in the document. 

• Ctrl + Z is the shortcut for undoing the last action. 

• Ctrl + X is used to cut the selected content. 

 

S19. Ans.(c) 
Sol. Word processors (e.g., MS Word) and spreadsheet 

applications (e.g., MS Excel) are examples of Application 

Software. These types of software are designed to help users 

perform specific tasks, such as writing documents or organizing 

data in tabular form. Application software runs on top of system 

software and caters to user-specific functions. 

Important Key Points: 

1. Application Software includes programs designed for end-

users, such as word processing, spreadsheets, and 

presentations. 

2. They enhance user productivity by providing tools for tasks 

like data analysis and document creation. 

Knowledge Booster: 

• System Software includes the operating system, which 

manages hardware and basic system operations, not user-

specific tasks. 

• Utility Software helps maintain and optimize the 

computer's performance, such as antivirus or disk 

management tools. 

• Security Software is designed to protect the system from 

malware and cyber threats. 

• Firmware is low-level software stored on hardware 

components to control device functionality. 

 

S20. Ans.(c) 
Sol. The unit of measurement for the timer watch in a 

microprocessor is Hertz (Hz). This measures the clock 

frequency, which indicates how many cycles per second the 

timer operates. The microprocessor’s internal clock governs the 

speed at which the microprocessor executes instructions, and it 

is typically measured in millions or billions of Hertz (MHz or 

GHz). 

Important Key Points: 

1. Hertz (Hz) is the standard unit for frequency, including the 

timing functions within a microprocessor. 

2. A higher clock frequency (measured in Hertz) allows for 

faster execution of instructions. 

Knowledge Booster: 

• Volts measure electrical potential or voltage, not frequency. 

• Amperes measure electric current, not time-related 

functions. 

• Ohms measure resistance in an electrical circuit, not the 

frequency of a timer. 

• Joules measure energy, not clock frequency in a 

microprocessor. 
 

S21. Ans.(c) 

Sol. RAM (Random Access Memory) is the primary storage in 

a computer used for temporarily storing data. It holds data 

and instructions that are currently being used by the CPU for 

processing. RAM is volatile, meaning its contents are lost when 

the computer is turned off. 

Important Key Points: 

1. RAM stores data temporarily and allows quick read and 

write access to support active tasks. 

2. It is essential for multitasking, as it provides the CPU with 

fast access to necessary data. 

Knowledge Booster: 

• CPU (Central Processing Unit) processes data but does not 

store it temporarily. 

• CD-ROM is a read-only storage medium, not used for 

temporary data storage. 

• Flash Drive is used for portable, non-volatile storage, not 

temporary memory. 

• ROM (Read-Only Memory) contains permanent data for 

system boot-up and other critical functions but does not 

store temporary data. 

 

S22. Ans.(b) 

Sol. Ctrl (Control) and Alt (Alternate) are known as Modifier 

Keys. These keys are used in combination with other keys to 

perform specific functions or shortcuts, such as Ctrl + C for 

copying and Alt + Tab for switching between open applications. 

Modifier keys alter the function of other keys when pressed 

together. 

Important Key Points: 

1. Modifier Keys like Ctrl and Alt enable keyboard shortcuts 

that help users perform tasks more efficiently. 

2. They do not perform any action on their own but modify the 

function of other keys when used together. 

Knowledge Booster: 

• Function Keys (e.g., F1, F2) perform specific tasks, often 

associated with system or application functions. 

• Navigation Keys (e.g., arrow keys) are used to move the 

cursor around a document or screen. 

• Toggle Keys (e.g., Caps Lock) switch between two states 

(on/off) when pressed. 

• Numeric Keys are used to input numbers and are found on 

the number pad. 

 

S23. Ans.(c) 

Sol. A Window is the rectangular area on the computer screen 

that displays information and allows users to run programs. In 

operating systems like Microsoft Windows, multiple windows 

can be opened at once, enabling users to view and interact with 

different applications simultaneously. 
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Important Key Points: 

1. A Window allows users to view and interact with a 

program or document on the screen. 

2. Multiple windows can be resized, minimized, or closed as 

needed, enhancing multitasking. 

Knowledge Booster: 

• The Taskbar is located at the bottom of the screen and 

shows open applications but is not used for displaying 

program content. 

• The Menu Bar provides access to program functions and 

commands but is not the area where content is displayed. 

• The Desktop is the main screen area where icons and 

shortcuts are placed, not where programs run. 

• The Toolbar is a set of icons or buttons that provide quick 

access to functions within a window. 

 

S24. Ans.(b) 
Sol. Burn is not a computer security threat. It refers to physical 

damage, such as overheating or hardware failure, not a 

cyberattack or software vulnerability. The other options are all 

forms of cyber threats that can compromise a computer’s 

security or functionality. 

Important Key Points: 

1. SQL Injection is a type of attack that targets databases by 

injecting malicious SQL queries. 

2. DOS (Denial of Service) Attack is a method of 

overwhelming a system with traffic to make it unavailable 

to users. 

3. Phishing involves tricking users into revealing sensitive 

information such as passwords or credit card details. 

Knowledge Booster: 

• Power Surge can damage hardware but is not classified as 

a cyber threat. It can result from electrical issues but does 

not involve malicious intent. 

• SQL Injection exploits vulnerabilities in applications that 

use SQL databases. 

• DOS Attack disrupts service by overloading a network or 

server. 

• Phishing uses deceptive emails or websites to obtain 

sensitive information. 

 

S25. Ans.(c) 
Sol. In CISC, which stands for Complex Instruction Set 

Computer, the letter I refers to Instruction. CISC is a type of 

computer architecture where single instructions can execute 

multiple low-level operations, such as loading from memory, 

performing arithmetic, and storing results in memory. 

Important Key Points: 

1. CISC architecture allows complex instructions to perform 

multiple operations, reducing the number of instructions 

per program. 

2. It contrasts with RISC (Reduced Instruction Set Computer), 

where simpler instructions are used, and more are required 

to perform a task. 

Knowledge Booster: 

• Internet refers to the global network, unrelated to CISC 

architecture. 

• Integration involves combining components but is not 

relevant in the context of CISC. 

• Information is not specific to computer architecture. 

• Interface refers to the interaction between systems but is 

not part of the CISC acronym. 

 

S26. Ans.(d) 
Sol. The decimal number 15 can be converted to binary by 

repeatedly dividing the number by 2 and recording the 

remainders. Starting with 15, the binary equivalent is: 

• 15 ÷ 2 = 7, remainder 1 

• 7 ÷ 2 = 3, remainder 1 

• 3 ÷ 2 = 1, remainder 1 

• 1 ÷ 2 = 0, remainder 1 

Reading the remainders from bottom to top, the binary 

representation of 15 is 1111. 

Important Key Points: 

1. Binary numbers consist of only 0s and 1s, representing 

powers of 2. 

2. The binary number 1111 represents 

1×23+1×22+1×21+1×20=8+4+2+1=15. 

Knowledge Booster: 

• 1001 is the binary representation for 9. 

• 1100 is the binary representation for 12. 

• 1010 is the binary representation for 10. 

• 1000 is the binary representation for 8. 

 

S27. Ans.(b) 
Sol. India's first computer, HEC-2M, was installed at the Indian 

Statistical Institute (ISI) in Kolkata in 1955. It was one of the 

earliest computers used in the country for statistical and 

scientific purposes. The installation of this computer marked 

the beginning of computing in India and was a significant 

development in the field of technology. 

Important Key Points: 

1. HEC-2M was among the first computers used in India and 

contributed greatly to research and academic 

advancements. 

2. Kolkata (then Calcutta) became the initial hub for 

computing in India with this installation. 

Knowledge Booster: 

• Mumbai is known for being a financial hub, but it didn’t 

host the first computer in India. 

• Bengaluru is now the IT capital of India but didn’t have the 

first computer. 
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• Delhi and Chennai are significant cities, but neither was 

home to India’s first computer. 

 

S28. Ans.(c) 

Sol. Bing is the search engine developed by Microsoft. It was 

launched in 2009 as a successor to earlier Microsoft search 

engines, and it offers web, image, and video search capabilities. 

Bing is integrated into several Microsoft services and products, 

including the Windows operating system and the Edge web 

browser. 

Important Key Points: 

1. Bing is Microsoft's answer to other popular search engines 

like Google and Yahoo. 

2. It is used as the default search engine in Microsoft’s Edge 

browser. 

Knowledge Booster: 

• Google is developed by Google LLC, not Microsoft. 

• Yahoo is another search engine, but it is not owned by 

Microsoft. 

• DuckDuckGo is known for its focus on privacy but is not 

affiliated with Microsoft. 

• Baidu is a Chinese search engine, not related to Microsoft. 

 

S29. Ans.(b) 

Sol. Vint Cerf is widely recognized as the "Father of the 

Internet." Along with Robert E. Kahn, he developed the TCP/IP 

protocol, which is the fundamental technology that powers the 

Internet. His work laid the foundation for the modern global 

network, allowing computers to communicate over vast 

distances. 

Important Key Points: 

1. Vint Cerf and Robert E. Kahn co-designed the TCP/IP 

protocol suite, which enabled the creation of the Internet. 

2. The development of this protocol in the 1970s was crucial 

for establishing the foundation for the Internet as we know 

it today. 
 

 

Knowledge Booster: 

• Tim Berners-Lee is credited with inventing the World 

Wide Web (WWW), not the Internet itself. 

• Bill Gates co-founded Microsoft but is not related to the 

invention of the Internet. 

• Steve Jobs co-founded Apple, but he is not considered a 

pioneer of the Internet. 

• Marc Andreessen co-authored Mosaic, one of the first web 

browsers, but is not the father of the Internet. 

 

S30. Ans.(a) 
Sol. Word Matrix is not a type of printer. It is an incorrect term 

in this context. Dot Matrix, Laser, Inkjet, and Thermal are all 

legitimate types of printers used for different printing 

technologies. 

Important Key Points: 

1. Dot Matrix printers use a print head that moves back and 

forth and prints by impact, pressing an ink-soaked ribbon 

against the paper. 

2. Laser printers use a laser beam to create an image on a 

drum, which is then transferred to paper using toner. 

3. Inkjet printers spray tiny droplets of ink onto paper to form 

text or images. 

4. Thermal printers use heat to transfer images onto thermal 

paper. 

Knowledge Booster: 

• Word Matrix does not exist as a printer type and is 

unrelated to any printing technology. 

• Dot Matrix printers are among the oldest impact printers 

still in use for specific purposes. 

• Laser printers are known for high-speed and high-quality 

printing, especially in offices. 

• Inkjet printers are commonly used in homes and small 

offices for color and photo printing. 

• Thermal printers are used in point-of-sale systems and for 

printing receipts. 

 

S31. Ans.(b) 
Sol. The shortcut key Ctrl + H is used to open the Find and 

Replace dialog box in most word processing programs, 

including MS Word. This allows users to search for specific text 

in the document and replace it with new text. 

Important Key Points: 

1. Ctrl + H opens the Find and Replace tool, enabling users to 

efficiently replace instances of text or formatting 

throughout the document. 

2. This shortcut enhances productivity by automating the 

process of finding and modifying text. 

3. F5 can be used to open the Find and Go To window, 

allowing users to jump to specific locations within the 

document, but it does not include the replace function. 
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Knowledge Booster: 

• Ctrl + F is used to find specific text in a document but does 

not open the replace function. 

• Ctrl + R is used to align text to the right in most word 

processors. 

• Ctrl + G is used to go to a specific page, section, or line in 

the document. 

• Ctrl + P is the shortcut for printing the document. 

 

S32. Ans.(a) 
Sol. A Nibble is half of a byte, consisting of 4 bits. A byte is 

made up of 8 bits, so half of that is 4 bits, which is referred to as 

a nibble. Nibbles are commonly used in computing, particularly 

in systems that work with hexadecimal numbers. 

Important Key Points: 

1. A Nibble is composed of 4 bits, and 2 nibbles make up a 

byte. 

2. Nibbles are often used in digital systems and hexadecimal 

representations, where each hexadecimal digit corresponds 

to 4 bits (or 1 nibble). 

Knowledge Booster: 

• A Bit is the smallest unit of data in computing, representing 

a single binary value of 0 or 1. 

• A Word refers to a group of bits processed as a single unit 

by the CPU, typically larger than a byte. 

• Kilobyte is a unit of data storage equal to 1024 bytes. 

• Megabyte is a unit of data storage equal to 1024 kilobytes. 

 

S33. Ans.(b) 
Sol. The shortcut key Ctrl + M is used to add a new slide in 

Microsoft PowerPoint. This allows users to quickly insert a 

new slide without navigating through the menus, enhancing 

productivity while creating presentations. 

Important Key Points: 

1. Ctrl + M directly adds a new slide in PowerPoint, making it 

a crucial shortcut for presentation design. 

2. This shortcut works universally across most versions of 

PowerPoint, making it widely applicable. 

Knowledge Booster: 

• Ctrl + N is used to create a new presentation, not to add a 

slide. 

• Ctrl + S is used to save the presentation. 

• Ctrl + P is used to print the presentation. 

• Ctrl + T is used for opening the Font dialog box in many 

applications, but not for adding a new slide. 

 

S34. Ans.(c) 
Sol. SSD (Solid State Drive) is the fastest memory among the 

options provided. SSDs use flash memory and have no moving 

parts, which allows them to access and transfer data much 

faster than traditional storage media like CDs, DVDs, or hard 

disks. 

Important Key Points: 

1. SSDs provide significantly faster read/write speeds 

compared to optical media (CD/DVD) and traditional hard 

disks. 

2. SSDs are commonly used in modern computers and laptops 

due to their speed and reliability, especially for running 

operating systems and applications. 

Knowledge Booster: 

• CD and DVD are optical storage media with much slower 

data access speeds compared to SSDs. 

• Flash Drives are portable storage devices, but their 

read/write speeds are typically slower than SSDs. 

• Hard Disks (HDDs) have mechanical parts, making them 

slower than SSDs for data access. 

 

S35. Ans.(b) 
Sol. The shortcut key Ctrl + R is used to refresh or reload a web 

page in most web browsers. Pressing this combination forces 

the browser to reload the current page, ensuring that the user 

sees the latest version of the website. 

Important Key Points: 

1. Ctrl + R is commonly used in web browsers like Chrome, 

Firefox, and Edge for refreshing a web page. 

2. The refresh action helps retrieve the latest data from the 

server or reloads the current state of the webpage. 

Knowledge Booster: 

• Ctrl + F is used to find specific text on a webpage. 

• Alt + F4 is used to close the current window or application. 

• Ctrl + F6 is used for switching between open documents in 

some applications. 

• Shift + R does not refresh a web page. 

 

S36. Ans.(c) 
Sol. A key feature of Dot Matrix Printers is their ability to 

print multiple copies using carbon paper. This is because dot 

matrix printers use an impact mechanism, where the print head 

strikes an ink ribbon to form characters on the paper, allowing 

them to produce multiple copies simultaneously if carbon paper 

is placed between the sheets. 

Important Key Points: 

1. Dot Matrix Printers are impact printers, making them 

suitable for tasks that require printing multiple copies using 

carbon paper, such as receipts and invoices. 

2. Although outdated compared to modern printers, dot 

matrix printers are still used in specific applications where 

such functionality is needed. 

Knowledge Booster: 

• Coloured Printing is not a feature of dot matrix printers, as 

they are typically limited to monochrome. 

• High-Resolution Printing is not characteristic of dot 

matrix printers; they offer lower resolution compared to 

modern printers like inkjet or laser. 
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• Quiet Printing is not a feature of dot matrix printers; they 

tend to be noisier than modern non-impact printers. 

• Laser Precision is a feature of laser printers, not dot matrix 

printers. 

 

S37. Ans.(b) 

Sol. The Insert tab in MS PowerPoint allows users to add 

various elements such as tables, charts, pictures, and other 

media into slides. It is the primary tab for inserting content that 

enhances the visual appeal and functionality of a presentation. 

Important Key Points: 

1. The Insert tab provides options for adding tables, charts, 

images, shapes, and media files like audio and video. 

2. It is essential for creating dynamic and visually engaging 

presentations by including multimedia elements. 

Knowledge Booster: 

• The Home tab contains basic formatting options but is not 

used for inserting tables, charts, or pictures. 

• The Design tab is used for slide design and themes, not for 

adding content elements. 

• The View tab allows you to change the view of your 

presentation but not to insert content. 

• The Review tab is primarily for checking spelling, grammar, 

and adding comments, not for inserting tables or charts. 

 

S38. Ans.(b) 

Sol. The Conversation View feature groups emails with the 

same subject line into a single conversation. This feature helps 

users keep track of email threads more easily by displaying all 

related messages in a collapsed view, avoiding clutter in the 

inbox. 

Important Key Points: 

1. Conversation View is commonly used in email clients like 

Gmail and Outlook to organize related emails into one 

thread. 

2. It helps users follow discussions and responses in an 

organized manner, making it easier to manage long email 

exchanges. 

Knowledge Booster: 

• Spam Filter is used to detect and move unwanted or 

suspicious emails to the spam folder. 

• Thread Sorting refers to manually organizing emails but is 

not a specific feature for grouping emails automatically. 

• Email Archiving is used to store old emails for future 

reference, but it does not group emails by subject. 

• Priority Inbox is a feature that sorts emails by importance, 

not by grouping them into conversations. 

 

S39. Ans.(a) 
Sol. Autofill is a feature in web browsers that automatically fills 

in information such as usernames, passwords, addresses, and 

payment details on web forms. This feature saves time by 

retrieving previously stored information and applying it to the 

appropriate fields on a web page. 

Important Key Points: 

1. Autofill can store commonly used information like login 

credentials, shipping addresses, and payment methods, 

making online transactions and form submissions quicker. 

2. It is available in most web browsers, such as Chrome, 

Firefox, and Edge. 

Knowledge Booster: 

• Cache stores temporary data from websites to speed up 

page loading, but it does not autofill forms. 

• Cookies are small data files used to track user sessions and 

preferences, but they do not fill in information. 

• Bookmarks are used to save web page URLs for quick 

access, but they do not autofill forms. 

• Pop-up Blocker prevents unwanted pop-up windows from 

appearing but has no role in filling forms. 

 

S40. Ans.(c) 
Sol. Linux is a widely used open-source operating system. It is 

freely available and can be modified and distributed by anyone. 

Linux is popular for its flexibility, security, and use in a wide 

range of devices, from servers to personal computers. 

Important Key Points: 

1. Linux is known for being open-source, allowing users to 

access its source code and customize it as needed. 

2. It is highly regarded for its security, stability, and 

widespread use in servers, development environments, and 

even smartphones (via Android). 

Knowledge Booster: 

• Windows is a closed-source operating system developed by 

Microsoft. 

• macOS is a proprietary operating system by Apple. 

• iOS is the operating system for Apple's mobile devices and 

is not open-source. 

• Splunk is not an operating system; it is a platform for 

searching, monitoring, and analyzing machine-generated 

data. 

 

S41. Ans.(c) 
Sol.  The document is temporarily stored in RAM (Random 

Access Memory) while working on a PC. RAM is volatile 

memory, which means it stores data only when the computer is 

powered on. It allows for quick access to data and is used to 

hold the data temporarily until the user saves the document or 

closes the application. When the system is turned off, all data in 

RAM is lost unless saved to a more permanent storage medium 

like a hard disk. 
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Important Key Points: 

1. RAM is responsible for temporary storage of active 

documents and processes. 

2. Data in RAM is lost when the computer is powered off, 

making it volatile memory. 

Knowledge Booster: 

• Hard Disk: Used for permanent data storage, not 

temporary storage during active sessions. 

• CD-ROM: A read-only storage medium, not suitable for 

temporary or active document storage. 

• ROM: Non-volatile memory that contains firmware; it's not 

used for document storage. 

• USB Drive: A portable storage device used for transferring 

and saving data, not for temporary storage during active 

use. 

 

S42. Ans.(c) 
Sol. The main purpose of Microsoft Access is to serve as a 

Database Management System (DBMS). It is designed to 

create and manage databases, enabling users to store, retrieve, 

and organize large volumes of data. Microsoft Access provides 

tools for database design, query building, and reporting, making 

it ideal for small-scale to medium-sized database solutions. 

Important Key Points: 

1. Microsoft Access is used for managing relational 

databases, supporting forms, queries, and reports. 

2. It allows for easy data entry and retrieval, making it a 

powerful tool for database management tasks. 

Knowledge Booster: 

• Word Processing is the function of Microsoft Word, not 

Microsoft Access. 

• Spreadsheet Creation is handled by Microsoft Excel, which 

specializes in data analysis, not database management. 

• Graphic Design is managed by specialized software like 

Adobe Photoshop or CorelDRAW, not Microsoft Access. 

• Email Management is the primary function of Microsoft 

Outlook, not Microsoft Access. 

 

S43. Ans.(c) 
Sol.  A Flip-Flop is a basic memory element used in digital 

circuits to store a single bit of data. It is a type of bistable circuit, 

meaning it has two stable states (0 and 1), and it is commonly 

used in memory devices, counters, and shift registers. Flip-flops 

are fundamental building blocks for sequential logic circuits in 

digital systems. 

Important Key Points: 

1. Flip-Flop is a circuit that can maintain a stable state, 

representing either a 0 or 1, and is commonly used in 

memory elements. 

2. It is used to store data temporarily in digital systems, 

particularly in memory storage and processing tasks. 

Knowledge Booster: 

• Register: Registers are groups of flip-flops used to store 

multiple bits of data temporarily. 

• Cache: A high-speed memory component, not used for 

storing individual bits but for frequently accessed data. 

• RAM: Random Access Memory stores data temporarily 

while the system is running, but individual bits are often 

stored using flip-flops in its internal design. 

• SSD: Solid State Drives are non-volatile storage devices, 

storing large amounts of data but no single bits like flip-

flops. 

 

S44. Ans.(d) 
Sol.  To convert the binary number (101010) ₂ into decimal, we 

apply the binary-to-decimal conversion method by multiplying 

each bit by 2 raised to the power of its positional index (starting 

from 0 on the right). 

(101010)2 =1×25+0×24+1×23+0×22+1×21+0×20 

(101010)2 =32+0+8+0+2+0 

(101010)2 =42 

Thus, the decimal equivalent of (101010) ₂ is 42. 

Important Key Points: 

1. Binary-to-decimal conversion involves multiplying each bit 

by powers of 2, starting from the rightmost bit. 

2. This conversion method is essential in computing, 

especially in low-level data operations. 

Knowledge Booster: 

• Binary System: It is a base-2 numeral system consisting of 

only 0s and 1s, which is fundamental in computer 

operations. 

• Decimal System: It is a base-10 numeral system, the 

standard system used for representing integer values in 

daily life. 

• Octal System: Another numeral system with a base of 8, 

often used in computing, especially in legacy systems. 

• Hexadecimal System: A base-16 numeral system widely 

used in programming and computing to represent large 

binary numbers in a more compact form. 

 

S45. Ans.(d) 
Sol.  The First Generation of computers used vacuum tubes as 

the primary technology for circuitry. These computers were 

large, consumed a lot of electricity, and produced significant 

heat. Examples of first-generation computers include the ENIAC 

and UNIVAC. The vacuum tubes acted as electronic switches but 

were unreliable and prone to frequent failures. 

Important Key Points: 

1. First Generation computers (1940–1956) used vacuum 

tubes for processing. 

2. These computers were known for their large size, heat 

production, and high energy consumption. 
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Knowledge Booster: 

• Second Generation: Computers in this generation used 

transistors instead of vacuum tubes, which made them 

smaller and more reliable. 

• Third Generation: Integrated Circuits (ICs) replaced 

transistors, further reducing the size and increasing the 

efficiency of computers. 

• Fourth Generation: Microprocessors became the defining 

technology, integrating thousands of ICs on a single chip. 

• Fifth Generation: Focuses on artificial intelligence (AI) and 

advanced parallel processing, moving away from traditional 

hardware components like vacuum tubes and transistors. 

 

S46. Ans.(b) 
Sol. The Accumulator is a specialized register in the CPU that 

temporarily stores intermediate results while the Arithmetic 

Logic Unit (ALU) performs calculations. It is designed to 

quickly access and store data during processing, reducing the 

need to repeatedly access slower memory components, making 

the overall operations faster. 

Important Key Points: 

1. The Accumulator serves as a temporary storage location 

for ALU operations, holding intermediate results for faster 

processing. 

2. It plays a crucial role in speeding up computations by 

minimizing data transfers between the CPU and main 

memory. 

Knowledge Booster: 

• RAM: It holds data for active applications, but it is slower 

than registers like the accumulator and is not directly used 

for storing ALU results. 

• Control Unit: It directs the operation of the CPU but does 

not store data during ALU operations. 

• ROM: Read-Only Memory stores firmware and cannot be 

used for temporary data storage in ALU operations. 

 

S47. Ans.(d) 
Sol. Python is a programming language and is not a hardware 

component. It is a high-level, general-purpose programming 

language used to develop software and applications. Hardware, 

on the other hand, refers to the physical components of a 

computer system, such as a hard disk, monitor, and 

motherboard. 

Important Key Points: 

1. Python is a software tool used for writing code, not a 

physical device or component. 

2. Hardware includes tangible, physical components like hard 

drives, monitors, and motherboards that make up a 

computer system. 

Knowledge Booster: 

• Hard Disk: A physical storage device used for storing data 

in computers. 

• Monitor: A hardware device used to display output from a 

computer. 

• Printer: A peripheral device that produces physical copies 

of digital documents. 

• Motherboard: The central circuit board that connects and 

facilitates communication between all the components of a 

computer. 

 

S48. Ans.(b) 

Sol.  The Star Mark feature is used in email services to mark 

important emails for easy access. By adding a star to an email, 

users can quickly identify and prioritize their important 

messages, ensuring that they are easy to find and follow up on 

later. 

Important Key Points: 

1. The Star Mark helps users organize their inbox by 

highlighting important emails. 

2. This feature is widely available in popular email platforms 

such as Gmail to streamline inbox management. 

Knowledge Booster: 

• Archive: Moves emails out of the inbox but does not 

highlight important emails. 

• Draft: Refers to emails that have been written but not yet 

sent, not used for marking important messages. 

• Folder: Helps in organizing emails but doesn't specifically 

mark them as important. 

• Priority Label: Labels emails based on importance but 

differs from the star mark, which visually highlights specific 

emails. 

 

S49. Ans.(c) 
Sol. The statement "Data is lost after the PC is off" is incorrect 

for non-volatile memory. Non-volatile memory retains data 

even when the power is turned off. This type of memory is 

designed to store data permanently until it is intentionally 

erased or overwritten, which is why it is used in devices like 

SSDs, hard drives, and USB drives. 

Important Key Points: 

1. Non-volatile memory retains data without requiring 

power, making it ideal for permanent storage. 

2. It is commonly used in storage devices like SSDs, hard 

drives, and flash drives. 

Knowledge Booster: 

• Data is retained even after the PC is turned off: This is 

the defining feature of non-volatile memory. 

• It is commonly used for long-term storage: Non-volatile 

memory is designed for retaining data long-term, unlike 

volatile memory like RAM. 

• Non-volatile memory includes SSDs and Hard Drives: 

Both of these are examples of non-volatile storage devices. 
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• It is slower than volatile memory like RAM: This is true 

because non-volatile memory typically operates at slower 

speeds compared to volatile memory, which is optimized 

for fast access during active processes. 

 

S50. Ans.(b) 
Sol. The primary use of middleware is to facilitate the 

processing of multiple synchronous transactions between 

applications. Middleware acts as an intermediary, allowing 

different systems to communicate and coordinate tasks, 

especially in distributed or networked environments. This 

ensures smooth data exchange and interaction between various 

applications, even when they operate in different environments. 

Important Key Points: 

1. Middleware supports real-time communication between 

applications, allowing for efficient processing of multiple 

transactions simultaneously. 

2. It helps in managing communication, authentication, and 

transaction coordination in distributed systems. 

Knowledge Booster: 

• Middleware is not responsible for managing hardware 

resources: It focuses on software communication rather 

than hardware management. 

• Direct access to system memory is handled by low-level 

processes, not middleware. 

• Data storage is not the primary function of middleware; it 

is mainly concerned with facilitating communication. 

• User interface design is not part of middleware's 

functionality; this is handled by front-end software 

development. 

 

S51. Ans.(d) 
Sol. The technology used for Bitcoin transactions is Blockchain. 

Blockchain is a decentralized and distributed ledger technology 

that records all transactions across a network of computers. It 

ensures that Bitcoin transactions are secure, transparent, and 

tamper-proof. Every transaction is verified by nodes in the 

network and added to a block, which is then added to the 

existing chain of blocks, creating an immutable record of 

transactions. 

Important Key Points: 

1. Blockchain is the backbone technology for Bitcoin and 

most other cryptocurrencies, ensuring secure, decentralized 

transaction processing. 

2. The transparency and immutability of blockchain prevent 

double-spending and unauthorized alterations to the 

transaction record. 

Knowledge Booster: 

• Machine Learning: This is a subset of AI focused on data-

driven predictions but is not used for Bitcoin transaction 

processing. 

• Artificial Intelligence (AI): While AI is revolutionizing 

many industries, it is not directly involved in processing 

Bitcoin transactions. 

• Data Mining: In cryptocurrency, "mining" refers to the 

process of verifying and adding transactions to the 

blockchain, but data mining (pattern discovery) is not the 

same. 

• Cloud Computing: Although used for storage and 

processing in various applications, cloud computing does 

not handle Bitcoin transaction verification. 

 

S52. Ans.(b) 
Sol.  A Trojan (or Trojan Horse) is a type of malicious software 

that appears to be legitimate or harmless but can actually cause 

harm to your computer or network. Trojans are often disguised 

as useful software or files, tricking users into installing them. 

Once installed, they can open a backdoor for hackers to gain 

access to the system, steal information, or cause other damage. 

Important Key Points: 

1. Trojan malware does not replicate itself like viruses but 

can cause significant damage by allowing unauthorized 

access. 

2. Trojans are commonly used to steal data, gain control of 

systems, or install additional malware. 

Knowledge Booster: 

• Virus: A virus replicates itself and spreads to other 

programs or systems, causing damage by corrupting or 

deleting files. 

• Worm: A worm is a type of malware that spreads through 

networks, often causing disruption by consuming 

bandwidth, but it doesn’t disguise itself as legitimate 

software. 

• Spyware: Spyware secretly monitors user activity, but it 

usually doesn’t disguise itself as legitimate software like 

Trojans do. 

• Ransomware: Ransomware locks the user out of their 

system or files until a ransom is paid, but it’s not typically 

disguised as legitimate software. 

 

S53. Ans.(c) 
Sol. Wireless USB is used in Personal Area Networks (PAN). 

A PAN is a network that connects devices within a very short 

range, typically around a single person. Wireless USB allows for 

the wireless transfer of data between devices like computers, 

printers, cameras, and other peripherals, making it ideal for use 

in a PAN environment. 

Important Key Points: 

1. Wireless USB technology allows for short-range, high-

speed wireless communication, ideal for personal devices in 

close proximity. 

2. PAN networks are designed to support personal devices 

like smartphones, laptops, and wearable technology over 

short distances. 
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Knowledge Booster: 

• LAN: Used for connecting devices within a limited area, 

such as a home or office, but Wireless USB is typically 

focused on individual device connectivity rather than LANs. 

• WAN: A wide-area network connects devices over large 

geographical areas, which is not the focus of Wireless USB 

technology. 

• MAN: MANs cover larger urban areas, but Wireless USB is 

not designed for such extensive networking. 

• SAN: Storage Area Networks are specialized networks for 

data storage, unrelated to Wireless USB's personal device 

connectivity. 

 

S54. Ans.(c) 

Sol. CodeRed is not an antivirus software. It is a computer 

worm that targeted web servers running Microsoft IIS (Internet 

Information Services) in 2001. CodeRed exploited 

vulnerabilities in the web server software to spread itself across 

the internet, causing significant damage. Unlike antivirus 

programs, which are designed to protect systems from such 

malicious software, CodeRed was an attack that infected 

systems. 

Important Key Points: 

1. CodeRed is a notorious worm that exploited a vulnerability 

in Microsoft IIS servers in 2001. 

2. It is not designed to protect computers, but rather to cause 

harm by replicating itself and spreading across networks. 

Knowledge Booster: 

• McAfee: One of the leading antivirus software providers, 

offering protection against viruses, malware, and other 

threats. 

• Norton: A widely used antivirus and cybersecurity tool for 

protecting devices from malware. 

• Kaspersky: Known for providing comprehensive antivirus 

protection against malware and cyber threats. 

• AVG: Another popular antivirus software that provides 

protection against various forms of malware. 

 

S55. Ans.(a) 

Sol. The Arithmetic Logic Unit (ALU) is the part of the CPU 

responsible for performing arithmetic (addition, subtraction, 

multiplication, division) and logical (AND, OR, NOT, XOR) 

operations. It is a crucial component of the processor that 

handles all mathematical calculations and logical decision-

making tasks during program execution. 

Important Key Points: 

1. The ALU performs all arithmetic calculations such as 

addition and subtraction, as well as logical comparisons. 

2. It works closely with the control unit and memory to 

process data and execute instructions. 

Knowledge Booster: 

• Control Unit: Directs the operations of the CPU, but does 

not perform arithmetic or logical operations. 

• Memory Unit: Stores data and instructions temporarily, but 

does not perform calculations. 

• Cache: A small, high-speed memory that stores frequently 

accessed data but does not execute arithmetic or logic 

operations. 

• Register: Temporarily holds data and instructions for the 

CPU, but the actual operations are performed by the ALU. 

 

S56. Ans.(c) 
Sol. In MS Excel, the ampersand symbol (&) is used to 

combine the contents of two or more cells into a single cell. This 

process is called concatenation. For example, if cell A1 contains 

"Hello" and cell B1 contains "World," the formula =A1 & " " & B1 

will combine them into "Hello World." 

Important Key Points: 

1. The ampersand (&) symbol is a quick way to combine or 

concatenate text or numbers from different cells in Excel. 

2. You can also use the CONCAT function for the same 

purpose, i.e., =CONCAT(A1, B1). 

Knowledge Booster: 

• %: Used to format numbers as percentages. 

• +: Used for arithmetic addition, not for combining cell 

content. 

• =: Used to start a formula in Excel. 

• *: Used for multiplication, not concatenation. 

 

S57. Ans.(c) 
Sol. Spyware is a type of malware designed to secretly collect 

information about a user without their knowledge. It often 

tracks users' activities, including browsing habits, keystrokes, 

and personal information like passwords and credit card details. 

Spyware can be installed through malicious downloads, email 

attachments, or even legitimate-looking software. 

Important Key Points: 

1. Spyware operates silently in the background, collecting 

personal information and transmitting it to the attacker 

without the user's consent. 

2. It is often used for identity theft, financial fraud, or to serve 

targeted advertisements. 

Knowledge Booster: 

• Virus: A type of malware that replicates itself and spreads 

to other files, but its primary goal is not information 

collection. 

• Worm: Malware that spreads across networks, usually to 

cause disruption rather than to collect user information. 

• Ransomware: A type of malware that locks users out of 

their data or system until a ransom is paid, not for secret 

data collection. 
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• Trojan: Disguised as legitimate software, a Trojan grants 

unauthorized access but doesn’t focus solely on data 

collection like spyware. 

 

S58. Ans.(b) 
Sol. Cache memory has the shortest access time compared to all 

other memory units, except for CPU registers. Cache is located 

close to the CPU and stores frequently accessed data, allowing 

for quicker retrieval and improved processing speeds. This 

significantly enhances the performance of the system by 

minimizing the time it takes to access data from slower memory 

units, such as RAM or secondary storage. 

Important Key Points: 

1. Cache memory is faster than RAM and other storage units, 

as it stores frequently accessed data for the CPU. 

2. Cache helps in reducing latency and improving the overall 

performance of the system. 

3. The order of access time for different types of memory, 

from fastest to slowest, is: 

o CPU Registers (fastest) 

o Cache memory 

o Main memory (RAM) 

o Secondary memory (Hard disk, SSD, etc.) 

Knowledge Booster: 

• RAM: Slower than cache but faster than secondary storage 

devices. 

• Hard Disk: Much slower compared to cache and RAM, used 

for long-term storage. 

• SSD: Faster than traditional hard disks but slower than 

cache memory. 

• CD-ROM: Optical storage media, significantly slower in 

access time compared to all other memory types listed. 

 

S59. Ans.(a) 
Sol. The full form of ATX is Advanced Technology eXtended. 

ATX is a motherboard and power supply configuration standard 

that was developed by Intel in 1995. It defines the physical 

dimensions, mounting points, and connector interfaces for 

motherboards, ensuring compatibility between various 

computer components. 

Important Key Points: 

1. ATX is a widely adopted standard for motherboards and 

power supplies in desktop computers. 

2. It specifies the dimensions and layout of components to 

ensure that motherboards fit into cases and work with 

standard power supplies. 

3. Advanced Technology eXtended (ATX) is the successor to 

the earlier Baby AT form factor. 

4. ATX motherboards are larger than microATX and mini-ITX 

boards, offering more expansion slots. 

5. ATX is still the most common form factor for desktop 

computers. 

 

S60. Ans.(b) 

Sol. Ransomware is a type of Encryption Malware. It encrypts 

a user’s files or locks their system, demanding a ransom to 

unlock or decrypt the data. This form of malware poses a 

serious threat by making data inaccessible until the user pays 

the ransom, typically in cryptocurrency, to receive the 

decryption key from the attacker. 

Important Key Points: 

1. Ransomware uses encryption to lock files or systems, and 

users must pay a ransom to regain access. 

2. It is one of the most dangerous forms of malware due to its 

ability to render data completely unusable without the 

decryption key. 

Knowledge Booster: 

• Application Software: Software designed for user tasks, 

not malware. 

• Decryption Malware: This option is incorrect because 

ransomware encrypts data; it does not decrypt it. 

• Antivirus Software: Antivirus software detects and 

removes malware, but ransomware is a type of malware, 

not antivirus. 

• Protection Malware: This option is misleading; malware 

does not offer protection—it causes harm. 

 

S61. Ans.(a) 

Sol. The Control Unit (CU) in a CPU is responsible for 

interpreting instructions. It fetches, decodes, and directs the 

execution of instructions stored in memory, ensuring the CPU 

functions as required. It coordinates the activities of the CPU 

and other components, ensuring smooth and sequential task 

execution. 

Important Key Points: 

1. The Control Unit interprets and controls the flow of 

instructions in a computer system. 

2. It does not perform operations but directs other parts of the 

CPU to do so. 
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Knowledge Booster: 

• Printing data: This is handled by the printer driver or 

spooler, not the Control Unit. 

• Providing internet access: Managed by network adapters 

and protocols, not the CU. 

• Adjusting screen resolution:  Controlled by the graphics 

card and monitor settings, not the CU. 

• Compressing files: This is handled by software programs, 

not the Control Unit. 

 

S62. Ans.(c) 
Sol. The most prominent and widely used IP protocols today are 

IPv4 & IPv6. IPv4 has been the primary protocol used for 

internet traffic for decades. However, due to the limited address 

space of IPv4, IPv6 was introduced, offering a much larger 

address pool and several technological improvements to handle 

modern internet demands. 

Important Key Points: 

1. IPv4 remains widely used, while IPv6 adoption is 

increasing to accommodate the growing number of devices 

requiring IP addresses. 

2. IPv6 includes improvements in security and routing 

efficiency over IPv4. 

Knowledge Booster: 

• IPv2 & IPv3: Early versions of the Internet Protocol, not 

widely implemented. 

• IPv5 & IPv7: IPv5 was an experimental protocol and never 

fully deployed, while IPv7 is a non-existent protocol. 

• IPv1 & IPv7: These versions are not recognized or used in 

modern networking. 

• IPv2 & IPv5: These versions are either early or 

experimental protocols that were not adopted. 

 

S63. Ans.(a) 
Sol. A Rootkit is a type of malicious software designed to 

provide unauthorized access to a computer system while 

concealing its presence. Rootkits hide their processes, files, 

and data, making it difficult for users and antivirus programs to 

detect their malicious activities. Once installed, a rootkit allows 

attackers to control the system, steal data, and perform other 

harmful actions without being detected. 

Important Key Points: 

1. Rootkits are typically used by attackers to maintain 

persistent access to a compromised system while hiding 

their activities. 

2. Rootkits are often installed through phishing attacks, 

software vulnerabilities, or by exploiting system 

weaknesses. 

Knowledge Booster: 

• Security Software: Unlike rootkits, legitimate security 

software is designed to protect against malicious activities, 

not hide them. 

• System Performance Tools: These tools are used to 

improve the performance of a system, but they do not 

conceal activities. 

• System Recovery Applications: Used to restore systems 

after failure or corruption, these tools are legitimate and not 

malicious like rootkits. 

• Antivirus Software: Antivirus programs are designed to 

detect and remove malware, including rootkits, not to hide 

them. 

 

S64. Ans.(d) 
Sol. A stylus operates using capacitive touch technology, 

which allows it to interact with touchscreen devices. Capacitive 

touchscreens detect the conductive properties of the stylus, 

enabling precise input for activities like writing, drawing, or 

navigating. This technology mimics the electrical conductivity of 

a human finger. 

Important Key Points: 

1. Capacitive Touch technology is widely used in 

smartphones, tablets, and touchscreen laptops for accurate 

input with a stylus. 

2. The stylus provides more precise control than a finger, 

making it ideal for tasks requiring accuracy. 

Knowledge Booster: 

• Laser: Primarily used in laser pointers for presentations, 

not in stylus technology. 

• Pointer: Refers to devices for directing attention during 

presentations but not for touch input. 

• UV Rays: Not used in styluses; UV rays are related to light 

and electromagnetic radiation, not touchscreens. 

• Magnetic Field: Some specialized devices use magnetic 

technology, but common styluses rely on capacitive touch. 

 

S65. Ans.(c) 
Sol. An interrupt allows the CPU to temporarily halt its 

current task to manage urgent tasks, such as handling 

input/output operations or responding to critical events. This 

enables the system to quickly address time-sensitive operations. 

Once the interrupt is managed, the CPU resumes its previous 

task. 

Important Key Points: 

1. Interrupts ensure that high-priority tasks, like 

input/output requests, are addressed immediately. 

2. They allow the CPU to efficiently multitask, switching 

between processes as needed. 

Knowledge Booster: 

• Stop CPU tasks: This does not describe an interrupt; the 

CPU pauses tasks temporarily but resumes them after 

handling the interrupt. 

• Allocate memory: Memory management is handled by the 

operating system, not interrupts. 
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• Save data: Data storage operations are unrelated to 

interrupts, which manage real-time tasks. 

• Protect against malware: Interrupts do not provide 

security; antivirus programs are responsible for malware 

protection. 

 

S66. Ans.(b) 
Sol. Extending the size of RAM is one of the most effective 

ways to increase the speed of a computer. More RAM allows the 

system to handle more tasks simultaneously, reducing the need 

to rely on slower secondary storage, such as the hard disk. RAM 

upgrades improve multitasking, speed up applications, and 

enhance overall system performance. 

Important Key Points: 

1. RAM (Random Access Memory) allows the computer to 

store and access data quickly while performing multiple 

tasks. 

2. Increasing RAM reduces the frequency of data being 

swapped to the hard drive, which is slower. 

Knowledge Booster: 

• Increasing storage on the hard disk: While increasing 

storage provides more space, it doesn’t directly improve 

system speed. 

• Adding more USB ports: This adds more connectivity 

options but doesn’t impact computer speed. 

• Installing antivirus software: Protects the system but 

does not enhance its speed. 

• Replacing the power supply: Ensures stable power but 

does not affect system performance or speed. 

 

S67. Ans.(b) 
Sol. A Graphic Tablet is used to convert a handwritten 

signature into an image. This device allows users to write or 

draw on its surface using a stylus, and the input is captured 

digitally, making it ideal for creating digital signatures or 

artwork. 

Important Key Points: 

1. A Graphic Tablet captures handwriting or drawings and 

converts them into digital form. 

2. It is commonly used in digital design, signature capture, and 

other applications that require precise hand input. 

Knowledge Booster: 

• Barcode Scanner: Scans barcodes for information retrieval, 

unrelated to capturing handwritten signatures. 

• Joystick: Primarily used for gaming, not for inputting 

handwriting. 

• Optical Mouse: Used for pointing and clicking but cannot 

capture handwritten input. 

• Trackball: Another pointing device, similar to a mouse, 

with no capability to capture handwriting. 
 

S68. Ans.(c) 
Sol. SMTP (Simple Mail Transfer Protocol) is primarily used 

for email transmission. It is responsible for sending emails 

from one server to another over the internet. SMTP works by 

transferring mail from the sender's email client to the 

recipient's email server, ensuring that messages are delivered to 

the appropriate destination. 

Important Key Points: 

1. SMTP is the standard protocol used for sending emails 

across the internet. 

2. It is typically used in conjunction with other protocols like 

POP3 or IMAP, which are responsible for receiving emails. 

Knowledge Booster: 

• File Transfer: This is typically handled by FTP (File 

Transfer Protocol), not SMTP. 

• Web Browsing: HTTP/HTTPS are used for browsing the 

web, not SMTP. 

• Data Encryption: Encryption is handled by protocols like 

SSL/TLS, not SMTP directly. 

• Remote Access: This is managed by protocols such as SSH 

or RDP, unrelated to SMTP. 

 

S69. Ans.(c) 
Sol. UNIX is a system software that functions as an operating 

system. It manages hardware resources, provides a platform for 

applications to run, and facilitates user interaction with the 

system. Operating systems like UNIX control the core functions 

of a computer, such as file management, process management, 

and memory management. 

Important Key Points: 

1. System Software includes operating systems like UNIX, 

which are essential for managing hardware and software 

resources. 

2. UNIX is widely used in servers, workstations, and other 

systems requiring a stable, multiuser operating 

environment. 

Knowledge Booster: 

• Microsoft Word: A word processing application, 

categorized as application software. 

• Photoshop: A graphic design tool, also application 

software. 

• VLC Media Player: A media player used for playing audio 

and video files, part of application software. 

• Chrome: A web browser, which is also considered 

application software. 

 

S70. Ans.(c) 
Sol. The SATA (Serial Advanced Technology Attachment) 

port is the most commonly used port to connect an internal 

hard disk drive (HDD) to a motherboard. SATA is a widely 

adopted interface that allows for fast data transfer between the 

motherboard and storage devices, such as HDDs and SSDs. 
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Important Key Points: 

1. SATA is the standard interface for connecting internal 

storage devices to the motherboard, known for high data 

transfer speeds. 

2. It replaced older technologies like IDE (Integrated Drive 

Electronics) due to its improved performance and ease of 

use. 

Knowledge Booster: 

• USB: Commonly used for external storage devices, but not 

for internal HDD connections. 

• HDMI: Used for transmitting video and audio signals, not 

for connecting storage devices. 

• Ethernet: Used for networking, unrelated to HDD 

connections. 

• VGA: A video graphics port for connecting monitors, not for 

storage devices. 

 

S71. Ans.(b) 
Sol. A Worm is a type of malware that can spread across 

networks without needing to attach itself to a host file or 

program. Worms propagate by exploiting vulnerabilities in 

systems and can cause widespread damage by consuming 

bandwidth, disrupting network services, and sometimes 

corrupting data. 

Important Key Points: 

1. Worms spread autonomously over networks and do not 

require user action or attachment to files, unlike viruses. 

2. They often exploit network vulnerabilities, causing system 

slowdowns or network congestion. 

Knowledge Booster: 

• Virus: A virus typically attaches itself to a host file and 

requires user action to spread. 

• Trojan: A Trojan disguises itself as legitimate software but 

does not spread like a worm. 

• Spyware: Used to monitor user activity but does not spread 

autonomously. 

• Adware: Displays unwanted ads but does not replicate or 

spread across networks like worms. 

 

S72. Ans.(a) 
Sol. A phishing attack is a cyber-attack where attackers send 

fraudulent emails, pretending to be legitimate entities, to 

trick individuals into revealing sensitive information like 

passwords, credit card numbers, or other personal data. 

These emails often direct users to fake websites that closely 

mimic genuine ones, where they are prompted to enter their 

confidential information. 

Important Key Points: 

1. Phishing attacks are one of the most common types of 

social engineering attacks used to steal personal and 

financial information. 

2. They often use emails or messages that appear to be from 

trusted sources, tricking users into clicking malicious links 

or entering personal information. 

Knowledge Booster: 

• Blocking websites: Phishing attacks don't involve blocking 

websites; they use fake websites to steal data. 

• Encrypting data: Encryption is a security method, not 

related to phishing. 

• Malware: Phishing attacks don’t directly involve infecting 

systems with malware, though they can lead to it. 

• Scanning networks: Network scanning for vulnerabilities 

is a different kind of security assessment and not related to 

phishing. 

 

S73. Ans.(a) 
Sol. Parents can monitor the content their children are 

accessing online by reviewing Activity Logs. These logs 

provide detailed records of websites visited, applications used, 

and online activities. Many internet routers, parental control 

software, and devices include features that allow parents to 

track and control what content their children can access. 

Important Key Points: 

1. Activity Logs provide a record of a child's browsing history, 

which helps parents monitor online behavior. 

2. Parental control software often includes activity logs to 

offer additional tools for monitoring and filtering 

inappropriate content. 

Knowledge Booster: 

• Antivirus Software: Protects devices from malware but 

does not provide tools for monitoring children's online 

activities. 

• Disabling Internet Access: While this prevents access 

entirely, it doesn't allow monitoring or filtering content. 

• Installing External Storage: External storage does not 

offer any features for monitoring internet activity. 

• Using Word Processors: Word processing software is 

unrelated to monitoring internet activities. 

 

S74. Ans.(b) 
Sol. The main difference between IMAP (Internet Message 

Access Protocol) and POP3 (Post Office Protocol 3) is that 

IMAP allows email synchronization across multiple devices, 

meaning changes (such as reading, deleting, or moving an 

email) are reflected on all devices accessing the email account. 

POP3, however, downloads emails to a single device and 

typically removes them from the server, meaning emails are 

only available on the device where they were downloaded. 

Important Key Points: 

1. IMAP is ideal for accessing emails from multiple devices 

like phones, laptops, or desktops, ensuring that all changes 

are synced across these devices. 

https://www.adda247.com/activity/DAILY_QUIZZES
https://www.adda247.com/activity/PYP
https://www.adda247.com/activity/MAGAZINES


IBPS RRB Computer Capsule 2025 (PO and Clerk) 

 

 

25 
 

                                    

2. POP3 is better for users who want to store emails on a 

single device (like Mozilla Thunderbird or another email 

client), as it downloads emails locally and often removes 

them from the server, making the emails available only on 

that device. 

Knowledge Booster: 

• IMAP stores emails on the server, allowing users to access 

and sync their emails across multiple devices. 

• POP3 downloads emails to a single device and typically 

removes them from the server after download, limiting 

access to one device. 

 

S75. Ans.(b) 

Sol.  Whitelisting in parental lock settings refers to the process 

of allowing only approved websites or content to be 

accessed. In this system, parents or administrators create a list 

of safe or appropriate websites, and the user is restricted to 

accessing only those websites. Any content not on the whitelist 

is blocked. 

Important Key Points: 

1. Whitelisting ensures that only pre-approved websites or 

content are accessible, offering a high level of control over 

what children can view. 

2. It is an effective way for parents to filter and control the 

content their children can access online, especially in 

restrictive environments. 

Knowledge Booster: 

• Blocking specific websites: This is called blacklisting, 

where certain sites are blocked, but all others are 

accessible. 

• Monitoring all online activities: Involves tracking web 

usage but does not prevent access to certain content like 

whitelisting. 

• Disabling internet access: Prevents all online access, not 

just content filtering. 

• Tracking time spent online: Helps monitor usage time but 

does not control content access. 

 

S76. Ans.(c) 

Sol. An SSD (Solid State Drive) is a type of non-volatile 

memory, meaning it retains data even when the computer is 

powered off. Non-volatile memory, such as SSDs, is used for 

long-term data storage. Unlike volatile memory (e.g., RAM), non-

volatile memory doesn't lose data when power is removed. 

Important Key Points: 

1. Non-volatile memory retains data without power, making 

it ideal for long-term storage solutions like SSDs and hard 

drives. 

2. Volatile memory, such as RAM and cache, loses all stored 

data when the power is turned off. 

Knowledge Booster: 

• RAM: A volatile memory used for temporary storage while 

the computer is running. 

• Cache: Another form of volatile memory used to store 

frequently accessed data for quick access. 

• Registers: Small, fast storage locations inside the CPU, also 

volatile. 

• CPU: Central Processing Unit, not a type of memory. 

 

S77. Ans.(b) 
Sol. Laser technology is used in optical disks (such as CDs, 

DVDs, and Blu-ray discs) to store and retrieve data. Data is 

written on the disk by burning tiny pits into the surface of the 

disk using a laser. The laser is also used to read the data by 

detecting the reflections from these pits. 

Important Key Points: 

1. Optical disks store data by using a laser to burn pits into 

the surface, representing binary data (0s and 1s). 

2. When reading data, the laser shines onto the disk, and the 

reflected light is interpreted to retrieve the stored 

information. 

Knowledge Booster: 

• Magnetic Field: Used in magnetic storage devices such as 

hard drives and magnetic tapes, not in optical disks. 

• Electrical Charge: This is used in flash storage devices, not 

in optical disks. 

• Capacitive Touch: Related to touchscreens, not optical 

storage. 

• UV Rays: Not used in the technology for optical disk 

storage. 

 

S78. Ans.(c) 
Sol. A macro in MS Excel is a feature that allows users to 

automate repetitive tasks by recording a sequence of actions 

and replaying them whenever needed. Macros are particularly 

useful for performing repetitive tasks such as formatting, 

calculations, or data entry, and they can be triggered with a 

single command or keyboard shortcut. 

Important Key Points: 

1. Macros help save time by automating a series of steps in 

Excel, reducing the need to manually repeat the same 

actions. 

2. Users can record macros and assign them to a button or a 

keyboard shortcut for easy execution. 

Knowledge Booster: 

• Built-in formula: Excel uses functions like SUM() or 

AVERAGE(), but macros go beyond these by recording 

complex sequences of actions. 

• Chart creation: Charts in Excel are created using a different 

process, but a macro could be used to automate the chart 

creation. 
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• Formatting tool: Macros can be used to automate 

formatting, but they are not specifically a formatting tool. 

• Sorting data: Sorting is done using Excel’s built-in tools, 

though macros can automate this process. 

 

S79. Ans.(b) 

Sol. Virtual Reality (VR), Augmented Reality (AR), and 

Artificial Intelligence (AI) enhance human understanding by 

creating immersive environments and intelligent systems 

that help people visualize and process complex information. 

VR provides users with a fully immersive experience, while AR 

overlays digital information onto the real world. AI helps in 

making sense of large datasets, providing insights, predictions, 

and recommendations that assist in decision-making. 

Important Key Points: 

1. Virtual Reality (VR) offers immersive, simulated 

environments that can enhance learning and understanding 

by placing users in lifelike scenarios. 

2. Augmented Reality (AR) enhances real-world 

environments by overlaying digital information, allowing 

users to interact with both real and virtual elements. 

3. Artificial Intelligence (AI) processes data, generates 

insights, and provides intelligent systems that help humans 

understand complex concepts more effectively. 

Knowledge Booster: 

• AI is extensively used in educational tools, simulations, and 

decision-making systems, providing insights that help in 

various fields like medicine, engineering, and business. 

• VR and AR are applied in sectors like education, healthcare, 

and entertainment to improve understanding through 

immersive and interactive learning experiences. 

 

S80. Ans.(b) 
Sol. In Quantum Computing, the basic unit of information is a 

qubit, which differs from traditional bits used in classical 

computing. Qubits can exist in multiple states simultaneously 

due to quantum superposition, enabling quantum computers to 

process information much more efficiently than classical 

computers, which use bits that can only be in one state (0 or 1) 

at a time. 

Important Key Points: 

1. Qubits can represent both 0 and 1 simultaneously due to 

quantum superposition, allowing for parallel processing.  

2. Quantum Computing is especially useful for solving 

complex problems like cryptography, material simulations, 

and optimization tasks that are challenging for classical 

computers. 

Knowledge Booster: 

• Classical Bits: Used in traditional computers, where a bit 

can be either 0 or 1, unlike qubits which can represent 

multiple states. 

• Registers: Temporary storage in classical CPUs, not used in 

quantum computing. 

• Cache: A small, fast memory in classical computing, 

unrelated to quantum processing. 

• Transistors: The building blocks of classical computer 

processors, not relevant in quantum computing. 
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Memory Based Questions IBPS RRB PO & Clerk 2023 
 

Q1. What is the label of the first row in MS Excel? 

(a) A 

(b) 0 

(c) 1 

(d) 01 

(e) None of the above 

 

Q2. In MS Word, how are the title or page number defined? 

(a) Header and Footer 

(b) Margin and Border 

(c) Paragraph and Alignment 

(d) Font and Style 

(e) Table and Chart 

 

Q3. Arrange the following page sizes in ascending order: A4, 

A5, Legal. 

(a) Legal<A4<A5 

(b) A4<A5<Legal 

(c) A5< Legal<A4 

(d) A5<A4<Legal 

(e) Legal<A5<A4  

 

Q4. What is the shortcut key for inserting a page break in 

MS Word? 

(a) Ctrl + Enter 

(b) Ctrl + Shift + P 

(c) Ctrl + B 

(d) Ctrl + P 

(e) None of the above 

 

Q5. What is the function key for Help in most software 

applications? 

(a) F1 

(b) F2 

(c) F5 

(d) F8 

(e) None of the above 

 

Q6. What is the base of the octal number system? 

(a) (….)2 

(b) (….)8 

(c) (….)16 

(d) (….)10 

(e) None of the above 

 

Q7. Which of the following is an impact printer? 

(a) Inkjet Printer 

(b) Laser Printer 

(c) Dot Matrix Printer 

(d) Thermal Printer 

(e) 3D Printer 

 

Q8. Disk Defragmenter is an example of which type of 
software? 

(a) System Software 

(b) Application Software 
(c) Utility Software 

(d) Database Software 

(e) Programming Software 

 
Q9. What is the IP address range for Class A? 

(a) 10-128 

(b) 0-127 
(c) 192-223 

(d) 128-225 

(e) 128-191 

 
Q10. Which symbol is used for absolute cell reference in MS 

Excel? 

(a) # (Hash) 
(b) @ (At) 

(c) $ (Dollar) 

(d) & (Ampersand) 

(e) % (Percent) 
 

Q11. Which feature in MS Excel is used to display the cell 

contents on multiple lines, rather than one long line? 
(a) Merge Cells 

(b) Text Orientation 

(c) Word Wrap 

(d) Format Painter 
(e) Conditional Formatting 

 

Q12. What is the binary equivalent of the decimal number 
10? 

(a) 1010 

(b) 1001 

(c) 1100 
(d) 1110 

(e) 1000 
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Q13. In Excel, formulas always start with which symbol? 

(a) # 

(b) & 

(c) = 

(d) @ 

(e) None of the above 

 

Q14. What is the shortcut key for center alignment in MS 

Word? 

(a) Ctrl + L 

(b) Ctrl + E 

(c) Ctrl + R 

(d) Ctrl + J 

(e) Ctrl + C 

 

Q15. Which of the following statements about ChatGPT is 

true? 

1. ChatGPT is a type of artificial intelligence. 

2. ChatGPT can understand and generate human-like text. 

3. ChatGPT is developed by OpenAI. 

4. ChatGPT can perform language translation. 

5. ChatGPT can be used for programming assistance.  

(a) Only statements 1 and 3 are true. 

(b) Only statements 2 and 4 are true. 

(c) Only statements 1, 2, and 3 are true. 

(d) All statements 1, 2, 3, 4, and 5 are true. 

(e) Only statements 3 and 5 are true. 

 

Q16. How many alphabets are used in the hexadecimal 

number system? 

(a) 3 

(b) 6 

(c) 16 

(d) 9 

(e) None of the above 

 

Q17. In which generation of computers were real-time 

processing and time-sharing systems introduced? 

(a) First Generation 

(b) Second Generation 

(c) Third Generation 

(d) Fourth Generation 

(e) Fifth Generation 

 

Q18. What is the function of the Ctrl + F6 shortcut key in MS 

Excel? 

(a) Closes the current workbook 

(b) Opens a new workbook 

(c) Switches to the next workbook window when more than one 

workbook window is open 

(d) Saves the current workbook 

(e) Minimizes the current window 

 

Q19. In MS Word, under which tab can you find the option to 

insert a citation? 

(a) Home 

(b) Insert 

(c) Design 

(d) References 

(e) Layout 

 

Q20. How many bits are used in an IPv4 address? 

((a) 8 bits 

(b) 16 bits 

(c) 32 bits 

(d) 64 bits 

(e) 128 bits 

 

Q21. What is the use of a watermark in a document? 

(a) Prevent from copying 

(b) Enhance visual appearance 

(c) Add additional comments 

(d) Improve print quality 

(e) Save paper 

 

Q22. Which of the following is not programming software? 

(a) Eclipse 

(b) Visual Studio 

(c) Solaris 

(d) NetBeans 

(e) PyCharm 

 

Q23. The software substituted for hardware and stored in 

ROM is called: 

(a) Synchronous Software 

(b) Package Software 

(c) Firmware 

(d) BIOS 

(e) Middleware 

 

Q24. What is the correct formula to sum cells A1 and A2 in 

Excel? 

(a) =SUM(A1 OR A2) 

(b) =A1 + A2 

(c) =SUM(A1, A2) 

(d) =SUM(A1:A2) 

(e) =ADD(A1+A2) 

 

Q25. What is the shortcut key to run macros in MS Excel? 

(a) Alt + F4 

(b) Alt + F5 

(c) Alt + F8 

(d) Alt + F7 

(e) Alt + F6 
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Q26. Which of the following is not a type of database? 

(a) Hierarchical  

(b) Network 

(c) Relational 

(d) Private  

(e) Distributed 

 

Q27. What is the main function of the Control Unit (CU) in a 

computer? 

(a) Executing instructions 

(b) Storing data 

(c) Monitoring the CPU temperature 

(d) Controlling the sequence of operations 

(e) Managing input/output device 

 

Q28. What does the "I'm Feeling Lucky" button on the 

Google search page do? 

(a) Displays the search results page 

(b) Saves the search for later 

(c) Sends you to the first result on the page 

(d) Shows trending searches 

(e) Filters out ads from the search results above 

 

Q29. Which of the following are basic logic gates?  

(a) AND, OR, NOT 

(b) NAND, NOR, XOR 

(c) AND, NOR, XOR 

(d) OR, NAND, NOR 

(e) XOR, XNOR, NOT 

 

Q30. Which company originally developed SSL (Secure 

Sockets Layer)? 

(a) Microsoft 

(b) IBM 

(c) Netscape 

(d) Google 

(e) Sun Microsystem 

 

Q31. What type of language is Pascal? 

(a) Assembly Language 

(b) High-level Programming Language 

(c) Markup Language 

(d) Scripting Language 

(e) Machine Language 

 

Q32. The primary type of internal storage in smartphones 

is………………..  

(a) CD 

(b) SRAM 

(c) ROM 

(d) Flash Memory 

(e) Hard Disk 

 

Q33. GIF and PNG are which type of format? 

(a) Image 

(b) Video 

(c) Audio 

(d) Text 

(e) Document  

 
Q34. Which of the following uses a 48-bit addressing 

scheme? 

(a) PATA 

(b) SATA 

(c) CMOS 

(d) NIC 

(e) IP Address 

 

Q35. Which of the following are universal gates? 

(a) AND, OR 

(b) NOR, NAND 

(c) XOR, XNOR 
(d) NOT, OR 

(e) AND, NOT 

 

Q36. What is the use of the 'Merge and Center' feature in MS 

Excel? 

(a) It adds numeric values from two cells 

(b) It joins two words from two cells 

(c) It combines two cells into one cell 

(d) It calculates the total of a range of cells 

(e) It formats text as a heading 

 

Q37. In which year did the first computer virus appear? 

(a) 1965 
(b) 1971 

(c) 1983 

(d) 1986 

(e) 1990 

 

Q38. __________ is a form of social engineering and a scam 

where attackers deceive people into revealing sensitive 

information or installing malware such as viruses, worms, 

adware, or ransomware. 

(a) Phishing 

(b) Spamming 

(c) Hacking 
(d) Spoofing 

(e) Sniffing  

 

Q39. Which of the following mode makes it easy for the 

computer user to quickly resume the work? 

(a) Standby mode 

(b) Power down 

(c) Hibernation 

(d) Shutdown  

(e) None of the above 
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Q40. Direct Action Virus is also known as: 

(a) Resident Virus 

(b) Non-resident Virus 

(c) Boot Sector Virus 

(d) Polymorphic Virus 

(e) Macro Virus 

 

Q41. What is the shortcut key for removing character 

formatting in MS Word 2013? 

(a) Ctrl + Shift + F 

(b) Ctrl + Alt + F 

(c) Ctrl + Spacebar 

(d) Ctrl + Shift + C 

(e) None of the above 

 

Q42. What is the minimum number of rows and columns in 

an MS Word document table? 

(a) 0 Rows, 0 Columns 

(b) 1 Row, 2 Columns 

(c) 2 Rows, 1 Column 

(d) 1 Row, 1 Column  

(e) None of the above 

 

Q43. The extensions .doc and .docx are associated with 

which software? 

(a) MS Excel 

(b) MS PowerPoint 

(c) MS Word 

(d) MS Access 

(e) MS Publisher 

 

Q44. What device converts digital signals to analog signals? 

(a) Router 

(b) Switch 

(c) Modem 

(d) Hub 

(e) Repeater  

 

Q45. What is the capacity of CD-ROM? 

(a) 750 KB 

(b) 750 GB 

(c) 750 Byte 

(d) 750 MB 

(e) 750 TB 

 

Q46. Which of the following is a database software? 

(a) Microsoft Word 

(b) Adobe Photoshop 

(c) Microsoft Access 

(d) VLC Media Player 

(e) Notepad  

 

Q47. Which of the following is a function in Excel? 
(a) SUM 
(b) BOLD 
(c) SAVE 
(d) PRINT 
(e) NEW  
 
Q48. What is the bottom section of a document called? 
(a) Header 
(b) Footer 
(c) Margin 
(d) Border 
(e) Title  
 
Q49. A computer cannot boot if which of the following is not 
present. 
(a) Hard Drive 
(b) Power Supply 
(c) Operating System 
(d) Monitor 
(e) Keyboard 
 
Q50. Which of the following is used to work online in MS 
Office? 
(a) MS Word 
(b) MS Excel 
(c) MS PowerPoint 
(d) Office 365  
(e) None of the above 
 
Q51. What is the shortcut key for bolding text in MS Word? 
(a) Ctrl + I 
(b) Ctrl + U 
(c) Ctrl + B 
(d) Ctrl + A  
(e) None of the above 
 
Q52. Which of the following is non-volatile memory? 
(a) RAM 
(b) Cache Memory 
(c) Hard Drive 
(d) ROM  
(e) Register 
 
Q53. Which of the following is not a part of a laser printer? 
(a) Head & Ribbon 
(b) Toner Cartridge 
(c) Drum Unit 
(d) Fuser 
(e) Laser 
 
Q54. Arrange the following in descending order of size: KB, 
GB, TB, MB. 
(a) KB, MB, GB, TB 
(b) TB, GB, MB, KB 
(c) GB, TB, MB, KB 
(d) MB, GB, TB, KB 
(e) TB, MB, GB, KB 
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Q55. Which of the following is not a tool in MS Word? 

(a) Spell Check 

(b) Thesaurus 

(c) Mail Merge 

(d) Firefox 

(e) Hyperlink 

 

Q56. What is Artificial Intelligence (AI)? 

(a) A machine that cleans like a human 

(b) Making a machine intelligent 

(c) A software for graphic design 

(d) A tool for data entry 

(e) A hardware component  

 

Q57. What is the shortcut key to save a document? 

(a) Ctrl + P 

(b) Ctrl + S 

(c) Ctrl + C 

(d) Ctrl + V 

(e) Ctrl + X 

 

Q58. Which of the following is used for communication via 

television? 

(a) Radio 

(b) Internet 

(c) Telephone 

(d) Satellite 

(e) Fiber Optic Cable  

 

Q59. Which of the following provides power backup during 

an electricity outage? 

(a) Hard Drive 

(b) Surge Protector 

(c) UPS 

(d) CPU 

(e) Modem 

 

Q60. Which of the following is not an input device? 

(a) Mouse  

(b) Microphone 

(c) Plotter 

(d) Keyboard  

(e) None of the above 

 

Q61. What is the shortcut key to insert a new slide in 

PowerPoint? 

(a) Ctrl + M 

(b) Ctrl + N 

(c) Ctrl + S 

(d) Ctrl + D 

(e) Ctrl + P  

 

Q62. When was the internet invented? 

(a) January 1, 1970 

(b) January 1, 1980 

(c) January 1, 1983 

(d) January 1, 1990 

(e) January 1, 2000  

 

Q63. Which of the following is a valid PowerPoint file 

extension? 

(a) .xls 

(b) .docx 

(c) .ppt/.pptx 

(d) .mdb 

(e) .txt 

 

Q64. In the year 1837, what was the name of the first 

mechanical computer conceptualized? 

(a) Difference Engine 

(b) Analytical Engine 

(c) Turing Machine 

(d) ENIAC 

(e) Colossus 

 

Q65. Which of the following is not a UPI app? 

(a) Google Pay 

(b) PhonePe 

(c) Paytm 

(d) Adobe Acrobat  

(e) BHIM 

 

Q66. What is Blockchain? 

(a) A centralized database 

(b) A type of cryptocurrency 

(c) A distributed ledger on a peer-to-peer network 

(d) A software for creating websites 

(e) A tool for data encryption  

 

Q67. What is the function of the Format Painter in MS 

Word? 

(a) To copy text 

(b) To paste text 

(c) To apply the same formatting from one part of the document 

to another 

(d) To print the document 

(e) To insert a table above 

 

Q68. Under which tab is the Footnote option found in MS 

Word? 

(a) Home 

(b) Insert 

(c) References 

(d) Review 

(e) View  
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Q69. What is a digital signature in an email used for? 

(a) Encrypting the email content 

(b) Formatting the email text 

(c) Verifying the sender's identity and ensuring message 

integrity 

(d) Attaching files to the email 

(e) Automatically replying to emails 

 

Q70. Which of the following is a valid email address? 

(a) user@domain 

(b) user.domain.com 

(c) user@domain.com 

(d) user@domain@com 

(e) user#domain.com  

(e) None of the above 

 

Q71. Where does a deleted email go? 

(a) Inbox 

(b) Sent Items 

(c) Drafts 

(d) Trash Folder 

(e) Spam  

 

Q72. What is the full form of WAN? 

(a) Wireless Area Network 

(b) Wide Area Network 

(c) Web Area Network 

(d) Wired Area Network 

(e) World Area Network 

 

Q73. Which of the following is fastest primary memory? 

(a) Hard Drive 

(b) SSD 

(c) RAM 

(d) ROM 

(e) DVD 

 

Q74. Which of the following is not an operating system? 

(a) Windows 

(b) Linux 

(c) Android 

(d) Microsoft Office 

(e) macOS 

 

Q75. What is the function of the taskbar? 

(a) To save files 

(b) To display the desktop wallpaper 

(c) To provide access to programs and display open programs, 

even if minimized 

(d) To shut down the computer 

(e) To format the hard drive 

 

Q76. What is Linux? 

(a) A web browser 

(b) An operating system 

(c) A word processing software 

(d) A spreadsheet program 

(e) An email client  

 

Q77. Which of the following is used to hold data temporarily 

in a computer processor? 

(a) Hard Drive 

(b) RAM 

(c) Register 

(d) Cache Memory 

(e) SSD  

 

Q78. Which one of the following is not true? 

(a) You can also create graphs in Excel sheets. 

(b) Excel sheets have the extension *.doc. 

(c) A new workbook is called “Book 1”. 

(d) You can have Word and Excel open together. 

(e) Excel supports multiple worksheets in a single workbook.  

 

Q79. The process of retaining data for future use is called: 

(a) Reading 

(b) Writing 

(c) Storing 

(d) Coding 

(e) Processing 

 

Q80. What is the shortcut key for underlining text in MS Word? 

(a) Ctrl + I 

(b) Ctrl + U 

(c) Ctrl + B 

(d) Ctrl + A  

(e) None of the above 
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Solutions 
 

S1. Ans.(c) 

Sol. The label of the first row in MS Excel is 1. Excel rows are 

numbered sequentially starting from 1, while columns are 

labeled alphabetically starting from A. 

 

S2. Ans.(a) 

Sol. In MS Word, the title or page number is defined using the 

Header and Footer. The Header is the section at the top of each 

page where titles can be placed, and the Footer is the section at 

the bottom where page numbers and other information can be 

inserted. 

 

S3. Ans.(d) 

Sol. The correct ascending order of page sizes is 

A5(5.83”×8.27”)< A4(8.27”×11.69”)<Legal(8.5”×14”). A5 is 

the smallest, followed by A4, and Legal is the largest among 

these options. 

 

S4. Ans.(a) 

Sol. The shortcut key for inserting a page break in MS Word is 

Ctrl + Enter. This command quickly inserts a page break at the 

cursor's current position, moving the text following the cursor 

to the beginning of the next page. 

 

S5. Ans.(a) 

Sol. The function key for Help in most software applications is 

F1. Pressing F1 typically opens the Help documentation or 

support page relevant to the software being used. 

 

S6. Ans.(b) 

Sol. The base of the octal number system is 8. This means it uses 

eight digits, from 0 to 7, to represent numbers. 

 

S7. Ans.(c) 

Sol. A Dot Matrix Printer is an example of an impact printer. It 

works by striking a print head against an ink ribbon to produce 

characters on paper, making physical contact, unlike non-impact 

printers such as inkjet and laser printers. 

 

S8. Ans.(c) 

Sol. Disk Defragmenter is an example of Utility Software. It is 

used to reorganize fragmented data on a disk drive so that files 

are stored in contiguous blocks, which can improve the 

efficiency and speed of data access. 

 

S9. Ans.(b) 

Sol. The IP address range for Class A is 0-127. Class A addresses 

are designed for very large networks, with the first octet ranging 

from 0 to 127. However, addresses starting with 127 are 

reserved for loopback and diagnostic functions. 

 

S10. Ans.(c) 
Sol. The symbol used for absolute cell reference in MS Excel is 
the $ (Dollar) sign. It locks the reference to a specific cell, so 

when the formula is copied to another cell, the reference does 
not change. For example, $A$1 refers to an absolute reference to 
cell A1. 
 
S11. Ans.(c) 
Sol. The Word Wrap feature in MS Excel is used to display cell 
contents on multiple lines within the same cell. This makes the 
content easier to read by preventing long text from extending 
beyond the cell boundary. 

 
S12. Ans.(a) 
Sol. The binary equivalent of the decimal number 10 is 1010. 
Converting from decimal to binary involves dividing the number 
by 2 and recording the remainders, which results in the binary 
representation 1010. 
 
S13. Ans.(c) 
Sol. In Excel, formulas always start with the equal sign (=). This 
indicates to Excel that the following string of characters should 

be interpreted as a formula, not as regular text or numbers. 
 
S14. Ans.(b) 
Sol. The shortcut key for center alignment in MS Word is Ctrl + 
E. This command centers the selected text within the document, 
making it evenly spaced between the left and right margins. 
 
S15. Ans.(d) 
Sol. All statements 1, 2, 3, 4, and 5 are true. ChatGPT is a type 

of artificial intelligence developed by OpenAI that can 
understand and generate human-like text, perform language 
translation, and be used for programming assistance. 
 
S16. Ans.(b) 
Sol. The alphabets used in the hexadecimal number system are 
6(A, B, C, D, E, F). Hexadecimal is a base-16 number system, 
using the digits 0-9 and the letters A-F to represent values. 
 
S17. Ans.(d) 

Sol. Real-time processing and time-sharing systems were 
introduced during the Fourth Generation of computers. This 
era was characterized by the development of microprocessors 
and the widespread use of integrated circuits. These 
advancements made it possible to handle multiple tasks 
simultaneously and respond to real-time inputs. 
 
S18. Ans.(c) 
Sol. The Ctrl + F6 shortcut key in MS Excel switches to the next 

workbook window when more than one workbook window 
is open. This shortcut helps users quickly navigate between 
multiple open workbooks. 
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S19. Ans.(d) 

Sol. In MS Word, the option to insert a citation can be found 

under the References tab. This tab includes tools for adding 

citations, managing sources, and creating bibliographies, making 

it easier to reference and cite sources in your document. 

 

S20. Ans.(c) 

Sol. An IPv4 address uses 32 bits. These bits are typically 

represented as four decimal numbers separated by dots, with 

each number ranging from 0 to 255 (e.g., 192.168.1.1). 

 

S21. Ans.(a) 

Sol. The use of a watermark in a document is to prevent 

unauthorized copying or distribution. It serves as a visible 

mark indicating the document's ownership or copyright status, 

deterring misuse. 

 

S22. Ans.(c) 

Sol. Solaris is not programming software; it is a proprietary 

Unix operating system originally developed by Sun 

Microsystems. The other options listed are all integrated 

development environments (IDEs) used for programming. 

 

S23. Ans.(c) 

Sol. Firmware is the software that is substituted for hardware 

and stored in ROM. It is a specific class of computer software 

that provides low-level control for a device's specific hardware. 

BIOS (Basic Input/Output System) is an example of firmware. 

 

S24. Ans.(d) 

Sol. The correct formula to sum cells A1 and A2 in Excel is 

=SUM(A1:A2). This formula adds the values in the specified 

range of cells. 

 

S25. Ans.(c) 

Sol. The shortcut key to run macros in MS Excel is Alt + F8. This 

opens the Macro dialog box, allowing users to run, create, or edit 

macros. 

 

S26. Ans.(d) 

Sol. Hierarchical, Network, Relational, and Distributed are 

recognized types of databases based on their structure and 

functionality, while "private" is not a specific database type. 

 

S27. Ans.(d) 

Sol. The main function of the Control Unit (CU) in a computer is 

controlling the sequence of operations. It directs the 

operation of the processor by fetching instructions, decoding 

them, and managing the execution of instructions by 

coordinating with other components. 

 

S28. Ans.(c) 

Sol. The "I'm Feeling Lucky" button on the Google search page 
sends you directly to the first result of the search query. 

This feature is designed to save time by bypassing the search 

results page and taking you straight to the most relevant 

website. 
 

S29. Ans.(a) 

Sol. The basic logic gates are AND, OR, and NOT. These gates 
perform fundamental Boolean operations and are the building 

blocks of digital circuits. The other gates (NAND, NOR, XOR, etc.) 

are derived from these basic gates. 

 
S30. Ans.(c) 

Sol. SSL (Secure Sockets Layer) was originally developed by 

Netscape. SSL is a standard security technology for establishing 
an encrypted link between a server and a client, ensuring that all 

data transmitted remains private and integral. 

 

S31. Ans.(b) 
Sol. Pascal is a high-level programming language. It was 

developed for teaching programming concepts and for general-

purpose programming. It is known for its clear syntax and 
strong typing, making it an excellent language for structured 

programming and data structuring. 

 

S32. Ans.(d) 
Sol. The type of memory commonly used in mobile phones for 

primary storage is Flash Memory. Flash memory is a non-

volatile storage medium that retains data even when power is 
disconnected. It is commonly used in mobile phones and other 

portable devices due to its compact size, low power 

consumption, and ability to store data without the need for 

constant power supply. Flash memory is used primarily for 
storage, while RAM (Random Access Memory) is used for code 

execution and calculations on the data retrieved from storage. 

 
S33. Ans.(a) 

Sol. GIF (Graphics Interchange Format) and PNG (Portable 

Network Graphics) are image formats. They are used for 

storing and displaying images, with GIF supporting animation 
and PNG offering lossless compression for high-quality images. 

 

S34. Ans.(d) 

Sol. The NIC (Network Interface Card) uses a 48-bit 
addressing scheme known as the MAC (Media Access Control) 

address. This unique hardware identifier is assigned to network 

interfaces for communication on the physical network segment, 
ensuring each device on a local network has a distinct address. 

 

S35. Ans.(b) 

Sol. NOR and NAND gates are known as universal gates 
because they can be used to create any other type of logic gate. 

They are fundamental building blocks in digital circuit design. 
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S36. Ans.(c) 
Sol. The 'Merge and Center' feature in MS Excel combines two 
or more selected cells into one cell and centers the content 
in the new merged cell. This is often used for formatting 
headings or titles across multiple columns. 
 
S37. Ans.(b) 
Sol. The first computer virus, known as the "Creeper virus," 
appeared in 1971. It was an experimental self-replicating 
program created by Bob Thomas at BBN Technologies. The virus 
infected ARPANET, the precursor to the internet. 
 
S38. Ans.(a) 
Sol. Phishing is a form of social engineering and a scam where 
attackers deceive people into revealing sensitive information or 
installing malware such as viruses, worms, adware, or 
ransomware. It often involves pretending to be a trustworthy 
entity in electronic communications. 
 
S39. Ans.(a) 
Sol. Standby mode (or Sleep mode) makes it easy for the 
computer user to quickly resume work. It saves the current state 
of the computer in RAM and allows for a quick resume of 
operations, consuming minimal power. 
 
S40. Ans.(b) 
Sol. Direct Action Virus is also known as a non-resident virus. 
It gets installed and stays hidden in your computer's memory, 
where it executes its payload when the infected file is accessed, 
but it does not reside in the system's memory after execution. 
 
S41. Ans.(c) 
Sol. The shortcut key for removing character formatting in MS 
Word 2013 is Ctrl + Spacebar. This resets the selected text to 
the default font formatting. 
 
S42. Ans.(d) 
Sol. The minimum number of rows and columns in an MS Word 
document table is 1 row and 1 column. 
 
S43. Ans.(c) 
Sol. The file extensions .doc and .docx are associated with MS 
Word. They are used for Microsoft Word document files, with 
.docx being the newer format introduced with Word 2007. 
 
S44. Ans.(c) 
Sol. A modem (modulator-demodulator) is a device that 
converts digital signals to analog signals and vice versa, allowing 
computers to communicate over telephone lines or cable 
systems. 
 
S45. Ans.(d) 
Sol. The capacity of a CD-ROM is typically around 750 MB. This 
capacity allows it to store a substantial amount of data, such as 
software applications, audio files, and documents. 
 

S46. Ans.(c) 

Sol. Microsoft Access is a database software. It is used to store, 

manage, and retrieve data efficiently, whereas the other options 

are not designed for database management. 

 

S47. Ans.(a) 

Sol. SUM is a function in Excel used to add together a range of 

cells. The other options are commands or features not specific to 

Excel functions. 

 

S48. Ans.(b) 

Sol. The bottom section of a document is called the Footer. The 

Footer is located at the bottom of each page and can contain 

additional information such as page numbers, footnotes, or 

other references. 

 

S49. Ans.(c) 

Sol. A computer cannot boot if the operating system is not 

present. The operating system is essential for managing 

hardware and software resources and providing services for 

computer programs. Without it, the computer cannot start up 

and function properly. 

 

S50. Ans.(d) 

Sol. Office 365, now known as Microsoft 365, is a 

subscription-based service that allows users to work online with 

MS Office applications such as Word, Excel, and PowerPoint 

through a web browser. 

 

S51. Ans.(c) 

Sol. The shortcut key for bolding text in MS Word is Ctrl + B. 

This command applies bold formatting to the selected text or 

toggles the bold formatting on and off. 

 

S52. Ans.(d) 

Sol. ROM (Read-Only Memory) is non-volatile memory. It 

retains its data even when the computer is turned off, unlike 

volatile memory such as RAM, which loses its data when power 

is lost. 
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S53. Ans.(a) 

Sol. Head & Ribbon is not a part of a laser printer. Laser 

printers use a toner cartridge, drum unit, fuser, and laser to 

print documents, whereas head and ribbon are components 

used in dot matrix printers. 

 

S54. Ans.(b) 

Sol. The descending order of size is: TB (Terabyte), GB 

(Gigabyte), MB (Megabyte), KB (Kilobyte). This sequence 

arranges the data sizes from largest to smallest. 

 

S55. Ans.(d) 

Sol. Firefox is not a tool in MS Word. It is a web browser, while 

the other options are features and tools available in MS Word. 

 

S56. Ans.(b) 

Sol. Artificial Intelligence (AI) involves making a machine 

intelligent, enabling it to perform tasks that typically require 

human intelligence, such as reasoning, learning, and problem-

solving. 

 

S57. Ans.(b) 

Sol. The shortcut key to save a document in most software 

applications, including MS Word and Excel, is Ctrl + S. This 

command saves the current document. 

 

S58. Ans.(d) 

Sol. Satellite communication is used for talking via television. 

It enables the transmission of signals for television broadcasting 

over long distances, allowing for live communication and 

broadcasts. 

 

S59. Ans.(c) 

Sol. A UPS (Uninterruptible Power Supply) provides power 

backup during an electricity outage. It ensures that electronic 

devices continue to operate temporarily during a power failure, 

preventing data loss and hardware damage. 

 

S60. Ans.(c) 

Sol. A plotter is not an input device. It is an output device used 

for printing vector graphics. 

 

S61. Ans.(a) 

Sol. The shortcut key to insert a new slide in PowerPoint is Ctrl 

+ M. This command quickly adds a new slide to the presentation, 

making it easy to expand the content. 

 

S62. Ans.(c) 

Sol. The internet as we know it today was effectively born on 

January 1, 1983, when ARPANET adopted the TCP/IP protocol, 

marking the beginning of the modern internet. 

 

S63. Ans.(c) 

Sol. The valid PowerPoint file extensions are .ppt and .pptx. 

These extensions are used for Microsoft PowerPoint 

presentation files, with .pptx being the newer format introduced 

with PowerPoint 2007. 

 

S64. Ans.(b) 
Sol. The first mechanical computer conceptualized in 1837 was 

the Analytical Engine. It was designed by Charles Babbage and 

is considered the precursor to modern computers, capable of 

performing a variety of calculations using punched cards. 

 

S65. Ans.(d) 

Sol. Adobe Acrobat is not a UPI app. It is a software application 

used for viewing, creating, and managing PDF documents, while 

the other options are UPI apps used for digital payments. 

 

S66. Ans.(c) 

Sol. Blockchain is a distributed ledger on a peer-to-peer 
network. It allows multiple parties to have simultaneous access 

to a constantly updated digital ledger that is secure, transparent, 

and immutable. 

 

S67. Ans.(c) 

Sol. The Format Painter in MS Word is used to apply the same 

formatting from one part of the document to another. It 

helps in quickly copying and pasting formatting styles. 

 

S68. Ans.(c) 

Sol. The Footnote option is found under the References tab in 

MS Word. This tab provides tools for adding footnotes, endnotes, 

citations, and bibliographies to your document. 
 

S69. Ans.(c) 

Sol. A digital signature in an email is used for verifying the 

sender's identity and ensuring the message's integrity. It 

provides authentication and non-repudiation, ensuring the 

recipient that the email has not been altered and confirming the 

sender's identity. 

 

S70. Ans.(c) 

Sol. The correct format for a valid email address is 

user@domain.com. It includes a local part (user), an @ symbol, 

and a domain part (domain.com). 
 

S71. Ans.(d) 

Sol. When an email is deleted, it is moved to the Trash Folder. 

This folder temporarily stores deleted emails until they are 

permanently removed. 

 

S72. Ans.(b) 

Sol. WAN stands for Wide Area Network. It is a 

telecommunications network that extends over a large 

geographical area for the purpose of computer networking. 
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S73. Ans.(c) 

Sol. RAM (Random Access Memory) is the fastest primary 

memory compared to Hard Drives, SSDs, ROM, and DVDs. It 

provides quick read and write access for the CPU to execute 

programs and process data. 

 

S74. Ans.(d) 

Sol. Microsoft Office is not an operating system. It is a suite of 

productivity applications, whereas Windows, Linux, Android, 

and macOS are all operating systems. 

 

S75. Ans.(c) 

Sol. The taskbar provides access to programs and displays 

open programs on the desktop, even if they are minimized. 

It is a key interface element in operating systems, allowing users 

to switch between and manage running applications easily. 

 

S76. Ans.(b) 

Sol. Linux is an operating system. It is an open-source, Unix-

like OS used for a variety of computing purposes, including 

servers, desktops, and embedded systems. 
 

S77. Ans.(c) 
Sol. A register is a small, fast storage location within a 
computer processor used to hold data temporarily during 
processing. Registers are crucial for the CPU's operation, 
enabling quick data access and manipulation. 
 
S78. Ans.(b) 
Sol. Excel sheets do not have the extension *.doc. The correct 
file extensions for Excel sheets are *.xls or *.xlsx. The other 
statements about Excel are true, including creating graphs, 
naming new workbooks "Book 1," and having multiple 
worksheets. 
 
S79. Ans.(c) 
Sol. Storing is the process of retaining data for future use. It 
involves saving data in memory or on a storage device so that it 
can be accessed and used later. 
 
S80. Ans.(b) 
Sol. The shortcut key for underlining text in MS Word is Ctrl + 
U. This command applies an underline to the selected text or 
toggles the underline formatting on and off. 
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Memory Based Questions IBPS RRB PO & Clerk 2022 
 

Q1. Workbook is a collection of __________ in MS Excel? 
(a) page set-up 
(b) buttons 

(c) diagrams 
(d) worksheets  
(e) None of the above 

 
Q2. The __________ menu contains the options to add symbols in 
a Word document. 

(a) Home 
(b) Insert 
(c) Review 

(d) Mailing 
(e) None of the above 
 
Q3. Which among the following is the short cut key for 

slideshow? 
(a) F4 
(b) F5 

(c) F6 
(d) F7 
(e) F12 

 
Q4. Word is a word processor developed by Microsoft. In MS 
Word spelling check is a feature available in which tab? 

(a) Page Layout 
(b) Home 
(c) Insert  
(d) Review 

(e) None of the above 
 
Q5. Which term is not related with font? 

(a) Font face 
(b) Font size 
(c) Font color 

(d) Font grammar 
(e) None of the above 
 

Q6. Which key should you use to indent the first paragraph of 
your report? 
(a) tab key 
(b) return key 

(c) space bar 
(d) shift key 
(e) None of the above 

 
Q7. What is decorative text called, that you can add to a 
document? 

(a) Table 
(b) Symbol 
(c) WordArt 

(d) Image 
(e) None of the above 
 

Q8. If a word is typed that is not in MS Word's dictionary, a 
wavy underline appears below the word. What is the color of 
the underline that appears in this situation? 
(a) Blue 
(b) Red  
(c) Green 
(d) Black 
(e) None of the above 
 
Q9. Moving a paragraph in MS-word from one place to 
another can be done by which of the following actions? 
(a) Select, copy  
(b) Select all, cut  
(c) Select, cut and paste  
(d) Select, design  
(e) None of the above 
 
Q10.Each box in a spreadsheet is called a ________. 
(a) Cell  
(b) Block 
(c) Field  
(d) Table 
(e) None of the above 
 
Q11.Which of the following characteristics is used to compute 
dynamically the results from Excel data? 
(a) Go to 
(b) Table 
(c) Chart 
(d) Formula and Function 
(e) None of the above 
 
Q12.Which feature helps to search the text through reference 
material such as dictionaries, encyclopedias and translation 
services? 
(a) Translation 
(b) Research  
(c) Find 
(d) Font 
(e) None of the above 
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Q13.Which of the following key use, when you want to make 
all letters capital without having to use the shift key for each 
character? 
(a) shifter 
(b) upper case 
(c) caps lock key 
(d) icon 
(e) None of the above 
 
Q14.Which of the following features is used to count the 
number of pages, words, characters, paragraphs and lines in a 
Word document?  
(a) Orientation  
(b) Page Count  
(c) Word Count  
(d) Margin  
(e) None of the above 
 
Q15.Which of the following is not an in-built software 
application found in MS windows?  
(a) Paint  
(b) CD Player  
(c) Disk Defragmenter  
(d) MS Word 
(e) None of the above 
 
Q16. __________ is also known as inkless printer. 
(a) Thermal printer 
(b) Inkjet printer 
(c) OCR 
(d) Dot Matrix printer 
(e) None of the above 
 
Q17.Digital computers use a ________ system to encode data 
and programs.   
(a) Semiconductor  
(b) Decimal  
(c) Binary  
(d) RAM 
(e) None of the above 
 
Q18.Which of the following is a video format? 
(a) JPEG 
(b) GIF 
(c) FLV 
(d) PNG 
(e) None of the above 
 
Q19.Which of the following hardware or software designed to 
guard against unauthorized access to a computer network? 
(a) Hacker-proof program. 
(b) Firewall. 
(c) Hacker-resistant server. 
(d) Encryption safe wall. 
(e) None of the above 
 

Q20.A simple automated program that scans the web for 
specific data and insert into a designated database is ________. 
(a) Web mining  
(b) Web database integration  
(c) Web crawler 
(d) Web scanning  
(e) None of the above 
 
Q21.What is the software frequently utilized by end users 
called (like Word, PowerPoint)? 
(a) System Software 
(b) System Appliances 
(c) Application Software 
(d) Operating System 
(e) None of the above 
 
Q22.Web cam is an: 
(a) input unit device 
(b) output unit device 
(c) processing device 
(d) Input and Output device 
(e) None of the above 
 
Q23.Which part of the hardware compensates the difference 
between the CPU and peripherals?  
(a) Scanner  
(b) Printer  
(c) Video card  
(d) Interface  
(e) None of the above 
 
Q24.A device that not only provides surge protection, but also 
furnishes the computer with battery backup power during a 
power outage is ______   
(a) Battery strip  
(b) UPS  
(c) Surge strip  
(d) USB  
(e) None of the above 
 
Q25. _________ is a set of computer programs used on a 
computer to help perform tasks.  
(a) An instruction  
(b) Memory  
(c) A processor  
(d) Software  
(e) None of the above 
 
Q26.Which part of the CPU coordinates all the activities of a 
computer system?  
(a) Motherboard  
(b) Coordination board  
(c) Control unit  
(d) Arithmetic and logic unit  
(e) None of the above 
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Q27.Which of the following converts all the source code into 
machine code, creating an executable file. 
(a) linker 
(b) assembler 
(c) compiler 
(d) interpreter 
(e) None of the above 
 
Q28.What type of telecommunications hardware allows you 
to access the web? 
(a) Browser     
(b) Modem 
(c) FTP protocol    
(d) IRC 
(e) None of the above 
 
Q29.Which type of software coordinates the interaction of 
technology devices? 
(a) Application software 
(b) RAM 
(c) Utility software 
(d) Systems software 
(e) None of the above 
 
Q30.Which among the following is a software that uses a 
pattern-matching technique to examine all files on a disk 
looking for harmful code? 
(a) Multimedia Player   
(b) Backup software  
(c) Driver imaging  
(d) Antivirus Software 
(e) None of the above 
 
Q31.Which of the following software programs that allow you 
to legally copy files and give them away at no cost? 
(a) Time sharing 
(b) Public domain 
(c) Shareware 
(d) Commercial 
(e) None of the above 
 
Q32. A DVD is an example of a /an: 
(a) Output device 
(b) Hard disc 
(c) Optical disc 
(d) Solid-state storage device 
(e) None of the above 
 
Q33.What is a specialized software program that allows input 
and output devices to communicate with the rest of the 
computer system? 
(a) Utility driver 
(b) Utility program 
(c) Data compression utility 
(d) Device driver  
(e) None of the above 
 

Q34. A device that connects to a network without the use of a 
cable is said to be: 
(a) Distributed 
(b) Non-Wired 
(c) Centralized 
(d) Wireless 
(e) None of the above 
 
Q35.The software that is used to create text-based documents 
is referred as: 
(a) DBMS 
(b) Suits  
(c) Spreadsheets  
(d) Word processor 
(e) None of the above 
 
Q36.A __________ is an electronic device that process data, 
converting it into information. 
(a) processor 
(b) computer 
(c) case 
(d) stylus 
(e) None of the above 
 
Q37.Floppy drives, hard drives and tape drives all use a 
__________ to read data. 
(a) laser 
(b) sensor 
(c) magnet 
(d) pen 
(e) None of the above 
 
Q38.Which of the following software posts unwanted 
advertisements on client’s computer?    
(a) Virus  
(b) Malware  
(c) Worm  
(d) Adware  
(e) None of the above 
 
Q39.Which of the following mouse can work on any surface 
from a granite countertop to a carpet?  
(a) Mechanical mouse  
(b) Optical mouse  
(c) Laser mouse  
(d) Blue Track mouse  
(e) None of the above 
 
Q40.Which of the following keeps a list of web pages you have 
visited during the current session? 
(a) history 
(b) cache 
(c) favorites 
(d) trail 
(e) None of the above 
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Solutions 
 

S1. Ans.(d) 
Sol. Workbook is a collection of worksheets in MS Excel. 
 
S2. Ans.(b) 
Sol. The Insert menu is MS Word contains the Symbol option 
that allows you to insert symbols in the document. 
 
S3. Ans.(b)  
Sol. F5 is the shortcut key for slideshow. 
 
S4. Ans.(d) 
Sol. Word is a word processor developed by Microsoft. In MS 
Word spelling check is a feature available in Review tab.  
 
S5. Ans.(d) 
Sol. There is nothing such as font grammar. 
 
S6. Ans.(a) 
Sol.  Tab Key can be used for indentation. 
 
S7. Ans.(c) 
Sol. WordArt is decorative text that you can add to a 
document. You can make changes to WordArt, such as the font 
size and the text colour, by using the drawing tools options 
available automatically after you insert or select the WordArt 
in a document. 
 
S8. Ans.(b) 
Sol. This indicates either a possible spelling error or that 
Word doesn't recognize a word, such as a proper name or 
place. Green underline- Word thinks that grammar should be 
revised. Blue underline- A word is spelled correctly but does 
not seem to be the correct word for the sentence. 
 
S9. Ans.(c) 
Sol. You can move a letter, word or paragraph by first 
selecting it, cutting it and then pasting it to the intended 
location.  
 
S10. Ans.(a) 
Sol. Each box in a spreadsheet is called a cell. 
 

 

S11. Ans.(d)  
Sol. Functions are predefined formulas and are already 
available in Excel. They are used to compute dynamically the 
results from Excel data 
 
S12. Ans.(b) 
Sol. In the Research Option dialog box, you can select from 
dictionaries, thesauruses, and various Internet research Web 
sites in several languages. The Research Options services 
available depend on the language of the version of Office and 
any services that we add to the Research Options dialog box. 
 
S13. Ans.(c) 
Sol. Caps Lock key use, when you want to make all letters 
capital without having to use the shift key for each character 
 
S14. Ans.(c) 
Sol. The Word Count command displays the total number of 
pages, words and lines in a document.   
 
S15. Ans.(d)  
Sol. MS Word is not an in-built application of windows. 
However, it can be downloaded. 
 
S16. Ans.(a) 
Sol. Thermal printers are inkless. 
 
S17. Ans.(c) 
Sol. Digital Computers use Binary System.   
 
S18. Ans.(c) 
Sol. FLV (Flash Video Format), the FLV file extension is a file 
that uses Adobe Flash Player or Adobe Air to transmit 
video/audio over the internet. Flash Video has long been the 
standard video format used by nearly all embedded video on 
the internet including the videos found on YouTube, Hulu, and 
many more websites. 
 
S19. Ans.(b) 
Sol. A firewall is either hardware or software, or a 
combination of both. firewall prevent the unauthorized access 
to or from a private network. 
 
S20. Ans.(c) 
Sol. A web crawler (also known as a web spider or web robot) 
is a program or automated script which browses the World 
Wide Web in a methodical, automated manner. This process is 
called Web crawling or spidering. 
 
S21. Ans.(c) 
Sol. Application software is a program or group of programs 
designed for end users. An application program (app or 
application for short) is a computer program designed to 
perform a group of coordinated functions, tasks, or activities 
for the benefit of the user. Examples of an application include 
a word processor, a spreadsheet, an accounting application, a 
web browser etc. 
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S22. Ans.(a) 

Sol. A webcam is a hardware camera and input device that 

connects to a computer and the Internet and captures either 

still pictures or motion video of a user or other object. 

 

S23. Ans.(d) 

Sol. Interface part of the hardware compensates the difference 

between the CPU and peripherals. 

 

S24. Ans.(b)  

Sol. An uninterruptible power supply, also uninterruptible 

power source, UPS or battery/flywheel backup, is an electrical 

apparatus that provides emergency power to a load when the 

input power source or mains power fails. 

 

S25. Ans.(d) 

Sol. Software is a set of computer programs used on a 

computer to help perform tasks. Computer software, or simply 

software, is that part of a computer system that consists of 

encoded information or computer instructions, in contrast to 

the physical hardware from which the system is built. 

 

S26. Ans.(a) 

Sol. A motherboard is that part of a CPU which coordinates all 

the activities of a computer system. Various types of hardware 

are attached on the motherboard to facilitate these activities.  

 

S27. Ans.(c) 

Sol. Compiler converts all source code of high-level 

programming language into low level machine code. 

 

S28. Ans.(b) 

Sol. A modem is a device or program that enables a computer 

to transmit data over, for example, telephone or cable lines. 

Computer information is stored digitally, whereas information 

transmitted over telephone lines is transmitted in the form of 

analog waves. 

 

S29. Ans.(d) 

Sol. System software is a type of computer program that is 

designed to run a computer's hardware and application 

programs. 

 

S30. Ans.(d)  

Sol. Antivirus or anti-virus software, sometimes known as 

anti-malware software, is computer software used to prevent, 

detect and remove malicious software. 

 

S31. Ans.(c) 

Sol. shareware is software that allows a user to try all or part 

of the program for free before buying it. 
 

S32. Ans.(c) 
Sol. A DVD (Digital Versatile Disc) is an example of an optical 
disc. Optical discs use laser technology to read and write data. 
DVDs are commonly used for storing and distributing large 
amounts of digital data, such as movies, software, and other 
multimedia content. They are read by DVD players or DVD 
drives in computers and other devices. 
 
S33. Ans.(d) 
Sol. A device driver is a particular form of software 
application that is designed to enable interaction with 
hardware devices. Without the required device driver, the 
corresponding hardware device fails to work.  
 
S34. Ans.(d) 
Sol. A device that connects to a network without the use of a 
cable is said to be Wireless. 
 
S35. Ans.(d)  
Sol. Word processors are used to create text-based 
documents. 
 
S36. Ans.(b) 
Sol. A computer is an electronic device that process data, 
converting it into information. 
 
S37. Ans.(c) 
Sol. Floppy drives, hard drives and tape drives all use a 
magnet to read data. 
 
S38. Ans.(d) 
Sol. Adware is a software that is used to post unwanted 
advertisements. Generally, these advertisements are posted as 
popups.  
 
S39. Ans.(d) 
Sol. BlueTrack mouse is a type of mouse that is based on the 
Blue Track Technology and can work on any surface from 
granite countertop to the carpet.   
 
S40. Ans.(a) 
Sol. History keeps a list of web pages you have visited during 
the current session. 
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Memory Based Questions IBPS RRB PO & Clerk 2021 
 

Q1. ____________ are computers that support hundreds or 
thousands of users simultaneously. 
(a) Mainframe computer 

(b) Super computer 
(c) Mini computer 
(d) Micro computer 

(e) None of the above 
 
Q2. Zip is a -----file. 

(a) Executable File 
(b) Compressed File 
(c) System File 

(d) Processing File 
(e) None of the above 
 
Q3. What is the meaning of MICR? 

(a) Magnetic Ink Character Recognition 
(b) Magnetic Intelligence Character Recognition 
(c) Magnetic Information Cable Recognition 

(d) Magnetic Insurance Cases Recognition 
(e) None of the above 
 

Q4. which of the following is an intersection of a row and 
column in a spreadsheet? 
(a) Formula 

(b) Worksheet 
(c) Address 
(d) Cell 
(e) None of the above 

 
Q5. which of the following is a set of rules computers use to 
talk to each other? 

(a) Syntax 
(b) HTML 
(c) DOS command 

(d) Protocol 
(e) None of the above 
 

Q6. Which of the following topology have a central controller 
or hub? 
(a) Star 
(b) Mesh 

(c) Ring 
(d) Bus 
(e) None of the above 

 
Q7. Which tracking program records every keystroke you 
make on the computer? 

(a) ITrack/ULead 
(b) Key logging 
(c) eFollow 

(d) Stalking software 
(e) None of the above 
 

Q8. To place your image into a live video conference, a 
__________ is usually used. 
(a) Webcam 
(b) Video camera 
(c) Digital camera 
(d) Scanner 
(e) None of the above 
 
Q9. What are general purpose computers used for? 
(a) Accounting 
(b) Creating a small database 
(c) Performs calculation 
(d) All of the above 
(e) None of the above 
 
Q10. In MS-Word, _____is a series of commands and 
instructions that you group together as a single command to 
accomplish a task automatically. 
(a) Macro 
(b) Template 
(c) Structure 
(d) Balloons 
(e) None of the above 
 
Q11. Every computer connected to an internet must have a 
distinct____ 
(a) UPS address 
(b) proxy server 
(c) IP address 
(d) domain name 
(e) None of the above 
 
Q12. The Internet allows you to: 
(a) send electronic mail 
(b) view web pages 
(c) connect to servers all around the world 
(d) All of the above 
(e) None of the above 
 
Q13. Which of the following is the communication protocol 
that sets the standard used by every computer that accesses 
web-based information?  
(a) XML 
(b) DML 
(c) HTTP 
(d) HTML 
(e) None of the above 
 
Q14. Which of the following is a Web browser? 
(a) Paint  
(b) PowerPoint  
(c) Edge 
(d) Word  
(e) None of the above 
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Q15. Which of the following must be contained in a URL?  

(a) A protocol identifier  
(b) The letters, www 

(c) The unique registered domain name  

(d) A protocol identifier, www and the unique registered 

domain name 
(e) None of the above 

 

Q16. You can organize your bookmarks using __________. 
(a) structures 

(b) containers 

(c) folders 

(d) menus 
(e) None of the above 

 

Q17. Which among the following was the first graphical web 
browser? 

(a) Mosaic  

(b) WAIS 

(c) CERN 
(d) Gopher 

(e) None of the above 

 
Q18. Generally to copy data from a remote compute/internet 

to a local computer is called __________. 

(a) Upload 

(b) Editing 
(c) Download 

(d) E-mail 

(e) None of the above 
 

Q19. Which of the following is used to close a tab on a 

browser? 

(a) Ctrl + T 
(b) Ctrl + W 

(c) Ctrl + A 

(d) Ctrl + Y 
(e) None of the above 

 

Q20. What is a hyperlink? 

(a) It is a text or image that you can click on to jump to a new 
document/page. 

(b) It is an input type for multimedia files. 

(c) It is a collection or directory of web pages. 

(d) It is the home page of a site. 
(e) None of the above 

 

Q21. A commonly used graphic format for the Web is 
______________________? 

(a) GIF 

(b) BMP 

(c) TXT 
(d) LMP 

(e) TFT 

 

Q22. Which command is used to create a file in LINUX?  
(a) touch 
(b) make 
(c) dir 
(d) mkdir 
(e) None of the above 
 
Q23. What is the technology used to read pencil or pen marks 
on a multiple-choice answer sheet called? 
(a) OMR 
(b) MICR 
(c) OCR 
(d) CPU 
(e) None of the above 
 
Q24. The keyboard shortcut to restart your computer is 
_______? 
(a) Alt + F4   
(b) Ctrl + F4 
(c) Ctrl + Alt + Del  
(d) Alt + Del 
(e) Shift + Del 
 
Q25. Saving is the process_________________? 
(a) To copy document from memory to storage 
(b) To change the content of any document 
(c) To change the display or entire document 
(d) To develop document by entering text using keyboard  
(e) None of the above 
 
Q26. The shortcut key to search for a file or folder is __________?  
(a) F4  
(b) F1  
(c) F2 
(d) F3 
(e) F11 
 
Q27. The computer’s capability of distinguishing spoken 
words is called ________? 
(a) Voice analysis  
(b) Speech acknowledgment  
(c) Voice recognition  
(d) Speech interpretation  
(e) None of the above 
 
Q28. A character is represented in EBCDIC by _____? 
(a) 1 bit 
(b) 4 bits 
(c) 8 bits  
(d) 16 bits 
(e) 64 bits 
 
Q29. One megabyte equals approximately____? 
(a) 1,000 bits  
(b) 1,000 bytes  
(c) 1 million bytes  
(d) 1 million bits  
(e) 2000 bytes 
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Q30. Which of the following is required to create a HTML 
document? 
(a) Telnet 
(b) Browser 
(c) Internet 
(d) Text Editor  
(e) None of the above 
 
Q31. It helps to connect a computer from internet? 
(a) Browser 
(b) Netfit 
(c) Windows-95 
(d) Cable 
(e) None of the above 
 
Q32. ICMP is used for- 
(a) Addressing 
(b) Forwarding 
(c) Multicasting 
(d) Error reporting 
(e) None of the above 
 
 Q73. For document exchange on network which of the 
following is not necessary? 
(a) Floppy 
(b) Telephone line 
(c) Connector 
(d) Satellite 
(e) None of the above 
 
Q34.  A code of webpage has been written by using? 
(a) Hyper text markup language 
(b) 5th generation language 
(c) Winzi p 
(d) Perl 
(e) None of the above 
 
Q35.  When pointer points ………... then pointer appears like a 
hand? 
(a) Grammar error 
(b) Hyperlink 

(c) Screen tip 
(d) Spelling error 
(e) None of the above 
 
Q36.  The first political party of India which created its own 
web-site on internet is? 
(a) Bhartiya Janata Party 
(b) Lok Janshakti Party 
(c) Rastriya Janta Dal 
(d) Samajwadi Party 
 (e) None of the above 
 
Q37.  Which state of India first available the telephone 
directory on internet? 
(a) Sikkim 
(b) Arunachal Pradesh 
(c) Andhra Pradesh 
(d) Bihar 
(e) Uttar Pradesh 
 
Q38. Which of the following cannot be part of an email 
address? 
(a) Period (.) 
(b) At sign (@) 
(c) Space () 
(d) Underscore (_) 
 (e) None of the above 
 
Q39. Who runs internet? 
(a) I & B 
(b) IETF 
(c) Inter NIC 
(d) None of these 
(e) None of the above 
 
Q40. Internet was started in India at? 
(a) 15 August, 1995 
(b) 9August, 1995 
(c) 8August, 1994 
(d) 7 August, 1996 
(e) None of the above 

 

Solutions 
 

S1. Ans.(a) 
Sol. Mainframes are a type of computer that generally are 
known for their large size, amount of storage, processing 
power and high level of reliability. They are primarily used by 
large organizations for mission-critical applications requiring 
high volumes of data processing. 
 
S2. Ans.(b) 
Sol. Zip is a Compressed File. 
 
S3. Ans.(a) 
Sol. The MICR (Magnetic Ink Character Recognition) is a 
device that can recognize human readable characters printed 
on documents such as cheques using a special magnetic ink. 
 

S4. Ans.(d) 

Sol. A cell is the intersection between a row and a column on 

a spreadsheet that starts with cell A1. 

 

S5. Ans.(d) 

Sol. A protocol or communication protocol is a set of rules in 

which computers communicate with each other. 

 

S6. Ans.(a) 

Sol. Star topology is a network topology where each 

individual piece of a network is attached to a central node 

(often called a hub or switch). 
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S7. Ans.(b) 
Sol. key logging is a type of surveillance software that once 
installed on a system, has the capability to record every 
keystroke made on that system. 
 
S8. Ans.(a) 
Sol. To place your image into a live video conference, a 
Webcam is usually used. 
 
S9. Ans.(d) 
Sol. General Purpose computers can perform all those tasks.  
 
S10. Ans.(a) 
Sol. In Word, you can automate frequently used tasks by 
creating and running macros. First, you record the macro. 
S11Ans.(c) 
Sol. IP address is short for Internet Protocol (IP) address. An 
IP address is an identifier for a computer or device on a 
network.  
 
S12. Ans.(d) 
Sol.  The Internet allows you to send electronic mail, view 
web pages and connect to servers all around the world. 
 
S13. Ans.(c) 
Sol. The Hypertext Transfer Protocol (HTTP) is an application 
protocol for distributed, collaborative, hypermedia 
information systems. HTTP is the foundation of data 
communication for the World Wide Web. 
 
S14. Ans.(c)  
Sol. Paint, PowerPoint and Word are application software. 
Microsoft Edge is the new browser built for Windows 10. 
Edge is faster, safer and gives you longer battery life. 
 
S15. Ans.(d) 
Sol. A protocol identifier, www and the unique registered 
domain name are requisite for a URL 
 
S16. Ans.(c)  
Sol. you can organize your bookmark into folders by topic or 
task etc. 
 

 

S17. Ans.(a) 
Sol. NCSA Mosaic, or simply Mosaic, is a discontinued early 
web browser. It has been credited with popularizing the 
World Wide Web. It was the first graphical web browser. 
 
S18. Ans.(c) 
Sol. Generally to copy data from a remote compute/internet 
to a local computer is called downloading. 
 
S19. Ans.(b) 
Sol. Ctrl + W can be used to close a tab in a web browser. 
 
S20. Ans.(a) 
Sol. A hyperlink, or simply a link, is a reference to data that 
the reader can directly follow either by clicking, tapping, or 
hovering. Hyperlinks are found in nearly all Web pages, 
allowing users to click their way from page to page. 
 
S21. Ans.(a) 
Sol. The Graphics Interchange Format (GIF) is used to save 
simple Web graphics having limited colors. This image format 
is usually used for Web buttons, charts and text headings.  
 
S22. Ans.(a) 
Sol. The touch command is used to create a file. It can be 
anything, from an empty txt file to an empty zip file. 
 
S23. Ans.(a) 
Sol. Optical Mark Recognition What is the technology used to 
read pencil or pen marks on a multiple-choice answer sheet. 
 
S24. Ans.(c) 
Sol.  Ctrl + Alt + Del is used to restart computer. 
printers. 
 
S25. Ans.(a) 
Sol. Saving is the process to copy document from memory to 
storage. 
 
S26. Ans.(d) 
Sol. The shortcut key to search for a file or folder is F3.  
 
S27. Ans.(c) 
Sol. Voice or speech recognition is the ability of a machine or 
program to receive and interpret dictation, or to understand 
and carry out spoken commands. 
 
S28. Ans.(c) 
Sol. In an EBCDIC file, each alphabetic or numeric character is 
represented with an 8-bit binary number (a string of eight 0's 
or 1's). 256 possible characters (letters of the alphabet, 
numerals, and special characters) are defined. 
 
S29. Ans.(c)  
Sol. 1 MB= 1 million bytes. 
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S30. Ans.(d) 

Sol.  HTML document is created by using a basic text editor 

such as Notepad on Windows, TextEdit on MacOS, gedit on 

Ubuntu Linux. However, you should choose an editor that 

allows you to save a page in the UTF-8 encoding. 

 

S31. Ans.(a) 

Sol. Browser helps to connect a computer from internet. 

 

S32. Ans.(d) 

Sol. Internet Control Message Protocol (ICMP) is used to send 

control messages to network devices and hosts. Routers and 

other network devices monitor the operation of the network. 

When an error occurs, these devices can send a message using 

ICMP. 

 

S33. Ans.(a) 

Sol. For document exchange on network Floppy is not 

necessary. 

 

S34. Ans.(a) 

Sol. A code of webpage has been written by using Hyper text 

markup language. 

 

S35. Ans.(b) 

Sol. When pointer points Hyperlink then pointer appears like 

a hand. 

 

S36. Ans.(a) 

Sol. The first political party of India which created its own 

web-site on internet is Bhartiya Janata Party. 
 

S37. Ans.(a) 
Sol. Sikkim state of India first available the telephone 
directory on internet. 
 
S38. Ans.(c) 
Sol. Space () cannot be part of an email address. 
 
S39. Ans.(d) 
Sol. No one person, company, organization or government 
runs the Internet. It is a globally distributed network 
comprising many voluntarily interconnected autonomous 
networks. It operates without a central governing body with 
each constituent network setting and enforcing its own 
policies. 
 
S40. Ans.(a) 
Sol. Internet got introduced in India in 1986 but it took a 
decade to make it available for the public. VSNL first launched 
the internet in India on August 15, 1995. 
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1. Word processing, spreadsheet, and photo-editing are 

examples of which type of software? 
 (a) Application software 
 (b) System software 
 (c) Operating system software 
 (d) Platform software 
 (e) None of these 

 

2. Which are specially designed computer chips that 
reside inside other devices, such as your car or your 
electronic thermostat? 

 (a) Servers 
 (b) Embedded computers 
 (c) Robotic computers 
 (d) Mainframes 
 (e) None of these 

 

3. If you wished to limit what you would see on an Excel 
worksheet, what data function would you use? 

 (a) Sort  
 (b) Filter 
 (c) Conditional format  
 (d) Data analysis 
 (e) None of these 

 

4. Which of the following number system has base-16? 
 (a) Unary number system 
 (b) Binary number system 
 (c) Octal number system  
 (d) Hexadecimal Number System 
 (e) None of the above 

 

5. What is the full form of SMPS? 
 (a) Secure Make Potential Supply 
 (b) Standard Made Power Supply 
 (c) Switched-Mode Power Supply 
 (d) Simplex Mode Power Supply 
 (e) None of these 

 

6. Which of the following Program are often delivered to 
a PC through an email attachment and are often 
designed to do harm? 

 (a) Spam 
 (b) Portals 
 (c) Viruses 
 (d) Ransomware 
 (e) None of these 

 

7. Which type of memory holds only that program and 
data that CPU is presently processing? 

 (a) ASCII 
 (b) CMOS 
 (c) RAM 
 (d) ROM 
 (e) None of these 

 

8. Softcopy is the intangible output, so then what is 
hardcopy? 

 (a) The physical parts of the computer 
 (b) The printed parts of the computer 
 (c) The printed output 
 (d) The physical output devices 
 (e) None of the above 

 

9. One nibble is equal to how many bits? 
 (a) 4 
 (b) 8 
 (c) 2 
 (d) 16 
 (e) None of these 

 

10. What is a Firewall in Computer Network?  
 (a) The physical boundary of Network  
 (b) An operating System of Computer Network  
 (c) A system designed to prevent unauthorized access   
 (d) A web browsing Software  
 (e) None of these 

 

11. What is the main function of the ALU? 
 (a) Store data and information for future use 
 (b) Monitor all computer activities 
 (c) Perform arithmetic and logical operations 
 (d) Control computer output, such as printing 
 (e) None of the above 

 

12. Which one of the following is internet Standard 
Protocol?   

 (a) TML 
 (b) COBOL 
 (c) JAVA 
 (d) C++ 
 (e) TCP/IP 

 

13. Bridge work at which layer of OSI Model? 
 (a) Network layer 
 (b) Data link layer 
 (c) Physical layer 
 (d) Application layer  
 (e) Transport layer 

 

14. A _________ is used to direct and dispatch data packets 
between different networks. 

 (a) Connection 
 (b) Bridge 
 (c) Gateway 
 (d) Hub 
 (e) Router 

 

15. Who is the creator of PASCAL language? 
 (a) Dennis Ritchie 
 (b) Brendan Eich 
 (c) James Gosling 
 (d) Niklaus Wirth 
 (e) None of these 
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16. Which of the following is the shortcut key for hides the 
selected rows? 

 (a) Ctrl+D 
 (b) Ctrl+H 
 (c) Ctrl+9 
 (d) Ctrl+10 
 (e) None of these 

 

17. What does the .org domain represents? 
 (a) Organization domain 
 (b) Network domain 
 (c) Government domain 
 (d) Education domain 
 (e) None of these 

 

18. Which of the following is a Web browser? 
 (a) Paint  
 (b) PowerPoint  
 (c) Edge 
 (d) Word  
 (e) All are Web browsers 

 

19. Whihc of the following is used in Second-generation of 
computers? 

 (a) Vacuum tube based 
 (b) Integrated circuit based 
 (c) VLSI 
 (d) Transistor  
 (e) None of these 

 

20. Integrated Circuit (IC) chips used in computers are 
made with ____. 

 (a) Silicon 
 (b) Copper 
 (c) Aluminium 
 (d) Gold 
 (e) None of these 

 

21. If you wished to limit what you would see on an Excel 
worksheet, what data function would you use? 

 (a) Data analysis 
 (b) Sort 
 (c) Filter 
 (d) Conditional format 
 (e) None of these 

 

22. Which of the memories has the shortest access time? 
 (a) Cache memory  
 (b) Magnetic bubble memory  
 (c) Magnetic core memory  
 (d) RAM  
 (e) None of these  

 

23. While browsing the internet, which of the following 
key is used for full screen view? 

 (a) F3 
 (b) F5 
 (c) F11 
 (d) F9 
 (e) F1 

 

24. What is the base of hexadecimal number system? 
 (a) 2 
 (b) 8 
 (c) 16 
 (d) 10 
 (e) None of these 

 

25. What is the full form of SIM? 
 (a) Subscriber Idol Mechanism 
 (b) Semi Idol Module 
 (c) Substitute Identity Module 
 (d) Subscriber Identity Module 
 (e) None of these 

 

26. Harmful programs used to disrupt computer operation, 
gather sensitive information, or gain access to private 
computer systems are commonly referred to as: 

 (a) Adware 
 (b) Malware  
 (c) Computer viruses 
 (d) Spyware 
 (e) None of these 

 

27. A repair for a known software bug, usually available at 
no charge on the internet, is called a(n) ________. 

 (a) Version 
 (b) Patch 
 (c) Tutorial 
 (d) FAQ 
 (e) None of these 

 

27. A _________ typically connects personal computers 
within a very limited geographical area, usually within 
a single building. 

 (a) LAN  
 (b) FAN 
 (c) TAN  
 (d) WAN 
 (e) VPN 

 

28. Which of the following memories not needs refresh? 
 (a) SRAM                         
 (b) DRAM                
 (c) ROM 
 (d) All of above             
 (e) None of these 
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29. What database key uniquely identifies a record within 
a table? 

 (a) Primary key                      
 (b) Foreign key 
 (c) Secondary key                 
 (d) Relational key 
 (e) None of these 

 

30. A_________ is a built in mathematical formula included in 
excel. 

 (a) Function 
 (b) Cell 
 (c) Formula 
 (d)Range 
 (e) None of these 

 

31. Which of the following Excel features allows you to 
select/highlight all cells that are formulas? 

 (a) Find 
 (b) Replace  
 (c) Go To 
 (d) Go To Special 
 (e) None of these 

 

32. What is the maximum Zoom Percent allowed in 
Microsoft PowerPoint 2007? 

 (a) 100% 
 (b) 200% 
 (c) 300% 
 (d) 400% 
 (e) None of these 

 

33. In MS Word 2010 the feature for Word Count is 
available in Proofing under which of the following tab? 

 (a) Home 
 (b) Review 
 (c) Insert 
 (d) View 
 (e) References 

 

34. A computer cannot ‘boot’ if it does not have 
the_____________. 

 (a) Compiler 
 (b) Loader 
 (c) Operating system 
 (d) Assembler 
 (e) None of these 

 

35. ISDN stands for_________. 
 (a) Integrated Services Digital Network 
 (b) Integrated Services Data Network 
 (c) Integrated Security Digital Network 
 (d) Integrated Security Data Network 
 (e) None of these 
 

36. What type of resource is most likely to be a shared 
common resource in a computer network? 

 (a)Keyboards  
 (b) Speakers  
 (c) Floppy disk drives  
 (d) Printers   
 (e) None of these  

 

37. The most widely used type of database management 
system is the: 

 (a) Flat database 
 (b) Network database 
 (c) Relational database  
 (d) Hierarchical database 
 (e) None of the above 

 

38. Managers use sophisticated tool to combat 
cyberslacking, especially involving the internet. Such 
tools include ____ 

 (a) Web filters 
 (b) Surveillance Software 
 (c) Proxy Server 
 (d) Packet sniffer 
 (e) All of the above 

 

39. The altering of data so that it is not usable unless the 
changes are undone is _______. 

 (a) Biometrics 
 (b) Compression 
 (c) Encryption 
 (d) Ergonomics 
 (e) Spamming 

 

40. Which of the following is used for closing a tab on a 
browser? 

 (a) Ctrl + T 
 (b) Ctrl + W 
 (c) Ctrl + A 
 (d) Ctrl + Y 
 (e) Alt + F4 
 

 

 

https://www.adda247.com/activity/DAILY_QUIZZES
https://www.adda247.com/activity/PYP
https://www.adda247.com/activity/MAGAZINES
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


IBPS RRB Computer Capsule 2025 (PO and Clerk) 

 

 

51 
 

                                    

Solutions 
 

1. (a); Application software is a term which is used for 

software created for a specific purpose. It is 

generally a program or collection of programs 

used by end users. 

 

2. (b); An embedded system is some combination of 

computer hardware and software, either fixed in 

capability or programmable, that is designed for a 

specific function or for specific functions within a 

larger system. 

 

3. (b); Filter is used in your Excel data, if you only want 

to display records that meet certain criteria. 

 

4. (d); Hexadecimal number system has base 16, Octal- 

Base 8, Binary- Base 2 and Decimal- Base 10 

 

5. (c); SMPS stands for Switched-Mode Power Supply. It 

is an electronic power supply that uses a 

switching regulator to convert electrical power 

efficiently. It is also known as Switching Mode 

Power Supply. It is power supply unit (PSU) 

generally used in computers to convert the 

voltage into the computer acceptable range. 

 

6. (c); Computer virus are often delivered to a PC 

through an email attachment and are often 

designed to do harm. A computer virus is a 

malicious program that normally self-replicates 

by copying itself to another computer program. In 

basic terms, a computer virus spreads itself 

through executable code or documents. 

 

7. (c); RAM is volatile memory used to hold instructions 

and data of currently running programs. It loses 

integrity after loss of power. RAM memory 

modules are installed into slots on the computer 

motherboard. 

 

8. (c); A hardcopy is a printed copy of information from 

a computer. 

 

9. (a); One nibble is equal to 4 bits. 

 

10. (c); Firewall in Computer Network is a system 

designed to prevent unauthorized access. 

 

11. (c); ALU is an arithmetic-logic unit is the part of a 

central processing unit that carries out arithmetic 

and logic operations on the operands in computer 

instruction words. 

 

12. (e); TCP/IP, which stands for Transmission control 

Protocol/Internet Protocol, is an industry-

standard protocol suite for WANs. On the other 

hand, HTML, COBOL, JAVA and C++ are computer 

programming languages. 

 

13. (b); Bridges operate at the Data-Link Layer of the OSI 

Model. They can distinguish between local and 

remote data, so data traveling from one 

workstation to another in the same segment 

doesn't have to cross the bridge. Bridges operate 

on MAC-Layer addresses. 

 

14. (e);  A router is used to route data packets between 

different networks. It reads the information in 

each packet to tell where it is going. If it is 

destined for an immediate network it has access 

to, it will strip the outer packet (IP packet for 

example), readdress the packet to the proper 

Ethernet address, and transmit it on that network. 

 

15. (d); Pascal is an imperative and procedural 

programming language developed by Niklaus 

Wirth.  

 

16. (c); 

 

17. (a); The .org top-level domain stands for 

“organization” and is primarily used for nonprofit 

websites such as charities, NGOs, open source 

projects. 

 

18. (c); Paint, PowerPoint and Word are application 

software. Microsoft Edge is the new browser built 

for Windows 10. Edge is faster, safer and gives 

you longer battery life. 

 

19. (d); 

 

20. (a); 

 

21. (c); 

 

22. (a); Cache memory is a small-sized type of volatile 

computer memory that provides high-speed data 

access to a processor and stores frequently used 

computer programs, applications and data. Cache 

is the fastest memory in a computer. 

 

23. (c); 

 

24. (c); 

 

25. (d); 
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26. (b); 

 

27. (b); A patch is a piece of software designed to update 

a computer program or its supporting data to fix 

or improve it. 

 

27. (a); A local-area network (LAN) is a computer 

network that spans a relatively small area. Most 

often, a LAN is confined to a single room, building 

or group of buildings. 

 

28. (a); Static Random Access Memory (Static RAM or 

SRAM) is a type of RAM that holds data in a static 

form, that is, as long as the memory has power. 

Unlike dynamic RAM, it does not need to be 

refreshed. 

 

29. (a); Primary key is used to uniquely identify a record 

within a table. 

 

30. (a); 

 

31. (d); 

 

32. (d); 

 

33. (b); Word Count is available in Proofing under Review 

tab. 
 

34. (c); An Operating System (OS) is an interface between 

a computer user and computer hardware. An 

operating system is a software which performs all 

the basic tasks like file management, memory 

management, process management, handling 

input and output, and controlling peripheral 

devices such as disk drives and printers. 

 

35. (a); ISDN stands for Integrated Services Digital 

Network. 
 

36. (d); Printer is a shared common resource in a 

computer network.  
 

37. (c); A relational database management system 

(RDBMS) is a database management system 

(DBMS) that is based on the relational model as 

invented by E. F. Codd. Relational databases have 

often replaced legacy hierarchical databases and 

network databases because they are easier to 

understand and use. 

 

38. (e); Cyberslacking refers to an employee’s use of work 

computers and other resources during work 

hours for non-work-related purposes. When an 

employee is cyberslacking, they will be using the 

employer's devices, internet connection, or other 

resources for personal affairs and even 

entertainment.  

 

39. (c); Encryption is the most effective way to achieve 

data security. To read an encrypted file, you must 

have access to a secret key or password that 

enables you to decrypt it. Unencrypted data is 

called plain text; encrypted data is referred to as 

cipher text. 

 

40. (b); Ctrl+ W closes a tab on a browser and Alt + F4 

closes the whole application program. 
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1. Which of the following operating system developed by Apple? 

 (a) Windows 10 

 (b) Android 

 (c) Windows Vista 
 (d) macOS 

 (e) None of these 

 

2. What is the full form of DBMS? 

 (a) Database Maintain System 
 (b) Desktop Marketing System 

 (c) Database Management System 

 (d) Durable Management System 

 (e) None of these 

 

3. What is the base of Octal Number system? 
 (a) 8 

 (b) 16 

 (c) 10 

 (d) 2 
 (e) None of these 

 

4. Which of the following is used in first generation computer? 

 (a) Integrated Circuit 

 (b) Vacuum Tube 

 (c) Transistor 
 (d) VLSI circuits 

 (e) None of these 

 

5. PROM Stands for_______. 

 (a) Programmable random-on memory 
 (b) Picture random memory 

 (c) Process read-only memory 

 (d) Programmable read-only memory 

 (e) None of these 

 

6. COBOL is used for which of the following purpose? 
 (a) Scientific calculation 

 (b) Business and Finance 

 (c) Application development 

 (d) Network Security 
 (e) None of these 

 

7. Which key is used to delete characters to the left of the 

cursor? 

 (a) Tab 
 (b) Page Down 

 (c) Delete 

 (d) Backspace 

 (e) None of these 

 

8. How many MB is equal to 1 GB? 
 (a) 10MB 

 (b) 100000MB 

 (c) 20000 MB 

 (d) 1024 MB 
 (e) None of these 

 

9. Convert Binary number (111001)2 to decimal number________. 
 (a) (38)10 
 (b) (57)10 
 (c) (55)10 
 (d) (47)10 
 (e) None of these 

 

10. ENIAC belongs to which computer generation? 
 (a) Second 
 (b) First 
 (c) Third 
 (d) Fourth 
 (e) None of these 

 

11. MS Access is a _______? 
 (a) System Software 
 (b) Browser 
 (c) Database  
 (d) Pointing Device 
 (e) None of these 

 

12. Which of the following is the most common tool used to 
restrict access to a computer system? 

 (a) User logins 
 (b) Computer keys 
 (c) Access-control Software 
 (d) Passwords  
 (e) None of these 

 

13. Photo-editing, spreadsheet and word processing were the 
examples of? 

 (a) Application software. 
 (b) System software. 
 (c) Operating system software. 
 (d) Platform software.  
 (e) None of these 

 

14. Which of the following shortcut key is used to close document 
in MS Word? 

 (a)Ctrl+C 
 (b)Alt+W 
 (c) Shift+C 
 (d) Ctrl+W 
 (e) None of these 
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15. What is the base of Hexadecimal number system? 
 (a) 2 
 (b) 16 
 (c) 8 
 (d) 10 
 (e) None of these 

 

16. In second generation, which type of memory was used to 
store data?  

 (a) Paper tapes  
 (b) Magnetic drum  
 (c) Magnetic core  
 (d) Magnetic tape  
 (e) None of these 

 

17. Which among the following key can be used as a shortcut to 
rename a folder in Microsoft Windows 8 and higher versions? 

 (a) F2 
 (b) F4 
 (c) F6 
 (d) F9 
 (e) F11 

 

18. In order to move from one worksheet to another in MS-Excel 
workbook. One should click ___________. 

 (a) active cell  
 (b) scroll bar 
 (c) sheet tab  
 (d) tab button 
 (e) None of these 

 

19. Which shortcut key is used to check spelling and grammar in 
MS-Word? 

 (a) F1  
 (b) F2 
 (c) F7  
 (d) F9 
 (e) F10 

 

20. Which is not a storage device? 
 (a) Printer  
 (b) CD 
 (c) Hard disk  
 (d) Floppy Disk 
 (e) DVD 

 

21. An image editing software in which we can draw and edit 
images is? 

 (a) PageMaker  
 (b) MS-Paint 
 (c) Coral Draw  
 (d) Photo Image 
 (e) Front page 

 

22. Which of the following can be used to select the entire 
document? 

 (a) Ctrl+A  
 (b) Alt+F5 
 (c) Shift+A  
 (d) Ctrl+K 
 (e) Ctrl+H 

 

23. Which of the following shortcut key is used to minimize all 
open windows and display the desktop? 

 (a) Windows logo+D 
 (b) Alt+Shift+C 
 (c) Ctrl+fn 
 (d) Tab+Shift+C 
 (e) None of these 

 

24. Which of the following kind of devices allows the user to add 
components and capabilities to a computer system? 

 (a) System boards  
 (b) Storage devices 
 (c) Input devices 
 (d) Output devices 
 (e) Expansion slots 

 

25. Transformation of input into output is performed by: 
 (a) Peripherals  
 (b) Memory  
 (c) Storage  
 (d) ALU 
 (e) CPU 

 

26. Which of the following device enabling data transfer between 
two different networks? 

 (a) Plotter  
 (b) Joystick 
 (c) Gateway  
 (d) Path 
 (e) None of these 
 
 

27. Among the following which is the popular DOS based 
spreadsheet package? 

 (a) Multiplan 
 (b) Word 
 (c) Smart cell 
 (d) Lotus 1-2-3 
 (e) Excel 

 

28. Which of the following is a windows utility program that 
locates and eliminates unnecessary fragments and rearranges 
filed and unused disk space to optimize operations? 

 (a) Backup  
 (b) Disk cleanup  
 (c) Disk defragmenter 
 (d) Restore  
 (e) None of these  

 

29. Which among the following key combination can be used to 
search in Windows Explorer? 

 (a) Ctrl+F 
 (b) Ctrl+S 
 (c) Ctrl+G 
 (d) Alt+S 
 (e) Alt+P 

 

30. What is the technology used to read pencil or pen marks on a 
multiple-choice answer sheet called? 

 (a) OMR 
 (b) MICR 
 (c) OCR 
 (d) CPU 
 (e) FTP 
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31. Which among the following is a type of error that a compiler 
can check? 

 (a) Syntax Error 
 (b) Power Failure 
 (c) Network Failure 
 (d) All of the above 
 (e) None of the above 

 

32. A special, high-speed storage area within the CPU in which all 
data must be represented before it can be processed is called 
_____. 

 (a) BIOS 
 (b) Cache 
 (c) RAM 
 (d) Register 
 (e) None of these 

 

33. In Power Point, the Header & Footer button can be found on 
the Insert tab in what group? 

 (a) Illustrations group 
 (b) Object group 
 (c) Text group 
 (d) Tables group 
 (e) None of these 

 

34. Which of the following is generally used for selecting or 
highlighting?  

 (a) Icon  
 (b) Keyboard  
 (c) Mouse  
 (d) Floppy Disk  
 (e) None of these  

 

35. __________ ensures secure transfer of data over an unsecured 
network, such as the Internet. 

 (a) Antivirus 
 (b) Hacking 
 (c) Cracking  
 (d) Spoofing 
 (e) Cryptography 

 

36. The ability of an operating system to run more than one 
application at a time is called _________. 

 (a) Multi-tasking  
 (b) Object-oriented programming  
 (c) Multi-user computing  
 (d) Real-Time 
 (e) None of the above  
 

37. The process of checking all the peripheral units by the OS 
during the time of booting is known as_____ 

 (a) BIOS 
 (b) POST 
 (c) BUS 
 (d) Chkdsk 
 (e) None of these 

 

38. A handheld device that allows you to control your computer 
without typing instructions from a keyboard is known 
as_______.  

 (a) Tablet  
 (b) PDA 
 (c) Mouse  
 (d) Mike  
 (e) None of these  

 

39. The feature in database language that allows us to access 
certain records in database is called __________. 

 (a) Query 
 (b) Forms 
 (c) Reports 
 (d) Tables 
 (e) Node  

 

40. When you save a Microsoft Access project, what file format do 
you use? 

 (a) .adp  
 (b) .Xml  
 (c) .mbd  
 (d) All of the above  
 (e) None of the above 

 
Solutions 

 

1. (d); 

 

2. (c); A database management system (DBMS) is system 
software for creating and managing databases. A DBMS 
makes it possible for end users to create, read, update 
and delete data in a database. 

 

3. (a); 

 

4. (b); 

 

5. (d); PROM or programmable ROM (programmable read-only 
memory) is a computer memory chip that can be 
programmed once after it is created. Once the PROM is 
programmed, the information written is permanent and 
cannot be erased or deleted. 

 

6. (b); COBOL (Common Business-Oriented Language) is a high-
level programming language for business applications. 
COBOL was designed for business computer programs in 

industries such as finance and human resources. 

 

7. (d); 

 

8. (d); 

 

9. (b); (111001)2 = 1⋅25+1⋅24+1⋅23+0⋅22+0⋅21+1⋅20 = (57)10 

 

10. (b); 

 

11. (c); 

 

12. (d); 

 

13. (a); 

 

14. (d); 

 

15. (b); 

 

16. (c); In second generation, magnetic cores were used as 
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primary memory and magnetic tape and magnetic disks 
as secondary storage devices.  

 

17. (a); 

 

18. (c); 

 

19. (c); 

 

20. (a); 

 

21. (c); 

 

22. (a); 

 

23. (a); 

 

24. (e); Expansion slots allows user to add devices. 

 

25. (e); the CPU is the Central Processing Unit of the computer. A 
computer's CPU handles all instructions it receives from 
hardware and software running on the computer. 

 

26. (c); A gateway is a network node that connects two networks 
using different protocols together. 

 

27. (d); Lotus 1-2-3, developed by Lotus Development 
Corporation, is the most popular spreadsheet package 
among DOS users. 

 

28. (c); Disk Defragmenter is a utility in Microsoft Windows 
designed to increase access speed by rearranging files 
stored on a disk to occupy contiguous storage locations, a 
technique called defragmentation. 

 

29. (a); Ctrl+F is the short cut key combination that can be used 
to search in Windows Explorer. 

 

30. (a); Optical Mark Recognition What is the technology used to 
read pencil or pen marks on a multiple-choice answer 
sheet. 

 

31. (a); Syntax Errors - These are invalid code which the compiler 
doesn't understand. The compiler will detect them as it 
can't compile them. 

 

32. (d); Register is a special high-speed storage area within the 
CPU where all data must be represented before it can be 
processed. 

 

33. (c); 

 

34. (c); Generally, we can use mouse for selecting or highlighting 
object.  

 

35. (e); In cryptography, data are sent in such a way that they 
look completely different from the original data. Thus, 
cryptography ensures secure transfer of data over an 
unsecured network. 

 

36. (a); The ability of an operating system to run more than one 
application at a time is called Multi-tasking. 

 

37. (b); POST (Power on Self-Test) is a test the computer must 
complete to verify all hardware is working properly 
before starting the remainder of the boot process. 

 

38. (c); A mouse is a handheld device that allows you to control 
your computer without typing the instructions from the 
keyboard. By using a mouse, you can select icons, open 
programs, and select, commands, present in a program by 
moving the pointer.  

 

39. (a); Query allows us to access certain records in database. 

 

40. (a); An Access project is an Access file (.adp) that provides a 
direct, efficient connection to a Microsoft SQL Server 
database through the OLE DB component architecture. 
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1. Which of the following topologies has the highest 
reliability? 

 (a) Star topology 
 (b) Bus topology 
 (c) Ring topology 
 (d) Mesh topology 
 (e) None of these 
2. Which among the following term is used for: 

Unauthorized copying of software to be used for personal 
gain instead of personal backups?  

 (a) program thievery 
 (b) data snatching 
 (c) software piracy 
 (d) program looting 
 (e) data looting 
3. EDBIC code can support how many different 

representation of characters? 
 (a) 256 
 (b) 149 
 (c) 1024 
 (d) 64 
 (e) 16 
4. The main webpage of a website is also known as ­ 
 (a) Contents Page 
 (b) Home Page 
 (c) Introduction Page 
 (d) First Page 
 (e) Icebreaker Page 
5. What is a hyperlink? 
 (a) It is a text or image that you can click on to jump to a 

new document/page. 
 (b) It is an input type for multimedia files. 
 (c) It is a collection or directory of web pages. 
 (d) It is the home page of a site. 
 (e) None of the above 
6. What is a technique used to gain unauthorized access to 

computers, whereby the intruder sends messages to a 
computer with an address indicating that the message is 
coming from a trusted host? 

 (a) Identity Theft 
 (b) Forging 
 (c) IP Spoofing  
 (d) Pharming 
 (e) Phishing 
7. Portrait and Landscape are: 
 (a) Page Orientation 
 (b) page layout 
 (c) page size 
 (d) page view 
 (e) none of the above 
8. Internet access by transmitting digital data over the wires 

of a local telephone network is provided by:  
 (a) leased line 
 (b) digital subscriber line 
 (c) digital signal line 
 (d) MODEM 
 (e) None of the above 

9. Which of the following network devices is also called a 
concentrator? 

 (a) Switch 
 (b) Router 
 (c) Brouter 
 (d) Repeater 
 (e) Hub 
10. What type of web technology creates an online 

community where people can make statements and 
others can read and respond to those statements? 

 (a) I-Journal     
 (b) Podcast 
 (c) ASP     
 (d) Blog 
 (e) None of the above 
11. What is the full form of EDI in computer? 
 (a) Electronic Data Image 
 (b) E-mail Data Interchange 
 (c) Electronic Data Interchange 
 (d) Electronic digital Interchange 
 (e) None of these 
12. What is the use of "," symbol in Ms EXCEL? 
 (a) allows you to make one reference for multiple cells 

located between 2 cells 
 (b) is used to separate arguments in Excel spreadsheet 

formulas. 
 (c) it is an intersection operator  
 (d) For Sum of two cells 
 (e) None of these 
13. Which of the following shortcut key use to close the 

current window? 
 (a) Alt+F7 
 (b) Shift+F4 
 (c) CRLT+F6 
 (d) Alt+F4 
 (e)None of these 
14. What are programs such as Microsoft Edge that serve as 

navigable windows into the Web called as? 
 (a) Hypertext  
 (b) Web browsers 
 (c) Internet  
 (d) Networks 
 (e) Windows Navigator 
15. Which among the following is a self-contained step-by- 

step set of operations to be performed? 
 (a) System Software  
 (b) Algorithm 
 (c) Network topology  
 (d) Application software 
 (e) Utility software 
16. which of the following is an intersection of a row and 

column in a spreadsheet? 
 (a) Formula 
 (b) Worksheet 
 (c) Address 
 (d) Cell 
 (e) None of these 

Memory Based Questions IBPS RRB PO/Clerk 2018 
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17. which of the following is a set of rules computers use to 
talk to each other? 

 (a) Syntax 
 (b) HTML 
 (c) DOS command 
 (d) Protocol 
 (e) None of these 
18. Which of the following topology have a central controller 

or hub? 
 (a) Star 
 (b) Mesh 
 (c) Ring 
 (d) Bus 
 (e) None of these 
19. Which shortcut key is used to create a new folder in MS 

Windows? 
 (a) Right Click Button+W+Enter 
 (b) Ctrl+W+Shift 
 (c) Right Click Button+F+Enter 
 (d) Right Click Button+Q+Enter 
 (e) Ctrl+Shift+N 
20. The first computers were programmed using which of the 

following language? 
 (a) Assembly language  
 (b) Machine language  
 (c) Source code  
 (d) Object code  
 (e) None of the above 
21. Which of the following is not example of Utility Software? 
 (a) Backup software 
 (b) Antivirus software 
 (c) Disk tools 
 (d) Media Players 
 (e) All of the above are examples of Utility Software 
22. Copying a process from memory to disk to allow space for 

other processes is called __________. 
 (a) Swapping 
 (b) Deadlock 
 (c) Demand Paging 
 (d) Page Fault 
 (e) Cloud Computing 
 

 

23. Which of the following is a translator program used for 
assembly language?  

 (a) Complier  
 (b) Interpreter  
 (c) Translation  
 (d) Translator  
 (e) Assembler  
24. What is the technical term for the devices connected in a 

network?  
 (a) Hubs  
 (b) Nodes  
 (c) Sections  
 (d) Attachment units  
 (e) Access points  
25. Which of the following is the communication protocol that 

sets the standard used by almost every computer that 
accesses web based information?  

 (a) XML 
 (b) DML 
 (c) HTTP 
 (d) HTML 
 (e) RIP  
26. What is the attempt to acquire sensitive information such 

as usernames, passwords, and credit card details (and 
sometimes, indirectly, money) by masquerading as a 
trustworthy entity in an electronic communication? 

 (a) Phishing 
 (b) Spoofing 
 (c) Identity theft 
 (d) Authentication 
 (e) Spamming 
27. Communication channel is shared by all the machines on 

the network in: 
 (a) broadcast network 
 (b) unicast network 
 (c) multicast network 
 (d) Internet Protocol Address 
 (e) none of the above 
28. A(n) __________ converts all the source code into machine 

code, creating an executable file. 
 (a) linker 
 (b) assembler 
 (c) compiler 
 (d) interpreter 
 (e) None of these 
29. What is the term that refers to an ad hidden inside 

software that you downloaded from an internet site? 
 (a) Spam 
 (b) Cookie 
 (c) Phish 
 (d) Adware 
 (e) None of these 
30. In PowerPoint, what is the function of Alt+N in navigating 

the ribbon with only the keyboard? 
 (a) Open the Transitions tab 
 (b) Open the Home tab 
 (c) Open the Insert tab 
 (d) Open the Review tab 
 (e) Open the Tell me box 
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31. Commands at the top of a screen such as File-Edit, Format 
and Tools to operate and change things are incorporated 
in __________________. 

 (a) Menu bar 
 (b) Tool bar 
 (c) User friendly 
 (d) Word processor 
 (e) None of these 
32. Specialised program(s) designed to allow particular input 

or output device(s) to communication with the rest of the 
computer system is called _______. 

 (a) Computer  
 (b) Device drivers  
 (c) Interpreters  
 (d) Operating system  
 (e) None of these  
33. UDP and TCP are categorized under the ___layer of the OSI 

model. 
 (a) Data link 
 (b) Application 
 (c) Network 
 (d) Transport 
 (e) Session 
34. Twisted pair wires are commonly used in? 
 (a) Telephones networks 
 (b) Cable TV Networks 
 (c) Computer networks 
 (d) Both (a) and (b) 
 (e) None of the above 
35. Timing and control unit is a part of a(n)______. 
 (a) ALU  
 (b) Processor  
 (c) Memory  
 (d) CMOS  
 (e) BIOS 
36. A specialized network device that determines the next 

network point to which it can forward a data packet 
towards the destination of the packet is commonly known 
as_________. 

 (a) bridge  
 (b) router  
 (c) switch  
 (d) hub  
 (e) repeater 

37. A database that spreads information across different 
tables while maintaining links between them is referred 
to as________. 

 (a) Relational database  
 (b) Rotational database  
 (c) Database connection 
 (d) Tabular database  
 (e) None of these 
38. What does SNMP stand for? 
 (a) Simple Network Mail Protocol 
 (b) Single Network Mail Protocol 
 (c) Single Network Message Protocol 
 (d) Simple Network Management Protocol 
 (e) None of these 
39. What is the common name given to a program written in 

any one of the high-level languages? 
 (a) System program  
 (b) Compiler program  
 (c) Object program 
 (d) Source program  
 (e) Data program 
40. For predicting the weather which of the following is the 

best solution? 
 (a) thin clients  
 (b) servers  
 (c) supercomputer 
 (d) workstations 
 (e) mini computer 

 

 
 

Solutions 

 
1. (d); In the mesh topology, each computer is connected to 

the other with a separate physical link in a network. It 

is most reliable topology as the network does not get 

down in case one of the nodes is failed. 

2. (c); Software piracy is the illegal copying, distribution, or 

use of software. 

3. (a); EBCDIC stands for Extended Binary Coded Decimal 

Interchange Code. EBCDIC is a 8-Bit code with 256 

different representations of characters. It is mainly 

used in mainframe computers. 

4. (b); A home page is the main page or the introductory 
page of a website, typically serving as a table of 
contents for the site. 

5. (a); A hyperlink, or simply a link, is a reference to data 
that the reader can directly follow either by clicking, 
tapping, or hovering. Hyperlinks are found in nearly 
all Web pages, allowing users to click their way from 
page to page. 

6. (c); Spoofing: It is a type of scam where an intruder 
attempts to gain unauthorized access to a user’s 
system or information by pretending to be the user. 
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The main purpose is to trick the user into releasing 
sensitive information. 

7. (a); Page orientation is the way in which a rectangular 
page is oriented for normal viewing. 

8. (b); Digital subscriber line (DSL or digital subscriber 
loop) is a family of technologies that are used to 
transmit digital data over telephone lines. 

9. (e); A hub contains several ports for connecting multiple 
computers to form a small network. A simple hub is 
also called a concentrator. 

10. (d); A blog is a regularly updated website or web page, 
typically one run by an individual or small group, that 
is written in an informal or conversational style. 

11. (c); EDI (Electronic Data Interchange) is the transfer of 
data from one computer system to another by 
standardized message formatting, without the need 
for human intervention. EDI permits multiple 
companies -- possibly in different countries -- to 
exchange documents electronically. 

12. (b); 
13. (d); 
14. (b); 
15. (b); 
16. (d); A cell is the intersection between a row and a column 

on a spreadsheet that starts with cell A1. 
17. (d); A protocol or communication protocol is a set of rules 

in which computers communicate with each other. 
18. (a); Star topology is a network topology where each 

individual piece of a network is attached to a central 
node (often called a hub or switch). 

19. (e); Ctrl+Shift+N is also the shortcut key to open new 
incognito mode in chrome web browser. 

20. (b); First computers were programmed using machine 
language.  

21. (d); Utility software is system software designed to help 
analyze, configure, optimize or maintain a computer. 

22. (a); Swapping concept comes in terms of process 
scheduling. Scheduler removes process from CPU for 
duration and reduces the degree of 
multiprogramming. And after some time these 
process can again be reintroduced into main memory. 

23. (e); Assembler translates a program written in an 
assembly language into machine language.  

24. (b); In a computer network, the devices are called nodes. 
25. (c); The Hypertext Transfer Protocol (HTTP) is an 

application protocol for distributed, collaborative, 
hypermedia information systems. HTTP is the 
foundation of data communication for the World 
Wide Web. 

26. (a); Phishing is typically carried out by e-mail spoofing or 
instant messaging, and it often directs users to enter 
details at a fake website whose look and feel are 
almost identical to the legitimate one. 

27. (a); Broadcast networks: It has a single communication 
channel that is shared by all the machines on the 
network. Short messages, called packets in certain 
contexts, sent by any machine are received by all the 
others. 

28. (c); A compiler converts all the source code into machine 
code, creating an executable file. 

29. (d); Adware is software that automatically displays or 
downloads advertising material such as banners or 
pop-ups when a user is online. 

30. (c) 
31. (a); Those commands, options are available in menu bar. 
32. (b); A device driver is a program that controls a particular 

type of device that is attached to your computer. 
There are device drivers for printers, displays, CD-
ROM readers, diskette drives, and so on. When you 
buy an operating system, many device drivers are 
built into the product 

33. (d); The transport layer is a conceptual division of 
methods in the layered architecture of protocols in 
the network stack in the Internet Protocol Suite and 
the Open Systems Interconnection (OSI). The 
protocols of the layer provide host-to-host 
communication services for applications 

34. (a); Twisted pair wires are used  in telephone networks 
and for digital data transmission over short distances 
up to 1 km. 

35. (b); Timing and control unit is a part of processor. 
36. (b); A router is a networking device that forwards data 

packets between computer networks. Routers 
perform the traffic directing functions on the 
Internet. 

37. (a); A relational database is a collective set of multiple 
data sets organized by tables, records and columns. It 
establishes a well-defined relationship between 
database tables. 

38. (d); Simple Network Management Protocol (SNMP) is a 
popular protocol for network management. It is used 
for collecting information from, and configuring, 
network devices, such as servers, printers, hubs, 
switches, and routers on an Internet Protocol (IP) 
network. 

39. (d); Source program is written in high level language. 
40. (c); Supercomputer is used for predicting the weather. 
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MEMORY BASED QUESTIONS IBPS RRB PO AND CLERK 2017 
Q1. There is a small-sized type of volatile computer memory (d) Attachment (e) Spam 
that provides high-speed data access to a processor and Q14. Which among the following is the smallest unit in an 
stores frequently used computer programs, applications and image in a computer screen? 
data. Which among the following is a type of memory used to (a) Unit (b) Pixel (c) Array 
hold frequently used data? (d) Resolution (e) Clip 
(a) Microprocessor (b) Cache (c) ROM Q15. Different icons of application software can be found in 
(d) ALU (e) Control which bar in latest version of Microsoft Windows? 
Q2.  memory in a computer is where information is (a) Start Menu (b) Browser (c) Status 
temporarily stored while it is being accessed or worked on (d) Control Panel (e) Personalize 
by the processor. Q16. Information that comes from external source and fed 
(a) Logical (b) Secondary (c) ROM into computer software is called  . 
(d) RAM (e) Crude (a) Output (b) Input (c) Throughout 
Q3. Which among the following is a small set of data holding (d) Reports (e) Process 
place that is a part of the computer processor and may hold Q17. An email attachment is referred to as? 
an instruction, a storage address, or any kind of data? (a) The body of the email 
(a) Register (b) WAN (c) Bus (b) The address of the sender 
(d) Address (e) Processor (c) A document that is sent with an email 
Q4. An optical input device that interprets pencil marks on (d) The address of the receiver 
paper media is  . (e) Any document that can be attached and sent with an 
(a) OMR (b) punch card reader email 
(c) optical scanners (d) magnetic tape (e) Stylus Q18. What is the default extension of Microsoft Word 2013? 
Q5. Which among the following is related to the internet and (a).dcc (b).docx (c).xls 
e-mail? (d).ppt (e).ycs 
(a) Boot-Up (b) Magnetic Tapes Q19. Which unit is a combinational digital electronic circuit 
(c) Application Software (d) Paging (e) Virus that performs arithmetic and bitwise operations on integer 
Q6. Shift, Control, Alt are examples of which among the binary numbers? 
following category? (a) BOU (b) AEU (c) CPU 
(a) Modifier Keys (b) Primary Keys (d) ALU (e) UPS 
(c) Function Keys (d) Alternate Keys Q20. Which button is called as middle button used as third 
(e) Candidate Keys mouse button by pressing on it. 
Q7. In a keyboard, left-right-up-down set of keys facilitates (a) right button (b) scroll wheel 
which among the following function? (c) touch bar (d) light bar (e) left button 
(a) Deleting Data or Modification Q21. Presentation of a series of still images on a projection 
(b) Page Scrolling to view a Document screen or electronic display device is called as: 
(c) Launching Start Menu (a) slide edit (b) slide view (c) slide show 
(d) Initiating Search and Help (d) slide movie (e) slide image 
(e) Controlling RAM or process execution Q22. Which memory is used as temporary memory? 
Q8. Which among the following term means/refers to web (a) Non-volatile memory 
address of a page? (b) volatile memory 
(a) SMTP (b) IP (c) HTTP (c) hard disk memory 
(d) URL (e) MAC (d) read only memory 
Q9. Which of the following is always a part of an E-mail (e) flash disc memory 
address? Q23. A software program that add functionality to your 
(a) Period (-) (b) At sign (@) (c) Space ( ) computer or help your computer perform better is called as 
(d) Underscore () (e) Angular Bracket (<) (a) Utility program 
Q10. Which among the following is a term for the initial or (b) function program 
main web page of a website or a browser? (c) specialized program 
(a) URL (b) Domain (c) Google (d) manufacturer program 
(d) Search Engine (e) Home Page (e) compiling program 
Q11. What does .org stands for? Q24. Which unit of computer helps in communication 
(a) Government (b) Commercial Site between the memory and the arithmetic logical unit. 
(c) Organization (d) Orientation (e) Website (a) CMU (b) CCU (c) UPS 
Q12. Help menu is available at which button? (d) CPU (e) ALU 
(a) End (b) Start (c) Turn Off Q25. Specialized program that allows user to utilize in 
(d) Restart (e) Reboot specific application is classified as 
Q13. Which among the following is area of an email that is a (a) relative programs 
short description of the message? (b) application program 
(a) Subject (b) CC (c) BCC (c) appropriate programs 
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(d) replicate programs 
(e) logical programs 
Q26.Which of the following is most commonly used to 
identify return visitors to a website? 
(a) logged-in visitors 
(b) digital certificates 
(c) electronic time stamping 
(d) cookies 
(e) None of the above. 
Q27.  is a type of electronic spam where unsolicited 
messages are sent by email. 
(a) trash mail (b) cram mail (c) draft mail 
(d) spam mail (e) starred mail 
Q28. Data on a floppy disk was recorded in rings called  . 
(a) flip (b) ringers (c) rounders 
(d) fields (e) segments 
Q29. Choose the odd one out: 
(a) Word (b) Excel (c) Access 
(d) Keyboard (e) PowerPoint 

(c) Assembly language (d) Machine language 
(e) None of these 
Q34. Which one of the following is not an e-mail service 
provider? 
(a) Hotmail (b) Gmail (c) Bing 
(d) Yahoo mail (e) Outlook 
Q35. Which of the following fields of an e-mail hides the 
identity of the recipients? 
(a) To (b) From (c) Cc 
(d) Bcc (e) Subject 
Q36. Using output devices one can  . 
(a) View or Print Data (b) Modify Data 
(c) Store Data (d) Replicate Data 
(e) Enter Data 
Q37. Which among the following functions does Ctrl+P 
perform? 
(a) Project (b) Erase (c) Copy 
(d) Paste (e) Print 
Q38. The key combination of ‘Ctrl + Right Arrow’ is used to 

Q30. A device that not only provides surge protection, but   in MS Word. 
also furnishes the computer with battery backup power 
during a power outage is  . 
(a) Battery strip (b) UPS (c) Surge strip 
(d) USB (e) Memory 
Q31. A(n)  allows you to access your e-mail from 
anywhere. 
(a) Forum (b) Webmail interface 
(c) Message Board (d) Weblog (e) EEPROM 
Q32. Which of the following is not a valid memory unit? 
(a) ILB (b) KB (c) YB 
(d) PB (e) Byte 
Q33. Which of the following is a machine independent 
program? 
(a) High level language (b) Low level language 

(a) Move the cursor one word to the right 
(b) Move the cursor to the end of the line 
(c) Move to cursor to the end of the document 
(d) Move the cursor one paragraph down 
(e) None of these 
Q39. The default extension of Power point 2013 is- 
(a) .ppt (b) .pdf (c) .pptx 
(d) .pps (e) .ppn 
Q40.  is a useful tool which allows you to create a huge 
number of documents by merging the main document with 
the data source. 
(a) Mail Merge (b) Track Change (c) Page Margin 
(d) Orientation (e) Indentation 

 
 

History 
The word Computer in earlier times meant a person who 
performed calculations or computations. With years its 
definition changed to a machine that performs calculations. 
It can perform all type of mathematical and logical 

operations; it can accept data, store data, retrieve data, 
process data and produce output. 
Charles Babbage was known as father of computer. He 
invented two machines in 1822 introduced Difference 
Engine and in 1834, introduced Analytical engine 

 Difference Engine Charles Babbage First automatic mechanical calculator  

Analytical Engine Charles Babbage Mechanical general-purpose computer 
Z1 Konrad Zuse World’s first freely programmable computer 
MARK-1 Konrad Zuse First Freely programmable Computer 
ENIAC John W. Mauchly and J. 

Presper Eckert 
First general purpose programmable electronic 
computer 

EDSAC John von Neumann First computer to store program 
EDVAC John W. Mauchly and J. 

Presper Eckert 
UNIVAC John W. Mauchly and J. 

Presper Eckert 

Binary serial computer 
 

First general-purpose computer for commercial use 

Intel 4004 Intel First commercially available microprocessor by 
Intel, a 4-bit CPU 

LISA(Local Integrated 
Software 
Architecture) 

Apple Inc. First commercial personal computers to have a GUI 

Dataphone AT&T First AT&T Commercial modem 
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ARPANET United States Department 
of Defence 

Early packet switching network and the first 
network to implement the protocol suite TCP/IP. 

NEXUS Browser 
(WorldWideWeb) 

Tim Berners-Lee First   Web   Browser   was   WorldWideWeb   later 
named Nexus. The first commonly available web 
browser with a graphical user interface was Erwise. 

Six Degrees First social networking/ social media site 
 

 

ENIAC was the first digital computer and it was invented 
by J.Presper Eckert and John Mauchly at the University of 
Pennsylvania and began construction in 1943. It uses 18000 
vacuum tubes as a storing device. They were also founders of 
the first computer company, it was initially named Electronic 
Controls Company which was later changed to Eckert– 

Mauchly Computer Corporation, and released a series of 
mainframe electronic digital stored-program computer 
under the name of UNIVAC. 
MIT introduces the whirlwind machine (first computer with 
RAM) on March 8, 1955. 

 
 

Generation of Computer  
 

Subject 1st generation 2nd generation 3rd generation 4th generation 5th generation 
Period 1940-1956 1956-1963 1964-1971 1971-present present & beyond 

Circuitry Vacuum tube Transistor Integrated 
chips (IC) 

Microprocessor 
(VLSI) 

ULSI (Ultra Large 
Scale Integration) 

technology 

Memory Capacity 20 KB 128KB 1MB Semiconductor type 
and very high 

VLSI and ULSI 

Processing Speed 300 IPS inst. Per 
sec. 

300 IPS 1MIPS(1 
million inst. Per 

sec.) 

Faster than 3rd 

generation 
Very fast 

Programming 
Language 

Assembly 
Language 

High level 
language 
(FORTRAN, 

COBOL, ALGOL) 

C,C++ C,C++,Java All the Higher level 
languages, 

Neural networks, 

Example of 
computers 

UNIVAC, 
EDVAC 

IBM 1401, IBM 
7094, 

CDC 3600,D 
UNIVAC 1108 

IBM 360 series, 
1900 series 

Pentium series 
Multimedia, 
Stimulation 

Artificial 
Intelligence, 

Robotics 

Types of computer 
 

 

Analog computer introduced by Lord Kelvin. Numerical 
data are represented by measurable physical variables such 
as electrical voltage. A thermometer is a simple analog 
computer. 
Digital computer that accepts and process data in the form 
of numbers and all the character are converted into binary 
code. 
Hybrid computer used the combined feature of analog and 
digital machine. you can see hybrid computer in geological 
departments. 
Microcomputer these are small relatively inexpensive 
computer designed for personal and office use. It has lowest 

storing and processing speed. These can be laptop or 
desktop. 
Minicomputer powerful as compare to microcomputer it 
has higher memory provide faster operating speeds and 
large storage capacities than microcomputers. It can be used 
as a server and capable of supporting from 2 to 200 users. 
Mainframe computer it has very high memory and 
processing speed and used as a server (can support 
thousands of users) 
Super computer can be used for complex type of application 
i.e. specific research, weather forecasting, Weapon designing 
etc. 
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CDC 6600 was the first successful supercomputer. 
Sunway TaihuLight of China is the fastest supercomputer in 
the world. 
PARAM-8000 India’s first Super Computer developed by C- 
DAC Pune in 1998. 
Shasra T is considered as India’s fastest super computer, 
manufactured by Indian Institute of Science. 

Servers are dedicated computers that serve the needs or 
request of other programs or computer. 
Workstations serve usually one user only. 
Information appliances are computers specially designed 
to perform a specific "user-friendly" function—such as 
playing music, photography. 
An embedded system is a computer system with a 
dedicated function within a larger system. 

 

Hardware and I/O Devices 
A computer is an electronic device that accepts data from the 
user (input), processes the data by performing calculations 
and operations on it and generates the desired Output. 

 
An unprocessed collection or representation of raw facts 
represented in a manner suitable for communication, 
interpretation or processing by humans or by automatic 
means, is known as Data. 
Personal computers use a number of chips mounted on a 
main circuit board called Motherboard. A motherboard is 
the physical arrangement in a computer that contains the 
computer's basic circuitry and components. 

 
An output device is any piece of computer hardware 
equipment used to communicate the results of data 
processing carried out by an information processing system 
(such as a computer) which converts the electronically 
generated information into human-readable form. 

 
The CPU is fabricated as a single Integrated Circuit (IC) chip. 
It is also known as the Microprocessor. Multiprocessor 
Computers uses two or more central processing units (CPUs) 
within a single computer system. The term also refers to the 
ability of a system to support more than one processor 
and/or the ability to allocate tasks between them. 

 

 
The central processing unit (CPU) is the brain of your 
computer. It handles all the instructions you give your 
computer. The control unit (CU) is a component of a 
computer's central processing unit (CPU) that directs 
operation of the processor. It tells the computer's memory, 
arithmetic/logic unit and input and output devices how to 
respond to a program's instructions. 
An arithmetic logic unit (ALU) is a digital circuit used to 
perform arithmetic and logic operations. It represents the 
fundamental building block of the central processing unit 
(CPU) of a computer. 
Instruction Execution: the program which is to be executed 
is a set of instruction which are stored in memory. The CPU 
executes the instructions of program to complete a task and 
this execution takes place inside the CPU with the help of 

registers ALU (arithmetic logic unit) and CU(control unit). 
When the processor executes instructions, data is 
temporarily stored in small local memory location and these 
are called registers. 
Accumulator Register:- which stores the immediate result 
of arithmetic and logical operations. 
Memory address register (MAR) :- which contain the 
address of memory location to which data is to be stored. 
Program counter :- which contain the address of the next 
instruction to process. 
Instruction register:- which contain the current instruction 
being processed 

 

 
The data that is fed into a computer processor, received into 
the computer by a keyboard or other sources is called Input. 
Examples of input devices include keyboards, mouse, 
scanners, digital cameras and joysticks. 
A keyboard is a typewriter-style device, which uses an 
arrangement of buttons or keys, to act as mechanical levers 
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or electronic switches. Most of the commonly available 
personal computers have a keyboard, popularly known as 
Qwerty. 

 
 
 

 
'Caps lock' and 'Num lock' keys are called as Toggle Keys 
because when pressed, they change their status from one 
state to another. 
Numeric Keypad is a keypad located on the right hand side 
of the keyboard. It consists of digits and mathematical 
operators. 
A Modifier key is a special key (or combination) on a 
computer keyboard that temporarily modifies the normal 
action of another key when pressed together. By themselves, 
modifier keys usually do nothing; that is, pressing any of the 
Shift, Alt, or Ctrl keys alone does not (generally) trigger any 
action from the computer. 
A Mouse is the most popular input device which is used 
today for interactive processing and for the one line entry of 
data for batch processing. The first computer mouse was 
invented by Douglas Engelbart. 
Drag and Drop refers to the action of clicking and holding 
down the mouse button, while moving the mouse and then 
releasing the mouse button. 
Joystick is the device that moves in all directions and 
controls the movement of a pointer. 
A Touch Screen is a type of display screen device that is 
placed on the computer monitor to allow direct selection or 
activation of the computer when the user touches the screen. 
It acts as both input and output device. 
Light Pen is the pen shaped device, which can sense light 
and is used to point at spots on a video screen. 
A technology enables a high-speed reading of large 
quantities of data and transferring these data to the 
computer without using a keyboard. It is referred as Optical 
Mark Reader (OMR). It uses a beam of light that is reflected 
on the paper with marks, to capture presence and absence of 
marks. 
MICR reads the characters by examining their shapes in a 
matrix form and the information is then passed `on to the 
computer. MICR stands for Magnetic Ink Character Reader. 
It provides a high level of security and is therefore used by 
the banking industry for faster processing of the cheque. 

 
Bar Code is a machine readable code, which is represented 
by parallel vertical lines with varying widths. For reading 
these bar-coded data, a device is used, which is known as a 
Bar Code Reader (BCR) 

 
Optical Character Recognition (OCR) is used to scan the 
document containing text. It is the mechanical or electronic 
conversion of scanned or photographed images of 
typewritten or printed text into machine- 
encoded/computer-readable text. 

 
A point of sale terminal (POS terminal) is an electronic 
device used to process card payments at retail locations. 

 
The device that prints information from the computer onto 
the paper is Printer. 
The printed form of output is referred as Hard Copy. The 
form of output displayed on the screen is referred as Soft 
Copy. 

 
Pages per Minute (PPM) is the unit used to count the speed 
of the printer. 

 
On the basis of technology, printers are categorized into 
Impact and Non- Impact Printers. 

 
Impact printers create an image by using some mechanism 
to physically press an inked ribbon against the page, causing 
the ink to be deposited on the page in the shape desired. 

 
I) Dot matrix :- The dot-matrix printer uses print heads 
containing from 9 to 24 pins. These pins produce patterns of 
dots on the paper to form the individual characters 

 
II) Daisy wheel:- A hammer strikes a “petal” containing a 
character against the ribbon, and the character prints on the 
paper. Its speed is slow typically 25-55 characters per 
second. 

 
III) Line printer:- Line printers, or line-at-a-time printers, 
use special mechanism that can print a whole line at once; 
they can typically print the range of 1,200 to 6,000 lines per 
minute 

 
IV) Drum printer:- A drum printer consists of a solid, 
cylindrical drum that has raised characters in bands on its 
surface. The number of print positions across the drum 
equals the number available on the page. 

 
V) Chain printer:- A chain printer uses a chain of print 
characters wrapped around two pulleys 

 

Function Keys F1-F2 

Toggle Keys Caps Lock, Num Lock, 

Modifier Keys Shift, Alt, Ctrl, Fn 

Alphanumeric Keys A-Z, 0-9 
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VI) Band printer:- Band printer has a steel band divided 
into five sections of 48 characters each. 

 
Non – Impact Printers do not touch the paper when 
creating an image. 

 
I) Ink-jet printers:- One or more nozzles in the print head 
emit a steady stream of ink drops. Droplets of ink are 
electrically charged after leaving the nozzle. The droplets are 
then guided to the paper by electrically charged deflecting 
plates 

 
II) Laser printers:- Laser printers use buffers that store an 
entire page at a time. When a whole page is loaded, it will be 
printed. 

 
III) Thermal printer:- is a digital printing process which 
produces a printed image by selectively heating coated 

thermo chromic paper, or thermal paper as it is commonly 
known, when the paper passes over the thermal print head. 

 
A plotter is an output device that interprets commands from 
a computer to make line drawings on paper with one or 
more automated pens. Unlike a regular printer, the plotter 
can draw continuous point-to-point lines directly from 
vector graphics files or commands. 

 
An uninterruptible power supply (UPS) is a device that 
allows a computer to keep running for at least a short time 
when the primary power source is lost. 

 
A Monitor is a TV-like display attached to the computer on 
which the output can be displayed and viewed. It can either 
be a monochrome display or a color display. The number of 
pixels displayed on a screen is known as Resolution. 

 

Software and Operating System 
A set of instructions that tells the computer about the tasks 
to be performed and how these tasks are to performed, is 
known as Software. 
The set of instructions, which control the sequence of 
operations, are known as Program. It is a sequence of 
instructions, written to perform a specified task with a 
computer. 

 
Application software is a group of program designed for 
fulfill the demand of end user e.g. MS office, PowerPoint, 
Windows Media Player. 
System software is a program which is created for the 
system and to make the system user friendly such as 
operating system or is a type of computer program that is 
designed to run a computer's hardware and application 
programs. 
Utility software designed to help analyze, configure, 
optimize or maintain a computer such antivirus software. 

Operating system is a set of programs that help in controlling 
and managing the hardware and the software resources of a 
computer system. Main functions of operating system are 
:- 
-Process management 
-Memory management 
-File management 
-Security 
-Command and interpretation 
-Resource allocation 

 
Types of OS. 
1) Batch operating system : Here data and program that 
need to be processed are bundled and collected as a batch 
and executed together. 
2) Multiprogramming operating system : It allows 
the instruction and data from two or more separate 
process to reside in primary simultaneously. 
Multiprogramming system are multitasking multiuser and 
multiprocessing operating system. 
3) Single user : It is designed for single user and a 
single person use it at a time i.e. DOS window’s 95 etc. 
4) Distributed operating system : It is the one 
which manages a collection of independent computers and 
makes them appear to the user of the system as a single 
computer. 5)Real Time Operating System (RTOS) : It is a 
computing environment that reacts to input within a 
specific time period. It is used at those Places in which we 
Requires higher and Timely Response. 
6) Time Sharing System: A time sharing system allows the 
many users to simultaneously share the computer resources. 
Since each action or command in a time-shared system take 
a very small fraction of time, only a little CPU time is needed 
for each user. 
7) Mobile OS: Windows 10 Mobile is the latest name for 
Microsoft's phone and tablet operating system. Google's 
latest’s version of its android OS is Nougat and iOS i.e. 
iPhone Operating System's latest version is iOS 10. 
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Computer Languages 
Low level language: these are coded in a form which is easy 
to understand by the processor. 

 
Machine language: it is also a type of low level language 
these can be develop in binary language (0 and 1) . 

 
Assembly language: it is also a type of low level language 
and using the human readable instruction of the CPU. It is 
written as ‘MOV A.’ 

 
High level language programmer can write code in simple 
easy language, it is user friendly . E.g. C, JAVA 

 
C language: it is a middle level programming language and 
also known as procedural language 
C++ is high level language that uses the OOPS concept. 

 
Fortran: it is known as formula translation. It is used for 
scientific application 

 
COBOL (Common Business Oriented Language ): used for 
record keeping and data management in business 
organizations.  

 
BASIC (Beginner’s All Purpose Symbolic Instruction 
Code): first language designed for non-professional 
programmers. 
PASCAL: it is developed as a teaching tool for programming 
concepts. 

 
Simula was the first object-oriented programming language. 
Java, Python, C++, Visual Basic .NET and Ruby are the 
most popular Object Oriented Programming languages. 
The Java programming language is designed especially for 
use in distributed applications on corporate networks and 
the Internet. Ruby is used in many Web applications. Curl, 
Smalltalk, Delphi and Eiffel are also examples of object- 
oriented programming languages. 

convert program into a machine language so translator do 
this work. 

 
Loader: It loads the code which is translated by translator 
into the main memory and makes it ready to execute. 

 
Linker is used to combine all the object files and convert 
them into a final executable program. 

 
Interpreter converts high level language program into 
machine language. It is very slow because it convert program 
line by line. 

 
Compiler: It also translates the program from high level 
language to machine language. It is very fast because it 
converts the whole program into machine language. 

 
Assembler: It is used for converting the code of low level 
language (assembly language) into machine level language. 

 

Language processor (Translator): Programmers write 
their program in one of the high level language because it is 
much easy to code in these language but computer does not 
understand any of these language so it is necessary to 

 

MEMORY MANAGEMENT 
 

8 bit 1 byte 

1024 Byte 1 KB (Kilo Byte) 

1024 KB 1 MB (Mega Byte) 

1024 MB 1 GB (Giga Byte) 

1024 GB 1 TB (Tera Byte) 

1024 TB 1 PB (Peta Byte) 

1024 PB 1 EB (Exa Byte) 

1024 XB 1 ZB (Zeta Byte) 

1024 ZB 1 YB (Yota Byte) 
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A group of 4 bits is called a nibble. A byte is also known as 
an Octet. 
Primary Storage (memory), also known as main storage 
and it is the area in a computer in which data is stored for 
quick access by the computer's processor. The terms random 
access memory (RAM) and memory are often as synonyms 
for primary or main storage. Primary storage is volatile and 
can be contrasted with non-volatile secondary storage, also 
known as auxiliary storage. 
Cache memory is a smaller, faster memory which stores 
copies of the data from frequently used main memory 
locations. A CPU cache is a hardware cache used by the 
central processing unit (CPU) of a computer to reduce the 
average time to access data from the main memory. 
Secondary memory is where programs and data are kept 
on a long-term basis. Common secondary storage devices are 
the hard disk and optical disks. The hard disk has enormous 
storage capacity compared to main memory. The hard disk is 
usually contained inside the case of a computer. 
Read-only memory (ROM) is a storage medium used in 
computers and other electronic devices. Data stored in ROM 
can only be modified slowly or with difficulty, or not at all. 

 
ROM is non-volatile and the contents are retained even 
after the power is switched off. 
It only allows reading. 
The types of ROM include PROM, EPROM and EEPROM. 
PROM - (programmable read-only memory) is a memory 
chip on which data can be written only once. 

The difference between a PROM and a ROM (read-only 
memory) is that a PROM is manufactured as blank memory, 
whereas a ROM is programmed during the manufacturing 
process. To write data onto a PROM chip, you need a special 
device called a PROM programmer or PROM burner. 
EPROM - (erasable programmable read-only memory) is a 
special type of PROM that can be erased by exposing it to 
ultraviolet light. 
EEPROM - (electrically erasable programmable read-only 
memory). EEPROM is a special type of PROM that can be 
erased by exposing it to an electrical charge. 

 
Random Access Memory (RAM), allows the computer to 
store data for immediate manipulation and to keep track of 
what is currently being processed. 

 
RAM is referred to as volatile memory and is lost when the 
power is turned off. 
It also known as read/write memory as information can be 
read from and written onto it. 
The two main types of RAM are Static RAM and Dynamic 
RAM. 

 
SRAM retains data as long as power is provided to the 
memory chip and need not be refreshed periodically. It is 
often used as CPU Cache memory. SRAM stands for Static 
Random Access Memory. 

 
The data on DRAM continues to move in and out of the 
memory as long as power is available and must be 
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continually refreshed to maintain the data. DRAM stands for 
Dynamic Random Access Memory. 

 
Virtual memory is memory on the hard disk that the CPU 
uses as an extended RAM. 

 

 
 
 Access 

Time 
Storage 
Capacity 

Cost per bit 
of storage 

Primary 
memory 

Faster Smaller High 

Secondary 
memory 

Slower Higher Low 

 
Memory can also be categorized on the basis of their material: 
 
Semiconductor memory:-such as RAM, ROM, EPROM, and 
flash memory. 
 
Magnetic memory:-such as hard disk, floppy disk and 
magnetic tapes. 
 
Optical memory:-such as computer disk, DVD and 
blue-ray disk. 
A bus, in computing, is a set of physical connections (cables, 
printed circuits, etc.) which can be shared by multiple 
hardware components in order to communicate with one 
another. 
 
The address bus (sometimes called the memory bus) 
transports memory addresses which the processor wants to 
access in order to read or write data. It is a unidirectional bus. 
 
The data bus transfers instructions coming from or going to 
the processor. It is a bidirectional bus. 
 
The control bus (or command bus) transports orders and 
synchonisation signals coming from the control unit and 
travelling to all other hardware components. It is a 
bidirectional bus, as it also transmits response signals from 
the hardware. 

 
 

 

Structure of hard disk 

 
 

• Track- concentric division of disk 

• Sector- subdivision of track 

• Platter- circular magnetic disk which store 
magnetic data 

• Head- which perform read write data  

• Spindle -Spindle is the axis on which the hard 
disk spin 

• Disk -Formatting- division of disk into track 
and sector is known as Disk formatting  

• Speed of disk- speed of disk is measured in 
revolution per minute (RPM) 
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Number System 
 
The radix or base is the number of unique digits, including 
zero, used to represent numbers in a positional numeral 
system. For example, for the decimal system the radix is ten, 
because it uses the ten digits from 0 through 9. And that of 
Binary is base 2. 
 
Number System 
Decimal, Binary, Octal and Hexadecimal 
Equivalents 
Decimal Binary Octal Hexadecimal 

0 0000 000 0 

1 0001 001 1 

2 0010 002 2 

3 0011 003 3 

4 0100 004 4 

5 0101 005 5 

6 0110 006 6 

7 0111 007 7 

8 1000 010 8 

9 1001 011 9 

10 1010 012 A 

11 1011 013 B 

12 1100 014 C 

13 1101 015 D 

14 1110 016 E 

15 1111 017 F 

 
Hexadecimal to Binary: Refer the above table for the 
conversion process 
(1A2)16 = (?)2 
1=0001, A= 1010, 2=0010; Hence
 (1A2)16 = (000110100010)2 
Decimal to Binary: (75)10 =(?)2 
Divide 75 by 2 (and write down its remainder). 

 
Hence (75)10 =(101011)2 

 
Any number system to decimal: 
Sum of all (Digit × (Base)Base’s Place) 
Example: (1A2)16 = (?)10 (From the table you can refer A is 
equivalent to 10) 
((1× 162)+(10 × 161)+ (2×160))= 256+160+2=418 
Example: (110110)2=(?)10 

((1×25)+ (1×24)+ (0×23)+ (1×22)+ (1×21)+ 

(0×20))=32+16+4+2= 54; (110110)2=(54)10 

Octal to Binary: (345)8 =(?)2 (Write down 3 bit binary 
equivalents of all digits) 
3=011, 4=100, 5=101; Hence (345)8 =(011100101)2 
 
Octal to Hexadecimal: Convert to Binary first and then 
group 4 bits to get hexadecimal number. Example: (345)8 

=(?)16 =>(345)8 =(011100101)2 = 0000 1110 0101 =(0E5)16  
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Computer Network 
 

Different types of network are: LAN, MAN and WAN. 
A LAN (local area network) is a group of computers and 
network devices connected together, usually within the same 
building. By definition, the connections must be high speed 
and relatively inexpensive (e.g., token ring or Ethernet). 
A MAN (metropolitan area network) is a larger network 
that usually spans several buildings in the same city or town. 
A WAN (wide area network), in comparison to a MAN, is 
not restricted to a geographical location, although it might be 
confined within the bounds of a state or country. A WAN 
connects several LANs, and may be limited to an enterprise 
(a corporation or an organization) or accessible to the public. 
The technology is high speed and relatively expensive. The 
Internet is an example of a worldwide public WAN. 
A personal area network (PAN) is a computer network 
used for data transmission amongst devices such as 
computers, telephones, tablets and personal digital 
assistants. 
Campus Area Network or corporate area network is a 
computer network made up of an interconnection of local 
area networks (LANs) within a limited geographical area. 
A Storage Area Network (SAN) is a specialized, high-speed 
network that provides block-level network access to storage. 
A virtual private network (VPN) extends a private network 
across a public network, such as the Internet. It enables 
users to send and receive data across shared or public 
networks as if their computing devices were directly 
connected to the private network. 
Networking Devices 
Modem: Modem stands for Modulator-Demodulator. It is 
used to connect computers for communication via telephone 
lines. 
Hub: It works at the Physical layer. It just acts like a 
connector of several computers i.e. simply connects all the 
devices on its ports together. It broadcasts all the data 
packets arriving at it with no filtering capacity. 
Switch: It works at the Data Link Layer. It is used for 
dividing a network into segments called subnets. It provides 
filtering of data packets and prevents network traffic also. 
Repeater: It operates at the Physical Layer. It is used to 
amplify a signal that has lost its original strength so as to 
enable them to travel long distances. 
Router: It works at the Network Layer and is used to 
connect different networks that have different architectures 
and protocols. It sends the data packets to desired 
destination by choosing the best path available thus reducing 
network traffic. 
Gateway: It operates in all the layers of the network 
architecture. It can be used to connect two different 
networks having different architectures, environment and 
even models. 
Bridge: They are used two connect two LANs with the same 
standard but using different types of cables. It provides an 
intelligent connection by allowing only desired messages to 
cross the bridge thus improving performance. It uses 
physical addresses of the packets for this decision. 
IPv4 - 32 bits numeric address 
IPv6 - 128 bits hexadecimal address 
IPv6 does not use broadcast messages and has three types 
of addresses, which are categorized as : 
Unicast addresses. A packet is delivered to one interface. 
Multicast addresses. A packet is delivered to multiple 
interfaces. 
Anycast addresses. A packet is delivered to the nearest of 
multiple interfaces (in terms of routing distance). 
With an IPv4 IP address, there are five classes of available IP 
ranges: Class A, Class B, Class C, Class D and Class E, while 

only A, B, and C are commonly used. Each class allows for a 
particular range of valid IP addresses. Class D is reserved for 
multicast groups and Class E is reserved for future use, or 
Research and Development Purposes. 

 

Data Communication deals with the transmission of digital 
data from one device to another. Data is transferred through 
a pathway called as communication channel which can be 
physical wire connecting the devices or may be unguided 
media like laser, microwave etc. 
A communication channel has a source or transmitter at one 
side and a designation or receiver at another side of the 
network. The source of data origination is single but there 
may be multiple receivers. A communication channel is of 3 
types: 

 

Simplex: This, communication is unidirectional i.e. one of 
the two devices can transmit the data and the other can only 
receive the data. For e.g. Radio broadcasting, television 
broadcasting etc. 

 

Half duplex: This communication is bidirectional. Either of 
the devices can act as transmitter or receiver but only one 
device can transmit the data at one time. For e.g. Walkie- 
Talkie. 

 

Full Duplex: Here the communication is in both directions 
and both the devices can simultaneously transmit the data. 
For e.g. Telephone conversation. 

 

The Open Systems Interconnection model (OSI) is a 
conceptual model that characterizes and standardizes the 
internal functions of a communication system by partitioning it into 
abstraction layers. The model is a product of the Open Systems 
Interconnection project at the International Organization 
for Standardization (ISO). 
 

1 PHYSICAL LAYER 

(Media, Signal and Binary Transmission) 
Bits 

2 DATA LINK LAYER 

(Physical Addressing) 
Frames 

3 NETWORK LAYER 

(Path Determination and IP) 
Packets 

4 TRANSPORT LAYER (End-to-end 
connections & reliability) 

Segments 

5 SESSION LAYER (Inter-host 
Communication) 

Data 

6 PRESENTATION LAYER (Data 
Representation & Encryption) 

Data 

7 
APPLICATION LAYER (Network Process to 
Application) 

Data 

 

Network topology is the arrangement of the various 
elements (links, nodes, etc.) of a computer network. There 
are two basic categories of network topologies: 
 Physical topologies and Logical topologies. 
Physical topology is the placement of the various 
components of a network, including device location and 
cable installation, while Logical topology illustrates 
how data flows within a network, regardless of its 
physical design. Various types of topologies are: 
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Bus 
Topology 

 

Every computer and network device is connected to single cable. 

Star 
Topology 

 

All the computers are connected to a single hub through a cable. 
This hub is the central node and all others nodes are connected to 
the central node. 

Ring 
Topology 

 

Each computer is connected to another computer, with the last one 
connected to the first. Exactly two neighbors for each device. 

Mesh 
Topology 

 

It is a point-to-point connection to other nodes or devices. All the 
network nodes are connected to each other 

Tree 
Topology 

 

It has a root node and all other nodes are connected to it forming a 
hierarchy. It is also called hierarchical topology. 

 
Hybrid topology uses a combination of any two or more 

topologies in such a way that the resulting network does not 

exhibit one of the standard topologies. 

Cloud computing is a type of Internet-based computing that 

provides shared computer processing resources and data to 

computers and other devices on demand. 

Public clouds are owned and operated by companies that 

offer rapid access over a public network to affordable 

computing resources. 

A private cloud is infrastructure operated solely for a single 

organization, whether managed internally or by a third party, 

and hosted either internally or externally. 

A hybrid cloud uses a private cloud foundation combined 

with the strategic integration and use of public cloud services. 

Google Drive is a personal cloud storage service from Google 

which gives every user 15 GB of Drive storage space. OneDrive 

is Microsoft's service for hosting files in the "cloud computing". 

OneDrive offers 5GB of storage space for free. 

 

Types of Cloud computing Service  

1. Platform as a Service (PaaS): - It is a category of cloud 

computing service that provide a platform & Environment to 

build application and service over the internet. 

Example-Amazon web service, Azure Google App Engine etc. 

2. Software as a Service (SaaS): - It is a Category of cloud 

computing service which delivering services and application 

over the internet  

Example: -Microsoft office 365, Dropbox, Elogua etc. 

3. Infrastructure as a Service (IaaS): - It is a category of 

cloud computing which is known as Service model that 

delivers computer infrastructure on an outsource basis to 

support various operation. 

Infrastructure means -web server, database, development 

tools etc. 

Example: -Amazon Web Services, IBM, OpenStack etc. 
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Internet 
The Internet is a global system of interconnected computer 
networks that use the standard Internet protocol suite 
(TCP/IP) to link several billion devices worldwide. 
It is a network of networks that consists of millions of 
private, public, academic, business, and government 
networks, of local to global scope, that are linked by a broad 
array of electronic, wireless, and optical networking 
technologies. 
ARPANET adopted TCP/IP in 1983, and from there 
researchers began to assemble the “network of networks” 
that became the modern Internet. 

The World Wide Web (abbreviated as WWW or W3, 
commonly known as the Web) is a system of interlinked 
hypertext documents that are accessed via the Internet. 

the intent that the remote system should store a copy of the 
data being transferred 

 
An Internet Protocol address (also known as an IP 
address) is a numerical label assigned to each device (e.g., 
computer, printer) participating in a computer network. It 
acts as an identifier for a computer. It is a unique address for 
every computer. 

 
Domain names are used to identify one or more IP 
addresses. 

 
The universal resource locator, or URL, is an entire set of 
directions, and it contains extremely detailed information. 
The domain name is one of the pieces inside of a URL. 

A Website is a set of related web pages served from a single 
web domain. 

 

Domain Types 

A Home page, index page, or main page is a page on a 
website. A home page usually refers to: 
• The initial or main web page of a website, sometimes 

called the "front page" (by analogy with newspapers). 
• The first page that appears upon opening a web browser 

program, which is also sometimes called the start page. 
This 'start page' can be a website or it can be a page with 
various browser functions such as the visual display of 
websites that are often visited in the web browser. 

• The web page or local file that automatically loads when a 
web browser starts or when the browser's "home" button 
is pressed; this is also called a "home page". The user can 
specify the URL of the page to be loaded, or alternatively 
choose e.g. to re-load the most recent web page browsed. 

• A personal web page, for example at a web hosting 
service or a university web site that typically is stored in 
the home directory of the user. 

A Hyperlink is a reference to data that the reader can 
directly follow either by clicking or by hovering or that is 
followed automatically 

Type Description 
com  Commercial and for profit organization 

edu Educational provider, college, Universities 

gov   Government agencies 

Mil US military sites 
net Internet infrastructure and service providers 

org  Miscellaneous and Non-profit organisations 

 
An email attachment is a computer file sent along with an 
email message. One or more files can be attached to any 
email message, and be sent along with it to the recipient. 
Hotmail was co-founded by an Indian American 
entrepreneur Sabeer Bhatia along with Jack Smith in July of 
1996 

A web browser (commonly referred to as a browser) is a 
software application for retrieving, presenting and 
traversing information resources on the World Wide Web. 

 

Some of the famous browsers are Safari, Chrome, Firefox, 
Bolt, UC Browser and Internet Explorer 
The Uniform Resource Locator, abbreviated as URL is a 
specific character string that constitutes a reference to a 
resource. In most web browsers, the URL of a web page is 
displayed on top inside an address bar. 
(i) An example of a typical URL would be 
"http://www.bankersadda.com". 
Here the domain name is ‘bankersadda.com’ 
Downloading means to receive data to a local system from a 
remote system or to initiate such a data transfer 

 

Uploading refers to the sending of data from a local system 
to a remote system such as a server or another client with 

 
 

 

 

 

 

 

 

 

 

 

 
 

CC (Carbon Copy) in e – mail indicates those who are to 
receive a copy of a message addressed primarily to another. 
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The list of CC recipients is visible to all other recipients of the 
message. 

 
An additional BCC (blind carbon copy) field is available for 
hidden notification; recipients listed in the BCC field receive 
a copy of the message, but are not shown on any other 
recipient's copy (including other BCC recipients) 

The Drafts folder retains copies of messages that you 
have started but are not yet ready to send. 

 
The first email was sent by Ray Tomlinson to himself 
in 1971. 

 
Internet  Explorer  was  deprecated  in  Windows  10,  with 
Microsoft Edge replacing it as the default web browser. 

 

Computer Security 
 
Malware, short for malicious software, is any 
software used to disrupt computer operation, gather 
sensitive information, or gain access to private 
computer systems. It can appear in the form of 
executable code, scripts, active content, and other 
software.  
Example-Virus, Worm, Trojan Horse, 
Spyware, Ransomware, Rootkit, 
Adware,Keylogger etc. 
 

A Computer Virus is a computer program or code 
that can replicate itself and spread from one 
computer system to another system. A computer 
virus has the capacity to corrupt or to delete data on 
your computer and it can utilize an e- mail program 
to spread the virus to other computer systems 
. In the worst-case scenario, it can even delete 
everything on your hard disk. The purpose of it is to 
disrupt the operation of the computer or the 
program. 

 
Some examples of Computer Virus are Stealth virus, 
Disk Killer, Stone virus, Sunday, Cascade, Nuclear, 
Word Concept, etc. 
 
Worm: - It is type of malware which spread over 
the network without the need for a host file and also 
self-replicating, it tries to slow down the system 
 
Trojan Horse: - It is type of malware that misleads 
users of its true intent by disguising itself as a 
genuine program. that downloads onto a computer 
disguised as a legitimate program. And not self-
replicating 
 
Spyware: - It is a type of malware which access data 
and information from your system and transfer to 
another (3rd party) without user knowledge. 
 
Ransomware: - It is types of malwares which 
encrypt your files, data, information and for 
decrypting these file and data demanding some 
Ransome amount.  
 
  Adware: - adware is unwanted advertisement 
display on system as pop-up .it comes along with 

software download and package. 
 
Keylogger: -   keylogger is a type of malware which 
record user keystroke behaviors to obtain user sensitive 
information like password. 
 
Rootkit: - Rootkit is a malware that provides privileged 
root level (i.e., administrative) access and control over a 
target device    
 
Antivirus Software is used to scan the hard disk to 
remove the virus from them. Some of the famous anti – 
viruses available are Avast, Norton, Avira, Kaspersky, 
AVG, etc. 

A person who uses his or her expertise to gain access to    
other people’s computers to get information illegally or 
do damage is a Hacker. 

Firewall: - It is a network security system which 
prevent form unauthorized attach It works on 
monitoring and filtering.  
Authorization is the function of specifying access rights 
to resources related to information security and 
computer security in general and to access control in 
particular. More formally, "to authorize" is to define an 
access policy. 

 
Authentication is the act of confirming the truth of an 
attribute of a single piece of data or entity. It might 
involve confirming the identity of a person by validating 
their identity documents, verifying the validity of a 
website with a digital certificate, tracing the age of an 
artifact by carbon dating, or ensuring that a product is 
what its packaging and labeling claim to be. In other 
words, Authentication often involves verifying the 
validity of at least one form of identification. 

 
Phishing is the attempt to acquire sensitive 
information such as usernames, passwords, and credit 
card details (and sometimes, indirectly, money) by 
masquerading as a trustworthy entity in an electronic 
communication. 
A Spoofing attack is a situation in which one person 
or program successfully represents oneself as another 
by falsifying data and thereby gaining an illegitimate 
advantage. 
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Microsoft Office 
 

Microsoft Office is an office suite of desktop 
applications, 
servers and services for the Microsoft Windows and 
Mac operating systems. It includes Microsoft Word, 
Excel, PowerPoint, Outlook, OneNote, Access and 
Publisher. 
Note: Microsoft Windows Vista was an windows OS for 
PC not Office Suit. 
 

Office 365 is a subscription service that includes the 
most 
recent version of Office, which currently is Office 2016. 
It comes with the applications you’re familiar with, like 
Word, PowerPoint, and Excel, plus extra online 
storage, ongoing tech support. 
 

Note- Microsoft Azure is a growing collection of 
integrated cloud services which developers and IT 
professionals use to build, deploy and manage 
applications through our global network of data 
centres. It provides software as a service (SaaS), 
platform as a service (PaaS) and infrastructure as a 
service (IaaS) and supports many different 
programming languages, tools and frameworks. 
Microsoft Azure was earlier known as Windows Azure. 
 
SOME NEW FEATURES INTRODUCED IN OFFICE 
2016 FOR WINDOWS OS 
 

Share: In Word 2016 for Windows, it is easier than 
ever to share your documents. When you share your 
files by using OneDrive or SharePoint Online for Office 
365, you can invite people to the document directly 
from within Word, or send a PDF or Word file as an 
email attachment. This feature of share is also available 
for Excel and PowerPoint 2016. 
 

Tell Me: This is a text field where you can enter words 
and phrases about what you want to do next and 
quickly get to those features you want to use or actions 
you want to perform. You can also use Tell Me to find 
help about what you're looking for, or to use Smart 
Lookup to research or define the term you entered. 
Smart Lookup: Bing search incorporated with 
applications 
New Charts introduced in Excel 2016 : New Chart 
types and templates are introduced in Excel 2016 such 
as treemap, sunburst chart (also known as a ring 
chart), waterfall chart, box plot and histogram, and 
financial and calendar templates. 
Skype and OneDrive Integration : One of the new 
features added to Word, Excel, and PowerPoint is the 
ability to use Skype for Business to collaborate and 
communicate while working on documents. User can 
IM or video-call someone with Skype from the new 

Share pane built into the new Office applications. 
OneDrive integration supports cloud storage file 
hosting service that supports access of office document 
from anywhere on any device. 
Some other features: 
New animations in PowerPoint (such as the Morph 
transition), the ability to insert online video in 
OneNote, and a data loss prevention feature in Word, 
Excel, and PowerPoint. 
New recent-documents feature in Outlook 2016 shows 
you the documents you've recently worked on in the 
Office apps, so you don't have to hunt for them on your 
PC. 
Enterprise Data Protection: To manage and prevent 
data loss at enterprise level, MS Office 2016 comes 
paced with inbuilt security feature that provide an ease 
for system admin to enforce policies for content 
authoring and document sharing. 
 
SOME COMMANDS RELATED TO MS OFFICE 
 

1. Save Vs Save As  
"Save" simply saves your work by updating the last 
saved version of the file to match the current version 
you see on your screen. 
"Save As" brings up a prompt to save your work as a 
file with a different name. For example, you might 
choose to save a document called "New Doc" as "Final 
Doc". This way, you can save you file at different stages 
and keep multiple versions on your hard drive. 
2. Save or convert to PDF 
You can use the Office programs to save or convert 
your files to PDFs so that you can share them or print 
them using commercial printers. To export or save as 
PDF, in your Office file, on the File menu, click Export 
or Save As. 
3. Undo Vs Redo 
You can undo, redo, or repeat many actions in 
Microsoft Word, PowerPoint, and Excel. Undo reverses 
the immediate action. Redo reverts the effects of the 
undo action. 
4. Portrait Vs Landscape 
The terms portrait and landscape refer to different 
orientations of the paper; whether it is oriented 
vertically or horizontally. A page with portrait 
orientation, typical for letters, memos, and other text 
documents, is taller than it is wide. Portrait is vertical 
mode and landscape is horizontal mode. 
 
MS WORD 2016: 
 

Backstage View in MS Word 2016: MS Word 2016 has 
a backstage view where you can see the recent 
documents that you’ve visited or edited and a few 
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templates as well. There is also an option to search for 
more templates. These templates can help you get the 
desired layout where a sample data will already be 
there. You may edit and enter data as you may like. 
 
MS Word 2016 Ribbons: 
 

Quick Access Toolbar 
By default, on top is the Quick access toolbar which has 
3 default options available: Save, Undo Typing and 
Repeat Typing. After this there is a drop-down menu 
for customizing the quick access toolbar. This toolbar 
is totally customizable; you can position it below the 
tabs and commands or add more items to it.  
 

To add or remove a command from the quick access 
toolbar: When you find a favorite command, right-click 
it, and then click Add to Quick Access Toolbar. 
 

Remove a command by right-clicking it on the Quick 
Access Toolbar, and then clicking Remove from Quick 
Access Toolbar. 
 
Tabs in Word 2016 
 

The ribbon in Word and other Office Suite’s 
Application has Tabs. In Word 2016 there are 9 tabs 
followed by a new feature of “Tell me what you want to 
do” arranged in a horizontal fashion. The tabs are as 
follows: File, Home, Insert, design, Layout, References, 
Mailing, Review, and View. The File tab opens the Info 
Window and has options arranged in a vertical array: 
Info, New, Open, Save, Save As, Print, Share, Export, 
Close, Account, Feedback and Options. 
 
The ribbon containing Tabs also have a new feature of 
Share and Comment at the extreme right corner. 
 
Note- Each tab has many commands which are 
grouped into specific categories. Following are the 
groups for commands under various tabs of MS Word 
2016: 
Home: Clipboard, Font, Paragraph, Styles and Editing 
Insert: Pages, Tables, Illustrations, Add-ins, Media, 
Links, Comments, Header & Footer, Text, Symbols 
Design: Document Formatting, Page Background 
Layout: Page Setup, Paragraph, Arrange 
References: Table of Contents, Footnotes, Research, 
Citation & Bibliography, Captions, Index, Table of 
Authorities  
Mailings: Create, Start Mail Merge, Write &Insert 
Fields, Preview Results, Finish 
Review: Proofing, Accessibility, Language, Comments, 
Tracking, Changes, Compare, Protect 
View: Views, Page Movement, Show, Zoom, Window, 
Macros 
 

MS WORD 2016 SHORT CUT KEYS 
 

Frequently used short cut keys 

To do this Press 
Go to "Tell me what you want 
to do" 

Alt+Q 

Open Ctrl+O 

Save Ctrl+S 

Close Ctrl+W 

Cut Ctrl+X 

Copy Ctrl+C 

Paste Ctrl+V 

Select all Ctrl+A 

Bold Ctrl+B 

Italic Ctrl+I 

Underline Ctrl+U 

Decrease font size 1 point Ctrl+[ 

Increase font size 1 point Ctrl+] 

Centre text Ctrl+E 

Left align text Ctrl+L 

Right align text Ctrl+R 

Justify align text Ctrl+J 

Cancel Esc 

Undo Ctrl+Z 

Re-do Ctrl+Y 

Zoom 

Alt+W, Q, then 
tab in Zoom 
dialog box to 
the value you 
want. 

Copy formatting from text. Ctrl+Shift+C 
Apply copied formatting to 
text. 

Ctrl+Shift+V 

Create and edit documents 

To do this Press 

Split the document window. Alt+Ctrl+S 

Remove the document 

window split. 

Alt+Shift+C or 

Alt+Ctrl+S 

Save a document. Ctrl+S 
 

Delete text and graphics 

To do this Press 

Delete one character to the left. Backspace 

Delete one word to the left. Ctrl+Backspace 

Delete one character to the 

right. 

Delete 

Delete one word to the right. Ctrl+Delete 

Cut selected text to the Office 

Clipboard. 

Ctrl+X 

Undo the last action. Ctrl+Z 

Cut to the Spike. (Spike is a Ctrl+F3 
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feature that allows you to collect 

groups of text from different 

locations and paste them in 

another location). 
 

Find, replace and go to specific items in the document 

To do this Press 

Open the search box in the 

Navigation task pane. 
Ctrl+F 

Replace text, specific 

formatting, and special items. 
Ctrl+H 

Go to a page, bookmark, 

footnote, table, comment, 

graphic, or other location. 

Ctrl+G 

Switch between the last four 

places that you have edited. 
Alt+Ctrl+Z 

 

Work with documents in different views 

To do this Press 

Switch to Read Mode view Alt+W, F 

Switch to Print Layout view. Alt+Ctrl+P 

Switch to Outline view. Alt+Ctrl+O 

Switch to Draft view. Alt+Ctrl+N 
 

Change Paragraph Alignment 

To do this Press 

Remove a paragraph indent 

from the left. 

Ctrl+Shift+M 

Create a hanging indent. Ctrl+T 

Reduce a hanging indent. Ctrl+Shift+T 

Remove paragraph formatting. Ctrl+Q 
 

Insert Special Characters 
 

To insert this Press 

A field Ctrl+F9 

A line break Shift+Enter 

A page break Ctrl+Enter 

A column break Ctrl+Shift+Enter 

An em dash 
Alt+Ctrl+Minus Sign (on the 
numeric keypad) 

An en dash 
Ctrl+Minus Sign (on the 
numeric keypad) 

An optional 
hyphen 

Ctrl+Hyphen 

A nonbreaking 
hyphen 

Ctrl+Shift+Hyphen 

A nonbreaking 
space 

Ctrl+Shift+Spacebar 

The copyright 
symbol 

Alt+Ctrl+C 

The registered Alt+Ctrl+R 

trademark 
symbol 
The trademark 
symbol 

Alt+Ctrl+T 

An ellipsis Alt+Ctrl+Period 

A single opening 
quotation mark 

Ctrl+`(single quotation 
mark), `(single quotation 
mark) 

A single closing 
quotation mark 

Ctrl+' (single quotation 
mark), ' (single quotation 
mark) 

Double opening 
quotation marks 

Ctrl+` (single quotation 
mark), Shift+' (single 
quotation mark) 

Double closing 
quotation marks 

Ctrl+' (single quotation 
mark), Shift+' (single 
quotation mark) 

An AutoText 
entry 

Enter (after you type the 
first few characters of the 
AutoText entry name and 
when the ScreenTip 
appears) 

 
MS POWERPOINT 2016: 
 

PowerPoint is a slideshow presentation program that's 
part of the Microsoft office suite of tools. PowerPoint 
slides can be plain with only text, or they can include 
pictures and even animation, including moving text 
and images. Text can be formatted in the same way as 
text can be formatted in Microsoft Word, including 
color, size, and font type. 
 

In PowerPoint 2016 there are 9 tabs followed by a new 
feature of “Tell me what you want to do” arranged in a 
horizontal fashion. The tabs are as follows: File, Home, 
Insert, design, Transition, Animation, Slide Show, 
Review, and View. 
 

1. Home  
The home tab in PowerPoint has following groups: 
Clipboard, Slides, Font, Paragraph, drawing and 
Editing. The Clipboard, Editing and Font commands are 
same as that in Word 2016. The Slides group contains 
commands to insert new slide, choose slide layout, 
reset the positions and formatting of the slide 
placeholders and option to organize your slides into 
sections. 
 

2. Insert 
Click Insert to add something to a slide. This includes 
pictures, shapes, charts, links, text boxes, video and 
more. The Insert Tab has following groups of 
commands: Slides, Tables, Images, Illustrations, Add-
ins, Links, Comments, Text, Symbols and Media. 
 

3. Design 
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On the Design tab, you can add a theme or color 
scheme, or format the slide background. The design tab 
has following categories or groups of commands:  
Themes- Each theme has its own unique set of font, 
effect, color to create a visually appeasing and overall 
look of the slide. 
Variants - The current theme or style can be 
customized using various color schemes through 
variants. 
Customize- This group contains commands to change 
slide size and Format Background. 
Designer- For instant slide makeovers. 
 

4. Transitions 
Set up how your slides change from one to the next on 
the Transitions Tab. Find a gallery of the possible 
transitions in the Transition to This Slide group – click 
More Button at the side of the gallery to see all of them. 
 

5. Animations 
User may use the Animations tab to choreograph the 
movement of things on his slides. Note that you can see 
many possible animations in the gallery in the 
Animation group, and see more of them by clicking  
More Button. Apart from adding animation you can 
also customize its duration and timing as you need by 
using advanced animation and timing group of 
commands. 
 

6. Slide Show 
On the Slide Show tab, set up the way that you want to 
show your presentation to others. 
 

7. Review 
The Review tab lets you add comments, run spell-
check, or compare one presentation with another 
(such as an earlier version). 
 

8. View 
Views allow you to look at your presentation in 
different ways, depending on where you are in the 
creation or delivery process. 
 

9. File 
At one end of the ribbon is the File tab, which you use 
for the behind-the-scenes stuff you do with a file, such 
as opening, saving, sharing, exporting, printing and 
managing your presentation. Click the File tab to open 
a new view called the Backstage. 
 

10. Tools tabs 
When you click some parts of your slides, such as 
pictures, shapes, SmartArt or text boxes, you might see 
a colourful new tab appear. 
For example, the Drawing Tools tab appears when you 
click a shape or text box. When you click a picture, the 
Picture Tools tab appears. Other such tabs include 
SmartArt Tools, Chart Tools, Table Tools and Video 
Tools. These tabs disappear or change when you click 

something else in your presentation. 
 
Terms related to PowerPoint 
 

Slide Show : Each page of a PowerPoint presentation is 
called a slide. The default orientation of the slide is in 
landscape layout 
Design Template : A design template acts as a 
coordinated packaged deal. It is created so that even 
though different slide types can have different layouts 
and graphics, the whole presentation goes together as 
an attractive package. 
Slide Master : When you want all your slides to contain 
the same fonts and images (such as logos), you can 
make those changes in one place—the Slide Master, 
and they'll be applied to all your slides. To open Slide 
Master view, on the View tab, select Slide Master: 
 
MS POWERPOINT 2016 SHORT CUT KEYS 
 

Frequently used shortcuts 
The following table itemizes the most frequently used 
shortcuts in PowerPoint. 

To do this Press 
Make selected text bold. Ctrl+B 
Change the font size for 
selected text. 

Alt+H, F, and 
then S 

Change the zoom for the slide. Alt+W, Q 
Cut selected text, object, or 
slide. 

Ctrl+X 

Copy selected text, object, or 
slide. 

Ctrl+C 

Paste cut or copied text, 
object, or slide. 

Ctrl+V 

Undo the last action. Ctrl+Z 
Save the presentation. Ctrl+S 
Insert a picture. Alt+N, P 
Insert a shape. Alt+H, S, and 

then H 
Select a theme. Alt+G, H 
Select a slide layout. Alt+H, L 
Go to the next slide. Page Down 
Go to the previous slide. Page Up 
Go to the Home tab. Alt+H 
Move to the Insert tab. Alt+N 
Start the slide show. Alt+S,B 
End the slide show. Esc 
Close PowerPoint. Alt+F, X 

 
MS EXCEL 2016 
Microsoft Excel is a spreadsheet developed by 
Microsoft. Spreadsheets allow you to keep track of 
data, create charts based from data, and perform 
complex calculations. Just like a book ledger, 
spreadsheets store information in columns and rows. 
You can have up to 256 columns and 65,536 rows per 
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worksheet.  

 

Feature Maximum limit 

Worksheet size 
1,048,576 rows by 
16,384 columns 

Column width 255 characters 

Row height 409 points 

Page breaks 
1,026 horizontal and 
vertical 

Total number of 
characters that a 
cell can contain 

32,767 characters 

Characters in a 
header or footer 

255 

Maximum 
number of line 
feeds per cell 

253 

Sheets in a 
workbook 

Limited by available 
memory (default is 1 
sheet) 

Unique cell 
formats/cell 
styles 

64,000 

Unique font types 
1,024 global fonts 
available for use; 512 
per workbook 

Hyperlinks in a 
worksheet 

66,530 hyperlinks 

Panes in a 
window 

4 

Zoom range 
10 percent to 400 
percent 

Fields in a data 
form 

32 

 

Workbook and Worksheet 
 

An Excel worksheet is a single spreadsheet that 

contains cells organized by rows and columns. A 

worksheet begins with row number 1 and column A. 

Each cell can contain a number, text or formula. Excel 

Workbook comprises number of worksheets. Many 

new sheets can be added to a workbook using adding 

worksheet command which is present at the bottom. 

 

Formula and Function 
 

Formulas enable you to enter calculations in a 

worksheet. Using Excel for calculations gives you the 

ability to change the data (or values) of the cells, and 

have the program automatically update the recalculate 

the value of the output based on the new numbers. 
 

Here are some most frequently used functions in Excel: 

Function Description 

SUM 

function 

Use this function to add the values 

in cells. 

IF function Use this function to return one 

value if a condition is true and 

another value if it's false.  

LOOKUP 

function 

Use this function when you need 

to look in a single row or column 

and find a value from the same 

position in a second row or 

column. 

MATCH 

function 

Use this function to search for an 

item in a range of cells, and then 

return the relative position of that 

item in the range. For example, if 

the range A1:A3 contains the 

values 5, 7, and 38, then the 

formula =MATCH(7,A1:A3,0) 

returns the number 2, because 7 is 

the second item in the range. 

CHOOSE 
function 

Use this function to select one of 
up to 254 values based on the 
index number. For example, if 
value1 through value7 are the 
days of the week, CHOOSE returns 
one of the days when a number 
between 1 and 7 is used as 
index_num. 

DATE 
function 

Use this function to return the 
sequential serial number that 
represents a particular date. This 
function is most useful in 
situations where the year, month, 
and day are supplied by formulas 
or cell references. For example, 
you might have a worksheet that 
contains dates in a format that 
Excel does not recognize, such as 
YYYYMMDD. 
Use the DATEDIF function to 
calculate the number of days, 
months, or years between two 
dates. 

DAYS 
function 

Use this function to return the 
number of days between two 
dates. 

FIND, 
FINDB 
functions 

FIND and FINDB locate one text 
string within a second text string. 
They return the number of the 
starting position of the first text 
string from the first character of 
the second text string. 
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Freeze Panes in Excel 
If you wish to see a particular area of a worksheet 
visible or multiple rows and columns while you scroll 
to another area of the worksheet, you can use Freeze 
Panes (available under view tab). 
 
Tabs in MS Excel 2016 
The ribbon in Excel and other Office Suite’s Application 
has Tabs. In Excel 2016 there are 8 tabs followed by a 
new feature of “Tell me what you want to do” arranged 
in a horizontal fashion. The tabs are as follows: File, 
Home, Insert, Page Layout, Formulas, Data, Review, 
and View. 
Following are the groups of Commands available under 
tabs of Excel 2016: 
Home: Clipboard, Font, Alignment, Number, Style (for 
Conditional Formatting of table), Cells (to insert, delete 
and format cells), Editing (AutoSum, Sort & Filter, Find 
& Select) 
Insert: Tables (Pivot Table, and Tables); Illustrations 
(Pictures, Online Picture, shapes and Icon); Add-ins; 
Charts; Tours (3D Map); Sparklines (Line, Column, 
Win/Loss); Filters; Links; Text; Symbols 
Page Layout: Themes; Page Setup (Margin, orientation, 
page size, print area, breaks, background and print 
titles); Scale to fit; Sheet Options (Gridline, headings); 
Arrange 
Formulas: Insert Function; Function Library; Defined 
Names; Formula Auditing; Calculation 
Data: Get external Data; Get & Transform (New query, 
show queries, from table, recent sources); 
Connections; Sort and Filter; Data Tools; Forecast 
(what-if analysis, forecast sheet); Outline 
Review: Proofing (Spelling, Thesaurus); Accessibility; 
Insights-smart lookup; Comments; Changes (Protect 
sheet, protect workbook, share workbook, allow users 
to edit ranges, track changes) 
View: Workbook Views (Normal, Page Break Preview, 
Page Layout, Custom Views); Show (gridlines, ruler. 
formula bar, headings); Zoom; Window; Macros 
 

EXCEL 2016 SHORT CUT KEYS 
 

Frequently used shortcuts Keys 
 

To do this Press 

Close a spreadsheet Ctrl+W 

Open a spreadsheet Ctrl+O 

Go to the Home tab Alt+H 

Save a spreadsheet Ctrl+S 

Copy Ctrl+C 

Paste Ctrl+V 

Undo Ctrl+Z 

Remove cell contents Delete key 

Choose a fill color Alt+H, H 

Cut Ctrl+X 

Go to Insert tab Alt+N 

Bold Ctrl+B 

Center align cell contents Alt+H, A, then 
C 

Go to Page Layout tab Alt+P 

Go to Data tab Alt+A 

Go to View tab Alt+W 

Open context menu Shift+F10, or 
Context key 

Add borders Alt+H, B 

Delete column Alt+H,D, then 
C 

Go to Formula tab Alt+M 

Hide the selected rows Ctrl+9 

Hide the selected columns Ctrl+0 

Format in cells: keyboard shortcuts 

 

To do this Press 
Move to the previous cell in 
a worksheet or the previous 
option in a dialog box. 

Shift+Tab 

Move one cell up in a 
worksheet. 

Up Arrow 
key 

Move one cell down in a 
worksheet. 

Down 
Arrow key 

Move one cell left in a 
worksheet. 

Left Arrow 
key 

Move one cell right in a 
worksheet. 

Right Arrow 
key 

Move to the edge of the 
current data region in a 
worksheet. 

Ctrl+arrow 
key 

Enter End mode, move to the 
next nonblank cell in the 
same column or row as the 
active cell, and turn off End 
mode. If the cells are blank, 
move to the last cell in the 
row or column. 

End, arrow 
key 

Move to the last cell on a 
worksheet, to the lowest 
used row of the rightmost 
used column. 

Ctrl+End 

Extend the selection of cells 
to the last used cell on the 
worksheet (lower-right 
corner). 

Ctrl+Shift+E
nd 

Move to the cell in the 
upper-left corner of the 
window when Scroll Lock is 
turned on. 

Home+Scrol
l Lock 
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Move to the beginning of a 
worksheet. 

Ctrl+Home 

Move one screen down in a 
worksheet. 

Page Down 

Move to the next sheet in a 
workbook. 

Ctrl+Page 
Down 

Move one screen to the right 
in a worksheet. 

Alt+Page 
Down 

Move one screen up in a 
worksheet. 

Page Up 

Move one screen to the left 
in a worksheet. 

Alt+Page Up 

Move to the previous sheet 
in a workbook. 

Ctrl+Page 
Up 

Move one cell to the right in 
a worksheet. Or, in a 
protected worksheet, move 
between unlocked cells. 

Tab 

 

Format in cells: keyboard shortcuts 
 

To do this Press 

Open the Format Cells dialog 
box. 

Ctrl+1 

Format fonts in the Format 
Cells dialog box. 

Ctrl+Shift+F 
or 
Ctrl+Shift+P 

Edit the active cell and put the 
insertion point at the end of 
its contents. Or, if editing is 
turned off for the cell, move 
the insertion point into the 
formula bar. If editing a 
formula, toggle Point mode 
off or on so you can use arrow 
keys to create a reference. 

F2 

Add or edit a cell comment. Shift+F2 

Open the Insert dialog to 
insert blank cells. 

Ctrl+Shift+P
lus (+) 

Open the Delete dialog box to 
delete selected cells. 

Ctrl+Minus 
(-) 

Enter the current time. 
Ctrl+Shift+c
olon (:) 

Enter the current date. 
Ctrl+semi-
colon (;) 

Switch between displaying 
cell values or formulas in the 
worksheet. 

Ctrl+grave 
accent (`) 

Copy a formula from the cell 
above the active cell into the 
cell or the Formula Bar. 

Ctrl+apostro
phe (') 

Move the selected cells. Ctrl+X 

Copy the selected cells. Ctrl+C 

To do this Press 

Paste content at the insertion 
point, replacing any selection. 

Ctrl+V 

Open the Paste Special dialog 
box. 

Ctrl+Alt+V 

Italicize text or remove italic 
formatting. 

Ctrl+I or 
Ctrl+3 

Bold text or remove bold 
formatting. 

Ctrl+B or 
Ctrl+2 

Underline text or remove 
underline. 

Ctrl+U or 
Ctrl+4 

Apply or remove 
strikethrough formatting. 

Ctrl+5 

Switch between hiding 
objects, displaying objects, 
and displaying placeholders 
for objects. 

Ctrl+6 

Apply an outline border to the 
selected cells. 

Ctrl+Shift+a
mpersand 
(&) 

Remove the outline border 
from the selected cells. 

Ctrl+Shift+u
nderline (_) 

Display or hide the outline 
symbols. 

Ctrl+8 
 

Work with data, functions, and the formula bar: 
keyboard shortcuts 
 

To do this Press 

Select an entire PivotTable 
report. 

Ctrl + Shift + 
asterisk (*) 

Edit the active cell and put 
the insertion point at the 
end of its contents. Or, if 
editing is turned off for the 
cell, move the insertion 
point into the formula bar. 
If editing a formula, toggle 
Point mode off or on so you 
can use arrow keys to 
create a reference. 

F2 

Expand or collapse the 
formula bar. 

Ctrl+Shift+U 

Cancel an entry in the cell 
or Formula Bar. 

Esc 

Complete an entry in the 
formula bar and select the 
cell below. 

Enter 

Move the cursor to the end 
of the text when in the 
formula bar. 

Ctrl+End 

Select all text in the 
formula bar from the 

Ctrl+Shift+End 
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cursor position to the end. 

Calculate all worksheets in 
all open workbooks. 

F9 

Calculate the active 
worksheet. 

Shift+F9 

Display the Function 
Arguments dialog box 
when the insertion point is 
to the right of a function 
name in a formula. 

Ctrl+A 

Insert argument names and 
parentheses when the 
insertion point is to the 
right of a function name in 
a formula. 

Ctrl+Shift+A 

Invoke Flash Fill to 
automatically recognize 
patterns in adjacent 
columns and fill the current 
column 

Ctrl+E 

Cycle through all 
combinations of absolute 
and relative references in a 
formula if a cell reference 
or range is selected. 

F4 

Insert a function. Shift+F3 
Create a chart of the data in 
the current range in a 
separate Chart sheet. 

F11 

Define a name to use in 
references. 

Alt+M, M, D 

Paste a name from the 
Paste Name dialog box (if 
names have been defined in 
the workbook. 

F3 

Move to the first field in the 
next record of a data form. 

Enter 

Create, run, edit, or delete a 
macro. 

Alt+F8 

 
FILE EXTENSIONS: 
 

Word 
XML file type Extension 
Document .docx 
Macro-enabled document .docm 
Template .dotx 
Macro-enabled template .dotm 

 
Excel 

XML file type Extension 
Workbook .xlsx 
Macro-enabled workbook .xlsm 
Template .xltx 
Macro-enabled template .xltm 
Non-XML binary workbook .xlsb 
Macro-enabled add-in .xlam 

 

 PowerPoint 
XML file type Extension 
Presentation .pptx 
Macro-enabled presentation .pptm 
Template .potx 
Macro-enabled template .potm 
Macro-enabled add-in .ppam 
Show .ppsx 
Macro-enabled show .ppsm 
Slide .sldx 
Macro-enabled slide .sldm 
Office theme .thmx 

 

 

Note-version of ms-word,excel,powerpoint 2016,  replace  with 2019    all content  will be same
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DATABASE MANAGEMENT SYSTEM 
DBMS is the acronym of Data Base Management System. 
DBMS is a collection of interrelated data and a set of 
programs to access this data in a convenient and efficient 
way. It controls the organization, storage, retrieval, security 
and integrity of data in a database. 

 
Types of Database Model: Network Database Model, 
Hierarchical Database model, Relational Database Model and 
Object-Oriented Database Model. 

 
Architecture of DBMS-The generalized architecture of 
DBMS is called ANSI/ SPARC model. The architecture is 
divided into three levels: 

• External view or user view/View Level- It is the 
highest level of data abstraction. This includes only 
those portions of database of concern to a user or 
Application program. Each user has a different external 
view and it is described by means of a scheme called 
external schema. 

• Conceptual view/Logical Level- All the database 
entities and the relationship among them are included. 
One conceptual view represents the entire database 
called conceptual schema. 

• Internal view/Physical Level- It is the lowest level of 
abstraction, closest to the physical storage method. It 
describes how the data is stored, what is the structure of 
data storage and the method of accessing these data. It is 
represented by internal schema. 

 
Data model: A data model is a plan for building a database. 
The model represents data conceptually, the way the user 

sees it, rather than how computers store it. Data models 
focus on required data elements and associations. 

• Entity – Relationship Model 

• Relational Model 
Entity: A thing (animate or inanimate) of independent 
physical or conceptual existence and distinguishable. In 
the University database context, an individual student, 
faculty member, a class room, are entities. 
Attributes: Each entity is described by a set of 
attributes/properties. 
SQL (Structured Query Language) is a database 
computer language designed for the retrieval and 
management of data in relational database. 
Constrains: In SQL, we have the following constraints- 
NOT NULL - Indicates that a column cannot store NULL 
value UNIQUE - Ensures that each row for a column 
must have a unique value 
CHECK - Ensures that the value in a column meets a 
specific condition 
DEFAULT - Specifies a default value for a column 
Primary Key uniquely identifies a record in a table. 
A candidate key is a single field or the least 
combination of fields that uniquely identifies each 
record in the table. 
A foreign key is generally a primary key from one table 
that appears as a field in another. 
DDL: Data Definition Language is used for specifying 
the database schema. It contains commands to create 
tables, alter the structure, delete tables or rename tables. 
E.g. Create DML: Data Manipulation Language is used 
for accessing and manipulating data in a database. E.g. 
Select, Update 
DCL: Data Control Language is used for granting and 
revoking user access on a database. 

 

 

                       
 

 
TCP Transmission Control Protocol 
FTP File Transfer Protocol 

TFTP Trivial File Transfer Protocol 
SFTP Secure File Transfer Protocol 

FULL FORMS & ABBREVIATIONS 
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SMTP Simple Mail Transfer Protocol TFT Thin Film Transistor 
HTTP Hyper Text Transfer Protocol CRT Cathode Ray Tube 
HTTPS Hyper Text Transfer Protocol Secure MIDI Musical Instrument Digital Interface 
UDP User Datagram Protocol MPEG Moving Picture Expert Group 
ARP Address Resolution Protocol PDA Personal Digital Assistants 
Tel Net Telecommunication Networking PDF Portable Document Format 
POP3 Post Office Protocol Version3 ARPANET Advanced Research Projects Agency 
BGP Border Gateway Protocol  Network 
P2P Point to Point Protocol SQL Structured Query Language 
PPP Peer to Peer Protocol USB Universal Serial Bus 
IP Internet Protocol VIRUS Vital Information Resource Under Siege 
SNMP Simple Network Management Protocol VOIP Voice Over Internet Protocol 
NTP Network Time Protocol IVR Interactive Voice Response 
SIP Session Initiation Protocol WIFI Wireless fidelity 
DHCP Dynamic Host Configuration Protocol WIMAX Worldwide Interoperability for Microwave 
IMAP4 Internet Message Access Protocol Version  Access 
 4 ADSL Asymmetric Digital Subscriber Line 
RARP Reverse Address Resolution Protocol API Application Program Interface 
SSH Secure Shell ARP Address Resolution Protocol 
MIME Multipurpose Internet Mail Extension RARP Reverse ARP 
SMIME Secure MIME ICANN Internet Corporation of Assign Names & 
ALGOL Algorithmic Language  Numbers 
ANSI American National Standard Institute DPI Dots Per Inch 
ATM Asynchronous Transfer Mode   

AS Autonomous System   

BASIC Beginners All Purpose Symbolic   

 Instruction Code   

BIOS Basic input Output System 
BPS bit Per Second 
DNS Domain Name Server 
EDI Electronic Data Interchange 
URL Uniform Resource Locator 
GIF Graphics Interchange Format 
ASCII American Standard Code for Information 

Interchange 
ASP Active Server Pages 
BCC Blind Carbon Copy 
CC Carbon copy 
CAD Computer Aided Design 
CDMA Code Division Multiple Access 
GSM Global System for Mobile Communication 
CMOS Complementary Metal Oxide Semi- 

Conductor 
CMYK Cyan Magenta Yellow Block 
GPS Global Positioning System 
GUI Graphical User Interface 
HDMI High Definition Multimedia Interface 
GIGO Garbage in Garbage Out 
LIFO Last In First Out 
FIFO First In First Out 
PING Packet Internet Gopher 
HDD Hard Disc Drive 
NIC Network Interface Controller/Cord 
HDTV High Definition Television 
ISP Internet Service Provider 
JPEG Joint Picture Expert Group 
LCD Liquid Crystal Display 
LED Light Emitting Diode 

 

 

 
 

 

 

 
 

 

 
 

 

 

 
DSL Digital Subscriber Line 
FAT File Allocation Table 
MANET Mobile Ad-Hoc Network 
MIPS Million Instruction Per Second 
BIPS Billion Instruction Per Second 
TIPS Trillion Instruction Per Second 
NAT Network Address Translation 
IEEE Institute of Electrical and Electronic 

Engineer 
IMAP Internet Message Access Protocol 
ISDN Integrated Servers Digital Network 
ISO International Standard Organization/ 

International Org for Standardization 
DHTML Dynamic Hyper Text Markup Language 
MAC Media Access Control 

 

CAN Campus Area Network  PCB Printer Circuit Board 
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PAN Personal Area Network  SRAM Static RAM 
SAN Storage Area Network  DRAM Dynamic RAM 
CNM Circulatory Network Mode  PROM Programmable ROM 
IPV4 Internet Protocol Version 4  EPROM Electrically PROM 
IPV6 Internet Protocol Version 6  EEPROM Electrically Erasable PROM 
DBMS Data Base Management System  HDD Hard Disc Drive 
MODEM Modulator Demodulator  FDD Floppy Disc Drive 
RAM Random Access Memory  CD Compact Disc 
ROM Read Only Memory  DVD Digital Video/Versatile Disc 
SMPS Switch Mode Power Supply  BRD Blu Ray Disc 
OMR Optical Mark Reader / Recognition  HVD Holographic Versatile Disc 
OCR Optical Character Reader / Recognition  ACID Atomicity Consistency Isolation Durability 
BCR Bar Code Reader  WYSIWYG What you see is what you get 
MICR Magnetic Ink Character Reader /   

 Recognition    

 

GLOSSARY 
 

A 
• Access time - The amount of time it takes for requested 

information to be delivered from disks and memory. 
• Antivirus software - A program designed to look for 

and destroy viruses that may infect the memory of a 
computer or files stored on a computer. 

• Artificial intelligence (AI) - Computer systems that 
attempt to imitate human processes for analyzing and 
solving problems. 

• Accumulator - A local storage area called a Register, in 
which the result of an arithmetic or logic operation is 
formed. 

B 
• BIT - It is basic unit of computers. It has two values 1 & 0 

only. 
• BYTE - Combination of 8 Bits. 
• Basic Input Output System (BIOS) - Also known as 

ROM BIOS. It provides an abstraction layer for the 
hardware, i.e., a consistent way for application programs 
and operating system to interact with input/output 
devices. 

• Bug - A software bug is an error, flaw, failure, or fault in 
a computer program or system produces an incorrect or 
unexpected result. 

• Bus - A pathway along which electronic signals travel 
between the components of a computer system. 

C 
• Cookie - A packet of information that travels between a 

browser and the web server. 
• Crash - Your computer or application no longer works 

correctly and so you “loose” all the work you’ve done 
since the last time you saved. 

• Command - An instruction that causes a program or 
computer to perform a function. 

• Cache - It is a memory storage area that keeps frequent 
use data readily available to the computer so that the 
computer does not retrieve them from slow storage 
devices. 

• Clock Speed - The speed of computer is measured in 
clock speed. High clock speed is synonymous with high 
processing capability. It is measured in Megahertz 
(MHz). 

• Column - A vertical block of cells in a table or 
spreadsheet. 

D 
• Delete - To remove an item of data from a file or to 

remove a file from the disk. 
• Debugging - Locating and eliminating defects in a 

program. 

• Desktop - The electronic work area on a display screen. 
• Dots Per Inch (DPI) - It is defined as the measure of the 

resolution of a printer and scanner, or monitor. 
• Domain Name - A unique name that identifies a 

particular website and represents the name of the server 
where the web pages reside. 

E 
• Edit - To make certain changes in existing data. 
• Ethernet Card - A network adapter that enables a 

computer to connect to an Ethernet. 
 

F 
• Fax - A shortened form of the word facsimile. A copy of a 

document transmitted electronically from one machine 
to another. 

• File transfer protocol (FTP) - A set of guidelines or 
standards that establish the format in which files can be 
transmitted from one computer to another. 

• Firewall - A security system usually consisting of 
hardware and software that prevents unauthorized 
persons from accessing certain parts of a program, 
database, or network. 

• Flash Memory - It is a type of non-volatile computer 
storage chip that can be electrically erased and 
reprogrammed. It was developed by EEPROM. 

G 
• Gateway - A machine that links two networks using 

different protocols. 

• Gigabyte - A measurement of the storage capacity of a 
device. One gigabyte represents 1024 megabytes. 

• Google – search engine on the web. 
• Gopher - A protocol used for locating and transferring 

information on the internet. It is an internet search tool 
that allows users to access textual information. 
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• GUI - Graphical User Interface uses icons and menus to 
carry out commands such as opening files, delete files, 
move files etc.. 

• Graphic Interchange Format (GIF) - A simple file 
format for pictures and photographs that are 
compressed so that they can be sent quickly. 

H 
• Hard copy - Text or graphics printed on paper; also 

called a printout. 
• Hard disk - A rigid type of magnetic medium that can 

store large amounts of information. 
• Hyperlink - An image or portion of text on a webpage 

which is linked to another webpage. 
• Hub-A network device that connects multiple computers 

on a LAN so that they can communicate with another 
network and the internet. 

• Header - Repetitive information that appears at the top 
(the head) of every page of a document. 

• Hypertext transfer protocol (HTTP) - The protocol 
used on the World Wide Web that permits Web clients 
(Web browsers) to communicate with Web servers 

I 
• Icons-In a graphical user interface (GUI), a small, 

pictorial, on screen representation of an object, such as a 
document, program, folder or disk drive. 

• Instant messaging (IM) - A chat program that lets 
people communicate over the Internet in real time. 

• Internet protocol (IP) address - A unique set of 
numbers that identifies a computer over a network. 

• Internet service provider (ISP) - An organization that 
provides access to the Internet for a fee. 

• Intranet - A private network established by an 
organization for the exclusive use of its employees. 
Firewalls prevent outsiders from gaining access to an 
organization’s intranet 

J 
• JPEG - Joint Photographic Experts Group. A format for 

storing complex graphics in compressed form. 
• Justification - Aligning lines of text at the left margin, 

the right margin, both margins, and the centre. Text 
aligned at both margins is considered fully justified. 

K 
• Keyboard - The device used to enter information into a 

computer. 
• Kilobyte - A measurement of the storage capacity of a 

device. One kilobyte represents 1024 bytes. 
L 

• LAN - A local area network (LAN) is a computer network 
that interconnects computers within a limited area such 

as a home, school, computer laboratory, or office 
building, using network media. 

• Laptop computer - A portable computer. Also known as 
a notebook computer. 

• Landscape Orientation – The positioning of the page so 
that the information is printed across the long 
dimension of the page. 

• Liveware - It is a term to describe the human system, 
opposed to hardware or software in a computer. 

M 
• Macro virus - A type of virus that attaches itself to 

documents or word processing templates. 

• Malware - Software that disrupts normal computer 
functions or sends a user’s personal data without the 
user’s authorization. 

• Memory - The part of a computer that stores 
information. 

• Memory Cell - A circuit in memory that represents a 
single bit of information. 

• Mass Storage - Storage systems that provide access to 
hundreds of billions of bytes of stored data. They are 
often referred to as Archival Storage because of the very 
large volumes of historical or backup data they can store. 

• MIPS - An acronym derived from millions of instructions 
per second. Used to measure the speed of a processor. 

• Morphing - The transformation of one image into 
another image. 

• Mobile Commerce (m-Commerce) - A form of e- 
commerce that has the ability to conduct monetary 
transactions via a mobile device such as a cell phone. 

• Mozilla - a web browser and successor to Netscape 
Communicator. 

• Multitasking - The ability of a computer to execute 
more than one program at a time. 

N 
• NIBBLE - Combination of four bits. 
• Network - A system of interconnected computers. They 

are of three types i. e. LAN, MAN, WAN. 
• Network Interface Card (NIC) - This is a part of the 

computer that allows it to talk to other computers via a 
network protocol like TCP/IP. 

• Node - A computer which is attached to the network. 
Each node has its own address on the network so that it 
can be uniquely identified and can communicate with 
other nodes on the same or different network. 

O 
• Offline - Refers to the state in which a computer is 

temporarily or permanently unable to communicate 
with another computer. 

• Online - Refers to the state in which a computer is ready 
to communicate with other computers. 

• Open source software - Software that makes the 
underlying source code available to all users at no 
charge. 

• Operating system (OS) - Software that manages the 
internal functions and controls the operations of a 
computer. 

P 
• Palmtop computer - A portable computer smaller than 

a notebook (or laptop) computer that fits on the palm of 
your hand. Also called a handheld computer. 

• Password - A user’s secret identification code, required 
to access stored material. A procedure intended to 
prevent information from being accessed by 
unauthorized persons. 

• Piracy - The illegal copying of software or other creative 
works. 

• Peripherals - A connectable device that has an auxiliary 
function outside the permanent system configuration 
such as plotters, printers and graphic displays. 

• Phishing - A type of computer fraud that tries to trick 
users into revealing their passwords and other 
confidential information. 
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• Pixel - A smallest picture element of a digital image. The 
smaller the pixels, the higher the resolution. 

• Port - An electrical connection on the computer into 
which a cable can be plugged so that the computer can 
communicate with other devices such as printer or 
modem. 

• Protocol - A set of rules and regulations that 
coordinates the exchange of information over the 
network. 

• Portrait orientation - Positioning paper so that 
information is printed across the short dimension of the 
paper. 

Q 

• Query - An alternate pipe form of operating system, 
which handles data in the form of messages rather than 
bytes. 

• Qwerty - It is one of the standard computer keyboard, 
with the character Q, W, E, R, T, Y on the top row of 
letters on the keyboard. 

R 

• Response time - The time a computer takes to execute a 
command. 

• Retrieve - To call up information from memory or 
storage so that it can be processed in some way. 

• Record - A collection of all the information pertaining to 
a particular subject. 

• Row - A horizontal block of cells in a table or 
spreadsheet. 

• Resolution - Measurement of the degree of sharpness of 
a displayed image. It is defined as number of pixels per 
square inch on a computer generated display. 

• Register - A temporary storage unit for quick, direct 
accessibility of a small amount of data for processing. 

S 

• Save As – Give the file a name and/or store the file in a 
certain place. 

• Save - Tell the computer to create a file on disk that has 
the information you’ve put into the document. 

• Scroll bar - Allows you to move around through your 
document. 

• Shut down - To quit all applications and turn off the 
computer. 

• Spam - unwanted repetitious messages, such as 
unsolicited bulk e-mail. 

• Scanner - An input device that can copy a printed page 
into a computer’s memory, thus doing away with the 
need to type the copy. 

• Screen saver - A program that changes the screen 
display while the user is away from the computer. 

• Server - A computer that manages a shared resource 
and provides a set of shared user services to the clients. 

• Search Engine - Software that searches, gathers and 
identifies information from a database based on an 
index, keywords or titles. 

• Spam - Unwanted repetitious messages, such as 
unsolicited bulk e-mail. 

• Soft copy - Information shown on the display screen. 
• Sort - To arrange fields, records, or files in a 

predetermined sequence. 
• Surfing the Net - Browsing through various Web sites 

on the Internet in search of interesting things. 
T 

• Trash - Place where you put files and folders that you 
want to delete or get rid of. 

• Topology - The structure of the network, including 
physical connections such as wiring schemes and logical 
interactions between network devices. 

• Track - A ring on a disk where data can be written. 
• Telnet - A protocol for remote computing on the 

internet that allows a computer to act as a remote 
terminal on another machine, anywhere on the internet. 

• Touchpad - The device on a laptop computer that takes 
the place of a mouse. 

• Touch screen technology - The technology that permits 
a user to perform a function simply by touching the 
screen on an appropriate spot. 

U 

• Uninterrupted Power Supply (UPS) - A Battery 
powered backup system that provides enough electricity 
to a computer during a power outage so that a user can 
save files before shutting down the computer. 

• Universal Serial Bus (USB) - A common standard for 
connecting multiple peripherals to a computer as 
needed. 

• Upload - To transfer information from a client computer 
to a host computer. 

V 
• Virus - A piece of computer code designed as a prank or 

malicious act to spread from one computer to another by 
attaching itself to other programs. 

W 
• WAP - Wireless Application Protocol is a specification 

for a set of communication protocol used to allow 
wireless devices to access the internet and other 
utilities. 

• Web browser - Software that permits a user with a 
click of a mouse to locate, display, and download text, 
video, audio, and graphics stored in a host computer 
on the Web. The most common Web browsers now in 
use are Internet Explorer, Google Chrome and Mozilla 
Firefox. 

• Web site - One or more related pages created by an 
individual or an organization and posted on the World 
Wide Web. 

• Wi-Fi (Wireless fidelity) - A process that permits high- 
speed wireless transmission of data. 

• Word processing - The electronic process of creating, 
formatting, editing, proofreading, and printing 
documents. 

• Workstation - A desktop computer that runs 
applications and serves as an access point in a local area 
network. 

Z 
• Zombie - A computer that has been hijacked by a 

cracker without the owner’s knowledge and used to 
perform malicious tasks on the Internet. 
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PROGRAMMING LANGUAGE 
 

PROGRAMMING LANGUAGE 
 

Programming Language are coded language are 
coded language used by programmer to write 
instructions that a computer can understand to 
what the Programmer want. 
 

Following are the major categories of 
Programming Languages − 
• Machine Language 
• Assembly Language 
• High Level Language 
• System Language 
• Scripting Language 
 
Pseudo code -  
Pseudo code is a simple way of writing 
programing code in english. 
 

For example – Task – Add two Numbers --- 
• Start 
• Get two numbers  
• Add them 
• Print the answer  
• End  
 
Flow chart  
 

A flow chart is a graphical or symbolic 
representation of a process. Each step in the 
process is represented by a different symbol and 
contains a short description of the process step. 
Different flow chart symbols have different 
meanings. The most common flow chart symbols 
are: 
• Terminator: An oval flow chart shape 

indicating the start or end of the process. 
• Process: A rectangular flow chart shape 

indicating a normal process flow step. 
• Decision: A diamond flow chart shape 

indication a branch in the process flow. 
• Connector: A small, labeled, circular flow 

chart shape used to indicate a jump in the 
process flow. (Shown as the circle with the 
letter "A", below.) 

• Data: A parallelogram that indicates data 
input or output (I/O) for a process. 

• Document: Used to indicate a document or 
report (see image in sample flow chart 
below). 

 
What is Algorithm 
 

An algorithm is a well-defined procedure that 
allows a computer to solve a problem. Another 
way to describe an algorithm is a sequence of 
unambiguous instructions. ... In fact, it is difficult 
to think of a task performed by your computer 
that does not use algorithms. 
Sequence of program –  
 

• Algorithm  
• Flowchart  
• Program (source code) 
• Compiling  
• Object code 
 

What is syntax -    way to write any instruction in 
any programming language with the help of some 
special symbols and character.  
 

Types of Programming Language 
 

 
 

• Machine language  
Machine language is written in binary 
language. It is consists of 0s and 1s. Machine 
language is dependent programming 
language. It is first generation programming 
language. It does not require translator. 
Machine Language is easy to understand for 
computer but difficult to programmer. 
The program is written in machine is called 
object code. 
It has two part – 
Opcode – Operation code – an opcode is a 
single instruction that can be executed by the 
CPU. 
Operand (address part) – operands are 
manipulated by opcode  
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• Assembly Language -  
Assembly language used mnemonic code in 
place of binary language. It is second 
generation programming language. An 
assembly language is a low-level 
programming language designed for a specific 
type of processor. Assembly languages 
generally lack high-level conveniences such as 
variables and functions. 

 

• High level Language -  
A high-level language (HLL) is a programming 
language such as C, FORTRAN, or Pascal that 
enables a programmer to write programs that 
are more or less independent of a particular 
type of computer. It is independent 
programming language. It is third Generation 
programming language. The program is 
written in high level is called source code. 
FORTAIN was first high level language. 

 
 

➢ FORTRAN 
Full form Formula Translation. It was first 
high-level language. It was introduced by John 
Backus in 1957. It is used for scientist and 
engineers. 

 

➢ ALGOL 
ALGOL is short for algorithmic language. It is 
an early high-level computer programming 
language devised to carry out scientific 
calculations. ALGOL was used as the standard 
method for creating algorithms. First 
appeared in 1958. ALGOL language designed 
by: Friedrich L. Bauer, Hermann Bottenbruch 

 

➢ COBOL 
The name COBOL stands for Common 
Business-Oriented Language. COBOL is a 
programming language that was developed in 
the year 1959.  It was one of the first 
computer programming languages used for 
commercial. It was introduced by Grace 

Hopper. 
 

➢ BASIC(Beginner's All-purpose Symbolic 
Instruction Code)  
BASIC. Stands for "Beginner's All-purpose 
Symbolic Instruction Code”. BASIC is a 
computer programming language that was 
developed in the mid-1960s to provide a way 
for students to write simple computer 
programs. In 1964, John G. Kemeny and 
Thomas E. Kurtz designed the original BASIC 
language at Dartmouth College. 

 

➢ Pascal  
Pascal is an imperative and procedural 
programming language, designed by Niklaus 
Wirth as .... Apollo Computer used Pascal as 
the systems programming language for its 
operating systems beginning in 1980. It is 
named in honor of the French mathematician, 
philosopher and physicist Blaise Pascal. 

 

➢ C Language 
C is a general-purpose, procedural computer 
programming language supporting structured 
programming, lexical variable scope, and 
recursion, while a static type system prevents 
unintended operations. C was developed at 
Bell Labs by Dennis Ritchie for the Unix 
Operating System in the early 1970s. It is also 
called middle level language. 

 

➢ C++ Language 
C++ is a High-level programming language 
developed by Bjarne Stroustrup starting in 
1979 at Bell Labs.  C++ runs on a variety of 
platforms, such as Windows, Mac OS, and the 
various versions of UNIX. This C++ tutorial 
adopts a simple and practical approach to 
describe the concepts of C++ for beginners to 
advanced software engineers. C++ fully 
supports object-oriented programming, 
including the four pillars of object-oriented 
development. 

 

➢ JAVA 
Java is a programming language and a 
platform. Java is a high level, robust, object-
oriented and secure programming language. 
Java is introduced by James Gosling. Java is 
used many application like ………. 
1. Desktop Applications such as acrobat 
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reader, media player, antivirus, etc. 
2. Web Applications such as irctc.co.in, 

javatpoint.com, etc. 
3. Enterprise Applications such as banking 

applications. 
4. Mobile 
5. Embedded System 
6. Smart Card 
7. Robotics 
8. Games, etc. 

➢ PERL(Practical Extraction and Reporting 

Language) 

Perl is a general-purpose programming 

language originally developed for text 

manipulation and now used for a wide range 
of tasks including system administration, web 

development, network programming, GUI 

development, and more. Perl was originally 

developed by Larry Wall in 1987. Stand for 
"Practical Extraction and Reporting Language 

 

➢ Python  

Python is a general purpose and high level 

programming language. You can use Python 

for developing desktop GUI applications, 
websites and web applications. It is 

introduced by Guido van Rossum. 
 

➢ C# Language 

C# can be used to create almost anything but 

is particularly strong at building Windows 
desktop applications and games. C# can also 

be used to develop web applications and has 

become increasingly popular for mobile 

development too. It is developed by Microsoft. 
C# is an object-oriented programming 

language used with XML-based Web services 

on the .NET platform and designed for 

improving productivity in the development of 

Web applications. 
 

Scripting Language  
 

Scripting languages are server-side scripting 

languages that manipulate the data, usually in a 

database, on the server. Scripting languages came 

about largely because of the development of the 

Internet as a communications tool.  
Html, Xml, JavaScript, ASP, JSP, PHP, Perl, Tcl and 

Python are examples of scripting languages. 
 

Language Translator –  
 

Language translator is a program which is used to 

translate instructions that are written in the 

source code to object code i.e. from high-level 
language or assembly language into machine 

language. 
There are 3 different types of translators as 
1. Assembler- Assembler are used to convert 

assembly language code into machine code.  
Assembler convert mnemonic code in to 
object code. 

2. Compiler- Compiler translate high level 
language in machine language. It read the 
entire program. It finds the syntax error. 
Error in a program is called bug. Compiler 
convert source code into object code. 

3. Interpreter- An interpreter translates high-
level instructions into an intermediate form, 
which it then executes.  It reads the program 
line by line. In contrast, a compiler translates 
high-level instructions directly into machine 
language. Compiled programs generally run 
faster than interpreted programs. 

 

 
 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

https://www.adda247.com/activity/DAILY_QUIZZES
https://www.adda247.com/activity/PYP
https://www.adda247.com/activity/MAGAZINES
https://www.adda247.com/product-testseries/79075/test-prime?productId=79076


IBPS RRB Computer Capsule 2025 (PO and Clerk) 

 

 

91 
 

                                   
 

 Important Questions Based on Microsoft Office:  
 

1. Microsoft Office is a __________. 
A) Shareware B) Public-domain software 
C) Open source software D) An application suit 
E) Firmware 

2. Which term is not related with font? 
A) Font face B) Font size C) Font color 
D) Font grammar E) None of these 

3. The valid format of MS Word is __________. 
A) .jpeg B) .png C) .doc 
D) .exe E) None of these 

4. Which of the following option may be used to change 
page-size and margins? 
A) Page Layout B) View C) Tools 
D) Data E) None of these 

5. To justify the selected text, the shortcut key is 
__________. 
A) Ctrl + 1 B) Ctrl + J C) Ctrl + U 
D) Ctrl + Alt + K E) None of these 

6. Workbook is a collection of __________ in MS Excel? 
A) page set-up B) buttons C) diagrams 
D) charts E) worksheets 

7. In order to move from one worksheet to another in 
MS-Excel workbook. One should click ___________. 
A) active cell B) scroll bar C) sheet tab 
D) tab button E) None of these 

8. In a spreadsheet, a __________ is a number you will use 
in a calculation. 
A) label B) cell C) field 
D) value E) None of these 

9. In Power Point, which of the following will not 
advance the slides in a slide show view? 
A) Esc key B) The spacebar 
C) The Enter key D) The mouse button 
E) None of these 

10. In Microsoft PowerPoint, two kinds of sound 
effects files that can be added to the 
presentation are 
A) .wav files and .mid files 
B) wav files and .gif files C) wav files and .jpg files 
D) jpg files and .gif files E) None of these 

11. Which PowerPoint view displays each slide 
of the presentation as a thumbnail and is 
useful for rearranging slides? 
A) Slide Sorter B) Slide Show C) Slide Master 
D) Notes Page E) Slide Design 

12. If you want to insert a chart to your slide then go 
to 
__________. 
A) Insert – Chart B) Home – Chart C) Format – 

Chart 
D) Table – Chart E) None of these 

13. Which of the following is not a type of 
Microsoft access database object? 
A) Table B) Worksheets C) Modules 
D) Macros E) None of these 

14. Row in an Access table is also known as __________. 
A) field B) record C) data 

D) type E) None of these 
15. Queries in Access can be used as __________. 

A) View, change and analyse data in different ways 
B) A source of records for forms and reports 
C) to access internet D) Both a and b 
E) None of these 

16. Pressing F8 key for three times selects 
A) A word B) A sentence C) A paragraph 
D) Entire document E) None of these 

17. What happens if you press Ctrl + Shift + F8? 
A) It activates extended selection 
B) It activates the rectangular selection 
C) It selects the paragraph on which the insertion line is. 
D) Both (A) and (C) E) None of these 

18. How can you disable extended selection mode? 
A) Press F8 again to disable 
B) Press Del to disable C) Press Esc to disable 
D) Press Enter to disable E) It cannot be disables 

19. What does EXT indicator on status bar of MS 
Word indicate? 
A) It indicates whether the external text is pasted on 
document or not 
B) It indicates whether extended add-ons are installed 
on MS Word or not 
C) It indicates whether Extended Selection mode 
is turned on or off 
D) Both (A) and (B) E) None of these 

20. What is the maximum number of lines you can 
set for a drop cap? 
A) 3 B) 10 C) 15 
D) 20 E) 50 

21. What is the default number of lines to drop for 
drop cap? 
A) 3 B) 10 C) 15 
D) 20 E)7 

22. What is the shortcut key you can press to create 
a copyright symbol? 
A) Alt+Ctrl+C B) Alt + C C) Ctrl + C 
D) Ctrl + Shift + C E)None of these 

23. How many columns can you insert in a word 
document in maximum? 
A) 35 B)63 C) 55 
D) 65 E) 60 

24. What is the smallest and largest font size available 
in Font Size tool on formatting toolbar? 
A) 8 and 72 B) 8 and 64 C) 12 and 72 
D) 10 and 40 E) None of these 

25. Select all the text in MS Word document by: 
A) Ctrl + S B) Ctrl + 1 C) Shift + A 
D) Ctrl + A E) None of these 

26. MS Word is __________ software. 
A) System B) Application C) Programming 
D) Compiler E) None of these 

27. The shortcut key for paste selected text/picture 
in MS Word is __________. 
A) Ctrl + X B) Ctrl + C C) Ctrl + V 
D) Ctrl + Z E) None of these 
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28. Using Print Preview is useful. When you want to 
A) colour the document B) save the document 
C) delete the document D) copy the document 
E) view how the document will appear when printed 

29. To indent the first paragraph of your report, you 
should use this key. 
A) Space bar B) Return key C) Tab key 
D) Shift key E) None of these 

30. In Excel, the contents of the active cell are displayed 
in the ________. 
A) footer bar B) tool bar C) task bar 
D) menu bar E) formula bar 

31. __________ appear at the bottom of the Excel Window. 
A) Work sheet tabs B) Name box C) Formula bar 
D) Title bar E) None of these 

32.  

33. In MS excel ________ are numbered from 1 to 
onwards and __________ are numbered from A 
to onwards. 
A) Columns, rows B) Rows, slides C) Slides, rows 
D) Rows, columns E) None of these 

34. What is the default column width of MS Excel? 
A) 5.5 B) 2.98 C) 8.43 
D) 6.49 E) None of these 

35. To insert a new slide go to __________ tab, in the 
Slides group, click New Slide. 
A) Home B) View C) Animations 
D) Slide show E) None of these 

36. Times new Roman, Cambria, Arial are the 
example of 
__________. 
A) Font face B) Themes C) SmartArt 
D) Clipart E) None of these 

37. In Access a __________ is the collection of data 
items of all the fields pertaining to one 
entity. 
A) field B) record C) form 
D) report E) None of these 

38. A table of how many columns can you 
insert in a word document in maximum. 
A) 55 B) 42 C) 32 
D) 63 E) As you wish 

39. In MS Access a __________ name must be unique 
within a database. 
A) Field B) Record C) Table 
D) Character E) None of these 

40. The minimum number of rows and columns 
in MS Word document is 
A) 1 and 1 B) 2 and 1 C) 2 and 2 
D) 3 and 3 E) None of these 

41. Thesaurus tool in MS Word is used for 
A) Spelling suggestions B) Grammar options 
C) Synonyms and Antonyms words 
D) All of the above E) None of these 

 
42. Why Drop Caps are used in document? 

A) To drop all the capital letters 
B) To automatically begin each paragraph with 
capital letter 

C) To begin a paragraph with a large dropped 
initial capital letter 
D)To drop the numbers 
E) None of these 

43. A bookmark is an item or location in 
document that you identify as a name for 
future reference. Which of the following 
task is accomplished by using 
bookmarks? 
A) To add anchors in web page 
B) To mark the ending of a paragraph of document 
C) To quickly jump to specific location in 

document 
D) To add hyperlinks in webpage 
E) None of these 

44. A word processor would most likely be used to 
do 
A) Keep an account of money spent 
B) Do a computer search in media center 
C) Maintain an inventory 
D) Type a biography 

E) Maintain records of database 
45. Which of the following is not valid version of 

MS Office? 
A) Office XP B) Office Vista C) Office 2007 
D) Office 2010 E) None of these 

46. You cannot close MS Word application by 
A) Choosing File menu then Exit submenu 
B) Press Alt+F4 
C) Click X button on title bar 
D) From File menu choose Close submenu 
E) None of these 

47. The key F12 in MS Word opens a 
A) Save As dialog box B) Open dialog box 
C) Save dialog box D) Close dialog box 
E) Opens help menu 

48. What is the short cut key to open the Open 
dialog box? 
A) F12 B) Shift F12 C) Alt + F1 
D) Ctrl + F12 E) None of these 
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46. Which of the following symbol sets would be most 
likely to contain a mathematical symbol such as a 
degree sign, greater than or equal to, or a Greek 
letter? 
A) Wingdings B) Wingdings 3 C) Webdings 
D) Symbol E) Arial 

47. When assigning a shortcut key to a symbol, you 
should always try to select a key or key combination 
that is: 

A)  

B) Regret B) Subdual 
C) We regret to inform you that your 
submission has been declined 
D) 11 E) None of these 

49. If you want to convert a symbol or several 
lines of text into an AutoCorrect entry, you 
should: 
A) Insert the symbol or type the text in a 
Word document first. Then, select the text 
or symbol and go to the AutoCorrect dialog 
box. 
B) Click the Tools menu and choose 
AutoCorrect Options. Then, click the Insert 
menu and choose Symbol (or click the Format 
menu and choose Paragraph) to add the symbol 
or paragraph to AutoCorrect. 
C) AutoCorrect can only accommodate one line of 
text. It is not possible to convert a symbol or 
multiple lines of text into an AutoCorrect entry. 
D) Insert the symbol or type the text in a Word 
document first. Then, select the text or symbol 
and click the Edit menu followed by Paste 
Special. Select New AutoCorrect Entry and then 
click OK. 
E) None of the above 

50. AutoCorrect was originally designed to replace 
_________ words as you type. 
A) Short, repetitive B) Grammatically incorrect 
C) Misspelled words D) Incorrect Image 
E) None of the above 

51. Which of the following is the second step in 
creating a macro? 
A) Start recording 
B) Using your mouse or keyboard, perform the 
task you want to automate 
C) Assign a keyboard shortcut to the macro 
D) Give the macro a name 
E) None of these 

52. If you will be displaying or printing your 
document on another computer, you’ll want 
to make sure and select the _____________ 
option under the ‘Save’ tab. 
A) Embed Fonts B) Embed True 
Type Fonts 
C) Save True Type Fonts D) Save Fonts 
E) Font Face 

53. In Word, the mailing list is known as the 
____________. 
A) Data sheet B) Source C) Data source 

D) Sheet E) Hyperlink 
54. To delete 3-D rotation from the shape, point 

to 3-D Rotation, and then click _____. 
A) Non Rotation B) Not Rotation C) None Rotation 
D) No Rotation E) None of these 

 
A) Unassigned 
55.  
56. In Microsoft Office Power-Point 2007, a 

 
_____ is a 

 
B) Located on the ten-key pad section of your keyboard. 
C) Assigned to another task. 
D) From the same font family as the symbol. 
E) None of these 

48. Suppose you wanted to create an AutoCorrect 
entry that would type the words ‘We regret to 
inform you that your submission has been 
declined’ of the following choices, which would be 
the best name you could assign to this entry? 

 
connection from one slide to another slide in 
the same presentation or to a slide in 
another presentation, an e-mail address, a 
Web page, or a file. 

 
A) Hyphenation       B) Header C) Footer 
D) Hyperlink E) None of these 

 
56. In PowerPoint, which of the following is the default 

page setup orientation for notes pages, outlines and 
handouts? 
A) Vertical B) Landscape C) Portrait 
D) All of these E) None of these 

57. In slide layout panel, how many layouts are available 
for next layout by default? 
A) 4 B) 7 C) 12 
D) 15 E) None of these 

58. In Access, this operation copies a backup file from the 
storage medium back onto the computer : 
A) Restore B) Recreate C) Copy 
D) Structure E) None of these 

59. In the Form Wizard dialog box, the fields from the 
selected table are displayed in which list box? 
A) All fields B) All Records 
C) Available Records D) Available Fields 
E) None of these 

60. Which control does access use to link data access page 
components to access data? 
A) Microsoft Office Data Source Control 
B) Microsoft Dynamic Data Control 
C) Microsoft Data Connection Control 
D) Microsoft Default Connection Control 

None of the above 
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Miscellaneous Questions on Computer Knowledge 
 

1. CD-ROM is a _______? 
(a) Semiconductor memory (b) Memory registers 
(c) Magnetic memory (d) Cache Memory 
(e) None of the above 

2. Actual execution of instructions in a computer takes place in? 
(a) ALU (b) Control Unit (c) Storage unit 
(d) Control bus (e) None of the above 

3. Modem stands for _______. 
(a) A type of secondary memory 
(b) Modulator demodulator 
(c) Mainframe operating device memory 
(d) Multiprocessing device 
(e) None of the above 

4. _______ Controls access to the resources on a network. 
(a) Server (b) Client 
(c) Both ((a) and (b) (d) Memory 
(e) None of the above 

5. The wider the bus, the _______ the transfer of data 
(a) Greater the number of transfer steps required and the 
slower 
(b) Greater the number of transfer steps required and the 
faster 
(c) Fewer the number of transfer steps required and the 
slower 
(d) Fewer the number of transfer steps required and the faster 
(e) None of the above 

6. What does 'GIF' Stands for? 
(a) Graphics Interchange Format 
(b) Geo Interchange Format 
(c) Graphical Interconnection Format 
(d) Graphics Interlace Format 
(e) Graphics Interchange File 

7. Cache and main memory will lose their contents when the 
power is off. They are _______. 
(a) dynamic (b) static (c) volatile 
(d) non-volatile (e) faulty 

8. How can the user determine what programs are available 
on a computer ? 
(a) Checking the hard disk properties 

(b) Viewing the installed programs during the 
booting process 
(c) Checking the operating system for a list of 
installed programs 
(d) Checking the existing files saved on the disk 
(e) None of these 

9. Processing involves ________. 
(a) inputting data into a computer system 
(b) transforming input into output 
(c) displaying output in a useful manner 
(d) providing relevant answers 
(e) None of these 

10. Which process checks to ensure the components of the 
computer are operating and connected properly? 
(a) Booting (b) Processing (c) Saving 
(d) Editing (e) None of these 

11. What kind of programming language is Java? 
(a) Object-oriented programming language 
(b) Relational programming language 
(c) Sixth-generation programming language 
(d) Database management programming language 
(e) None of these 

12. Formatting a disk results in all the data being? 
(a) Saved to the disk (b) Copied from the disk 
(c) Deleted from the disk 
(d) All of the above (e) None of the above 

13. What type of web technology creates an online 
community where people can make statements and 
others can read and respond to those statements? 
(a) I-Journal (b) Podcast (c) ASP 
(d) Blog (e) None of these 

14. What is a common medium used for thieves to steal 
others' identities? 
(a) Telephone (b) Pick pocketing 
(c) Burglary (d) Email 
(e) None of the above 

15. Application software? 
(a) Is used to control the operating system 
(b) Is designed to help programmers 
(c) Performs specific task for computer users 
(d) Is used for making design only 
(e) All of the above 

16. A set of instruction telling the computer what to do is called? 
(a) Mentor (b) instructor (c) compiler 
(d) program (e) debugger 

17. A __________ is anything that can cause harm. 
(a) vulnerability (b) redundancy (c) Spam 

(d) threat (e) None of the above 
18. A __________ is a small program embedded inside of a GIF image. 

(a) web bug (b) cookie (c) spyware application 
(d) spam (e) None of the above 

19. When you save an Microsoft Access project, what file format 
do you use? 
(a) .adp (b) .Xml (c) .mbd 
(d) All of these (e) None of the above 

21. To select a column the easiest method is to? 
(a) double click any cell in the column 

(b) drag from the top cell in the column to the last cell in 
the column 
(c) click the column heading 
(d) click the row heading 
(e) None of the above 

22. 30,000 bytes is equal to 
(a) 30 KB (b) 3 MB (c) 3 GB 
(d) 3 TB (e) None of these 

23. Terminal is a: 

((a) device to give power supply to computer 
(b) Point at which data enters or leaves the computer 
(c) The last instruction in a program 
(d) any input /output device 
(e) None of these 
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24. Which part of a computer cannot be touched? 
(a) Mouse (b) Monitor (c) Hardware 
(d) Software (e) None of these 

25. Manipulation of data in computer is called 
(a) Boot (b) Processing (c) Simplification 
(d) Format (e) Clean disk 

26. Which computer bus connects the main memory to the 
memory controller in computer systems? 
(a) Data Bus (b) Memory Bus 
(c) I/O Bus (d) Both (b) and ((c) 

(e) None of these 
27.   and  are the two types of computer memory. 

(a) RAM and CPU (b) ROM and CPU 
(c) RAM and ROM (d) RAM and BIOS 

(e) BIOS and ROM 
28. What is the full from of CRT? 

(a) Cathode Ray Tube 
(b) Computer Resolution and Transparency 
(c) Cathode Resolution and Transparency 
(d) Computer RAM Trash 
(e) None of these 

29. Which among the following is not hardware? 
(a) Motherboard (b) Operating system 
(c) CPU (d) Keyboard 

(e) Hard disk drive 
30. Which of the following is software? 

(a)  

(b) Motherboard (b) CPU 
(c) Microsoft  Windows 
(d) RAM (e) All of these 

31. In  computing,  a  is a directive to a 
computer program order to perform a specific 
task. 
(a) Hard boot (b) Hibernation (c) Command 
(d) Warm boot (e) Format 

32. Which of the following is/are modifier keys in a 
computer? 
(a) Ctrl (b) Alt (c) Shift 
(d) Both 2 and 3 (e) All of the above 

33. Which among the following is associated with 
Internet Mail? 
(a) Inbox (b) Server (c) Trash 
(d) Drop Box (e) One Drive 

34. What is a cursor? 
(a) It is an indicator 
(b) It shows the position on a computer monitor 
(c) Cursor is Latin for ‘runner. 
(d) Both 1 and 2 
(e) All of the above 

35. Which among the following is not legitimate type 
of computer virus?? 
(a) Boot Virus (b) File infector Virus 
(c) Resident Virus (d) Hangout Virus 
(e) Macro Virus 

36. 30,000 bytes is equal to 
(a) 30 KB (b) 3 MB (c) 3 GB 
(d) 3 TB (e) None of these 

37. The main folder on a storage device is called 
(a) Platform (b) Interface (c) Root Directory 
(d) Device Driver (e) None of these 

38. ISDN stands for 
(a) Integral Service Dynamic Network 
(b) International Subscriber Dialup Network 
(c) International Service Digital Network 
(d) Integrated Service Digital Network 
(e) None of these 

39. Which technology is used by cell phones to access the 
internet? 
(a) Cloud computing (b) Neural Networks 
(c) XML language (d) micro browser software 
(e) None of the above 

40. Which of the following scrambles a message by applying 
a secret code? 
(a) Audits (b) Encryption (c) UPS 
(d) Firewalls (e) Encapsulation 

41. What type of monitoring file is commonly used on and 
accepted from Internet sites? 
(a) Smartware (b) Phishes (c) Cookies 
(d) Trojans (e) None of the above 

42. The software that secretly collects information about the 
web client's internet habits? 
(a) Detectware (b) Spam (c) Spyware 
(d) Pharming (e) All of the above 

43. Which register is used as a working area in CPU ? 
(a) Program counter (b) Instruction registers 
(c) Instruction decoder 
(d) Parity generator (e) Accumulator 

44. Which of the following is the valid subnet mask for class B IP 
Address? 
(a) 251.254.25.5 (b) 255.255.0.0 
(C) 155.151.12.9 (d) 255.0.0.0 
(e) 255.255.255.0 

45. Repeaters function in which layer? 
(a) Physical layer (b) Data link layer 
(c) Network layer (d) Both (a) and (b) 
(e) Session layer 

46. Name the input device from the given options, that cannot be 
used to work in MS Office ? 
(a) Scanner (b) Mouse (c) Keyboard 
(d) Joy stick (e) All of the above 

47. Select the odd one out : 
(a) Interpreter (b) operating system 
(c) Compiler (d) Assembler 
(e) both (a) and (d) 

48. Name the first widespread computer virus for MS- DOS? 
(a) Brain (b) Handshake (c) Code Red 
(d) Melissa (e) Sasser 

49. What is ICMP (Internet Control Message Protocol)? 
(a) a protocol that manages memory 
(b) a protocol used to monitor computers 
(c) a protocol that handles error and control messages 
(d) both (a) and (b) (e) None of these 

50. What is Loading Operating System into main memory 
called? 
(a) Printing (b) Saving (c) Storing 
(d) Staring (e) Booting 
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51. What is a group of computers and associated devices that 
share a common communications line or wireless link to a 
server within a small geographic area are called? 
(a) LAN (b) WAN (c) MAN 
(d) both (a) and (b) (e) None of these 

52. _____________ is created when two tables are joined on 
attributes that are neither primary keys nor foreign 
keys. 
(a) Relation (b) Cardinality (c) Spurious tuple 
(d) Candidate Key (e) None of the above 

53. What does SQL stand for? 
(a) Structured Query Language 
(b) Structered Questioning Logicstics 
(c) Simplfied Query Logic 
(d) Simple Questioning Language 
(e) Structured Query Logic 

54. From where to where is a multicast message sent? 
(a) From one source to one destination 
(b) From multiple source to multiple destination 
(c) From multiple sources to one destination 
(d) From one source to multiple destinations 
(e) None of the above 

55. Using the direct broadcast address, 
(a) a host sends a packet to all other host on the 
network. 
(b) a router sends a packet to all other hosts on the 
network. 
(c) a host sends a packet to a specific host on the 
network. 
(d) a host sends a packet to all routers on the network. 
(e) none of the above 

56. In computing, a WYSIWYG editor is a system. What 
does WYSIWYG stands for? 
(a) what you see is what you get 
(b) when you see is where you get 
(c) when you see is what you get 
(d) where you see is when you get 
(e) None of the above 
 

 

57. What is the Global Access shortcut key for 
Opening a new database in MS Access? 
(a) Cntrl+A (b) Cntrl+F (c) Cntrl+S 
(d) Cntrl+O (e) Cntrl+N 

58. What is the latest version of MS Office available? 
(a) Office 2016 (b) Office 10 (c) Office 300 
(d) Office 250 (e) None of the above 

59. Which of the following is an operating system? 
(a) Compiler (b) Plotter (c) Mac 
(d) Both 1 and 2 (e) All of the above 

60. Which of the following is the name of an application 
similar to MS Office? 
(a) Libre Office (c) Open Office (c) Neo Office 
(d) Free Office (e) All of the above 

61. What is the full form of UNIVAC? 
(a) Universal Automatic Computer 
(b) Universal Array Computer 
(c) Unique Automatic Computer 
(d) Unvalued Automatic Computer 
(e) None of these 

62. The process of converting analog signals into digital 
signals so they can be processed by a receiving 
computer is referred to as 
(a) Modulation (b) Demodulation 
(c) Synchronizing (d) Digitizing (e) Transmission 

63. Which of the following memory has stored data in large 
number? 
(a) RAM (b) ROM (c) Cache memory 
(d) Hard Disk (e) None of these 

64. Generally, web address is located by 
(a) Hyperlink (b) HTTP (c) URL 
(d) Locator (e) Browser 

65. Which of the following is more than TB ? 
(a) MB (b) KB (c) PB 
(d) Bit (e) Bytes 

66. A web address is a unique name at identifies a specific 
_______ on the internet. 
(a) URL (b) HTML (c) CSS 
(d) Website (e) None of these 

67. If you wish to extend the length of the network without 
having the signal degrade, you would use a 
(a) Gateway (b) Router (c) Modem 
(d) Repeater (e) Resonator 

68. The ______ button on the Quick Access Toolbar allows you to cancel 
your recent commands or activities. 
(a) Search (b) Cut (c) Undo 
(d) Redo 

69. Which of the following is not a binary number? 
(a) 110010 (b) 201020 (c) 101010 
(d) 100001 (e) 1011101 

70. Which of the following is a base of hexadecimal number? 
(a) 8 (b) 2 (c) 10 
(d) 16 (e) 24 

71. A web address is a unique name at identifies a specific 
_______ on the internet. 
(a) URL (b) HTML (c) CSS 
(d) Website (e) None of these 
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72. What do you call the programs that are used to find out 
possible faults and their causes? 
(a) Operating system extensions (b) Cookies 

(c) Diagnostic software (d) Boot diskettes 

(e) None of the above 

74. What is Adwords ? 
(a) Advertising Service by Microsoft 
(b) Advanced Search Engine 

(c) Advertising Service by Google 

(d) Automatic words Search Engine by Yahoo 
(e) Advertising Service by Yahoo 

75. Given the following URL - 
http://www.example.com:80/path/to/myfile.html, here , 
'www.example.com', ':80' stand for _____ and 

______ respectively. 
(a) IP and source (b) Domain Name and Port 

(c) File name and Path (d) Path and Port 

(e) IP and Locator 

74. Which of the following is a recent version of operating 
systems? 
(a) Windows XP (b) Windows 7 Basic 

(c) Windows 8 (d) Windows 10 
(e) Windows 2013 

75. What is the full form of SMTP? 
(a) Swift Mail Transmission Program 

(b) Simple Mail Transfer Protocol 
(c) Swift Mail Transfer Program 

(d) Spam Mail Trash Program 

(e) None of these 

76. A high speed device used in CPU for temporary 
storage during processing is called 

(a) Register (b) Bus (c) Compiler 

(d) Translator (e) Bus 

77. Which of the following is used for establishing 
connection to other document or locations within a 
website? 
(a) Hyperlink (b) Web link (c) CSS 

(d) Java query (e) HTML Link 

78. When a computer is turned on, where does it get the 
first instructions that it loads into RAM? 
(a) From RAM (b) From ROM 

(c) From the Hard Disk 
(d) From a CD (e) None of these 

79. ___________is designed to communicate instructions to a 
machine, particularly a computer. It can be used to 
create programs to control the behavior of a 
machine or to express algorithms. 
(a) PROM (b) Programming language 

(c) Microcontrollers (d) EPROM 

(e) None of the above 

80. Which of the following groups contains all graphical file 
extensions? 

(a) JPG, GIF, BMP (b) GIF, TCF, WMF 

(c) TCP, JPG, BMP (d) ADP, GIF, PPT 

(e) JPG, CPX, GCM 

81. What type of technology allows you to verbally 
speak with someone over the Internet? 
(a) Wiki (b) Social network 
(c) E-phone (d) VoIP (e) Blog 

82. In PowerPoint, what is the function of Alt+N in 
navigating the ribbon with only the keyboard? 
(a) Open the Transitions tab (b) Open the Home tab 
(c) Open the Insert tab (d) Open the Review tab 
(e) Open the Tell me box 

83. What is it called when you are rerouted from your 
requested internet site to another, undesired site? 
(a) Phishing (b) Pharming (c) Redirecting 
(d) Hijacking (e) Trojan 

84. The coding language used to create documents for 
use on the Internet is  . 
(a) HTML (b) HSMT (c) HLTM 
(d) All of these (e) HTTP 

85. The technique in which an attacker convinces an 
authorized user to pass classified information to 
an unauthorized person is called . 
(a) dumpster diving (b) reverse social engineering 
(c) shoulder surfing (d) social engineering 
(e) Cracking 

86. In which generation did multi-programming start? 
(a) First generation (b) Second generation 
(c) Third generation 
(d) Fourth generation (e) Fifth generation 

87. FORTRAN is a programming language. It is more suitable for 
which purpose? 
(a) business applications (b) marketing applications 
(c) scientific applications 
(d) statically calculative applications 
(e) Commercial application 

88. Speed of supercomputer measured in: 
(a) Kbps (b) Mbps (c) FLOPS 
(d) MIPS (e) CPS 

89. Which of the following is used to open file menu options in 
current program? 
(a) Ctrl+F (b) Shift+F (c) Alt+F 
(d) Alt+Ctrl+F (e) Tab+F 

90. By which of the following symbol all Excel formula start? 
(a) % (b) + (c) - 
(d) = (e) @ 

91. Which IEEE standard used to define the specification for a 
wireless LAN? 
(a) IEEE 802.5 (b) IEEE 802.3 (c) IEEE 802.11 
(d) IEEE 802.4 (e) IEEE 802.6 

92. Which of the following data functions would you use to 
hide all rows in a worksheet except those that meet some 
criteria you specify? 
(a) Sort (b) Query (c) Custom Filter 
(d) Conditional Formatting 
(e) Conditional specification 

93. How many layers are in the TCP/IP model? 
(a) 4 layers (b) 6 layers (c) 5 layers 
(d) 7 layers (e) 3 layers 

94. Which of the following is a video format? 
(a) JPEG (b) GIF (c) FLV 
(d) PNG (e) BMP 
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95. Commands at the top of a screen such as File-Edit, 
Format and Tools to operate and change things are 
incorporated in  . 
(a) Menu bar (b) Tool bar (c) User friendly 
(d) Word processor (e) Graphics 

96. The basic input/output system (BIOS) is stored in: 
(a) RAM (b) ROM (c) ALU 
(d) Peripherals (e) DRAM 

97. Which of the following diagrams graphically represents 
an inter-relationship among entities in a database? 

(a) Entity-relationship diagram 
(b) Data flow diagram 
(c) Control flow diagram 
(d) Sequence diagram 
(e) Data relationship diagram 

98. Which of the following device enabling data 
transfer between two different networks? 
(a) Bridge (b) Router (c) Gateway 
(d) Repeater (e) Modem 

99. Which of the following number system has base-8? 
(a) Unary number system 
(b) Binary number system 
(c) Octal number system 
(d) Hexadecimal Number System 
(e) Decimal number system 

100. What is a note or an annotation that an author or 
reviewer adds to a document? 
(a) Comment (b) Caption (c) Footer 
(d) Header (e) Underline 
 

 

 
 
 
 
 
 
 

https://www.adda247.com/activity/DAILY_QUIZZES
https://www.adda247.com/activity/PYP
https://www.adda247.com/activity/MAGAZINES
https://www.adda247.com/product-onlineliveclasses/95728/rrb-po-mains-exams-online-coaching?productId=95729

